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คำนำ 

แผนการจัดการเรียนรู้  วิชา งานเขียนแบบเครื่องกลด้วยคอมพิวเตอร์ (Computer-Aided Mechanical 
Drafting Job) รหัสวิชา 20101-2029  ท–ป–น 1-6-3 นี้ มุ่งเน้นสมรรถนะอาชีพ ได้จัดทำขึ้นเพื่อใช้เป็นคู่มือ
ประกอบการจัดการเรียนการสอนในรายวิชาเพื่อพัฒนาผู้เรียนเป็นสำคัญ ตามหลักสูตรประกาศนียบัตร วิชาชีพ
พุทธศักราช 2567 ของสำนักงานคณะกรรมการการอาชีวศึกษา กระทรวงศึกษาธิการ  

 การจัดทำได้มีการพัฒนาเพื ่อให้เหมาะสมกับผู ้เร ียน โดยแบ่งเนื ้อหาออกเป็น  6 หน่วยการเรียนรู้ 
ประกอบด้วย 

1. การใช้งาน SOLIDWORKS เบื้องต้น และมุมมองชิ้นงาน 
2. การใช้เครื่องมือวาดเส้นร่างพ้ืนฐาน และระดับสูง 
3. การเขียนเส้นร่างด้วยฟังก์ชันหลัก และฟังก์ชันเสริมในโปรแกรม SOLIDWORKS 
4. ระบบ 3 มิติ และการสร้างชิ้นงาน 3 มิติด้วยการเพ่ิมความหนาในโปรแกรม SOLIDWORKS 
5. การสร้างวัตถุ 3 มิติ ด้วยการตัด เจาะ หมุน และกำหนดรูปทรงให้กับชิ้นงาน 
6. การประกอบชิ้นงานย่อยเป็นชิ้นงานที่สมบูรณ์ 

 พร้อมทั้ง แบบฝึกหัด ใบงาน แบบทดสอบพร้อมเฉลย และสื่อการเรียนการสอนต่าง ๆ เพื่อให้ผู้เรียนได้  
ฝึกทักษะในสถานการณ์ต่าง ๆ มีทักษะการคิดและแก้ปัญหา และบูรณาการกับการทำงานตามสาขาอาชีพต่าง ๆ 
ต่อไป 

 ผู้จัดทำหวังว่าแผนการจัดการเรียนรู้เล่มนี้คงจะเป็นแนวทางและเป็นประโยชน์ต่อผู้เรียน และผู้สนใจทั่วไป 
หากมีข้อเสนอแนะประการใด ผู้จัดทำยินดีน้อมรับไว้เพื่อปรับปรุงในโอกาสต่อไป 
 
 
 
                                                                     ลงชื่อ 
                                                                            (..........................................) 
                                                                                           ครูผู้สอน 
 
 
 
 
 
 

 



สารบัญ 
 หน้า 
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ตารางวิเคราะห์หน่วยการเรียนรู้  ง 
ตารางวิเคราะห์พฤติกรรมการเรียนรู้ ฏ 
ตารางกำหนดการจัดการเรียนรู้ ฑ 
แผนการจัดการเรียนรู้ที่ 1 หน่วยที่ 1 การใช้งาน SOLIDWORKS เบื้องต้น และมุมมองชิ้นงาน 1 
แผนการจัดการเรียนรู้ที่ 2 หน่วยที่ 2 การใช้เครื่องมือวาดเส้นร่างพ้ืนฐาน และระดับสูง 15 
แผนการจัดการเรียนรู้ที่ 3 หน่วยที่ 3 การเขียนเส้นร่างด้วยฟังก์ชันหลัก และฟังก์ชันเสริมในโปรแกรม 
SOLIDWORKS 

40 

แผนการจัดการเรียนรู้ที่ 4 หน่วยที่ 4 ระบบ 3 มิติ และการสร้างชิ้นงาน 3 มิติด้วยการเพ่ิมความหนา
ในโปรแกรม SOLIDWORKS 

66 

แผนการจัดการเรียนรู้ที่ 5 หน่วยที่ 5 การสร้างวัตถุ 3 มิติ ด้วยการตัด เจาะ หมุน และกำหนดรูปทรง
ให้กับชิ้นงาน 
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แผนการจัดการเรียนรู้ที่ 6 หน่วยที่ 6 การประกอบชิ้นงานย่อยเป็นชิ้นงานที่สมบูรณ์ 114 
ภาคผนวก  

 
 
 
 
 
 
 
 
 
 
 
 

 
 
 



หลักสูตรรายวิชา 

หลักสูตรประกาศนียบัตรวิชาชีพ พุทธศักราช 2567 
หมวดวิชาสมรรถนะวิชาชีพ กลุ่มสมรรถนะวิชาชีพเฉพาะ 

รหัสวิชา    20101-2029     ชื่อวิชา  งานเขียนแบบเครื่องกลด้วยคอมพิวเตอร์ 
(Computer-Aided Mechanical Drafting Job)  . 

ทฤษฎี     1   ชั่วโมง/สัปดาห์  ปฏิบัติ      6     ชั่วโมง/สัปดาห์  จำนวน       3      หน่วยกิต 

อ้างอิงมาตรฐาน 
 - 

 

ผลลัพธ์การเรียนรู้ระดับรายวิชา 
 เขียนแบบเครื่องกล โดยใช้คอมพิวเตอร์ 

 

จุดประสงค์รายวิชา เพ่ือให้ 
1. รู้และเข้าใจเกี่ยวกับหลักการเขียนแบบเครื่องกลโดยใช้คอมพิวเตอร์ 
2. สามารถเขียนแบบเครื่องกลโดยใช้คอมพิวเตอร์ 
3. มีเจตคติและกิจนิสัยที่ดีต่อการปฏิบัติงาน มีความประณีต รอบคอบ ปลอดภัย ความรับผิดชอบ และมี

จิตสำนึกในการรักษาสภาพแวดล้อม 
4. ประยุกต์ความรู้การเขียนแบบเครื่องกลโดยใช้คอมพิวเตอร์ด้วยความรับผิดชอบและมีจิตสำนึกในการ

รักษาสภาพแวดล้อม 
 

สมรรถนะรายวิชา  
1. แสดงความรู้เกี่ยวกับหลักการเขียนแบบเครื่องกลด้วยคอมพิวเตอร์ 
2. เขียนแบบเครื่องกลโดยใช้โปรแกรมคอมพิวเตอร์ตามหลักและกระบวนการ 
3. บำรุงรักษาคอมพิวเตอร์และอุปกรณ์ตามคู่มือ 
4. ประยุกต์ใช้การเขียนแบบเครื่องกลโดยใช้คอมพิวเตอร์กับงานยานยนต์ 

 

คำอธิบายรายวิชา 
 ศึกษาและปฏิบัติการใช้โปรแกรมพ้ืนฐาน ชุดคำสั่งการเขียนแบบภาพ 2 มิติ 3 มิติ การแสดงภาพ การจัดไฟล์ 
การพิมพ์ การพล๊อตและการใช้โปรแกรมสำเร็จรูป 
 

 
 

  



ตารางวิเคราะห์หน่วยการเรียนรู้ 

ผลลัพธ์การเรียนรู้ระดับรายวิชา (Job) 
เขียนแบบเครื่องกล โดยใช้คอมพิวเตอร์ 

 

งานหลัก 
(Duty) 

งานย่อย 
(Task) 

สมรรถนะย่อย 
(มาตรฐานอาชีพ) 

ความรู้ 
ในการปฏิบัติงาน 

ทักษะ 
ในการปฏิบัติงาน 

งานหลัก 1 
การใช้งาน 
SOLIDWORKS 
เบื้องต้น และ
มุมมองชิ้นงาน 

1.1 การสร้างเอกสาร 
(Document) สำหรับ  
ออกแบบชิ้นงาน  

- การสร้างเอกสาร 
(Document) สำหรับ 
ออกแบบชิ้นงาน 

- ใบงานที่ 1.1 การ
สร้างชิ้นงานพ้ืนฐาน
ใน SOLIDWORK 
- ใบงานที่ 1.2 การ
จัดการมุมมองและ
การแสดงผลชิ้นงาน 

1.2 ส่วนประกอบใน
หนา้ต่างของโปรแกรม 

ส่วนประกอบใน
หนา้ต่างของโปรแกรม 

1.3 การสร้างชิ้นงานใน 
SOLIDWORKS 

การสร้างชิ้นงานใน 
SOLIDWORKS 

1.4 การเปิดและบันทึก
ชิ้นงานใน 
SOLIDWORKS 

การเปิดและบันทึก
ชิ้นงานใน 
SOLIDWORKS 

1.5 การตั้งค่า 
SOLIDWORKS เบื้องต้น
ก่อนเริ่มทำงาน  

1.5.1 การเปลี่ยนฉาก
หลัง 
1.5.2 การกำหนด
หน่วยวัด 

1.6 ระนาบของชิ้นงาน 
และมุมมองชิ้นงาน 

1.6.1 วิธีการแบ่งหน้า
จอแสดงผล 
1.6.2 การย่อหรือขยาย
มุมมอง 

1.7 การเปลี่ยนมุมมอง
ระนาบในแบบต่าง ๆ 

การเปลี่ยนมุมมอง
ระนาบในแบบต่าง ๆ 

1.8 การเลือกการ
แสดงผลชิ้นงานใน
หน้าต่างโปรแกรม 

การเลือกการแสดงผล
ชิ้นงานในหน้าต่าง
โปรแกรม 

งานหลัก 2 
การใช้เครื่องมือ
วาดเส้นร่าง

2.1 ความแตกต่าง
ระหว่าง 2 มิติ และ 3 มิติ 

- ความแตกต่างระหว่าง 
2 มิติ และ 3 มิติ 

- ใบงานเพ่ิมเติมที ่1 
การฝึกเปลี่ยน
ระนาบและมุมมอง
ใน SOLIDWORKS 

2.2 การเปลี่ยนมุมมอง
แบบรวดเร็ว 

การเปลี่ยนมุมมองแบบ
รวดเร็ว 



งานหลัก 
(Duty) 

งานย่อย 
(Task) 

สมรรถนะย่อย 
(มาตรฐานอาชีพ) 

ความรู้ 
ในการปฏิบัติงาน 

ทักษะ 
ในการปฏิบัติงาน 

พ้ืนฐาน และ
ระดับสูง 

2.3 การวาดเส้นร่าง
พ้ืนฐาน 

2.3.1 การทำงานกับ
เส้นตรง 
2.3.2 การกำหนดความ
ยาวให้กับเส้นตรง 
2.3.3 การกำหนดให้
เส้นตรงมีความยาว
เท่ากัน 
2.3.4 การกำหนดองศา
ในมุมของเส้นตรง 
2.3.5 การทำงานกับ
เส้นสี่เหลี่ยม 
2.3.6 การทำงานกับ
เส้นวงกลม 

- ใบงานที่ 2.1 การ
สร้างโลโก้อย่างง่าย
ด้วยเครื่องมือวาด
เส้นพ้ืนฐาน 
- ใบงานที่ 2.2 การ
ออกแบบชิ้นส่วน
เครื่องจักรด้วย
เครื่องมือวาดเส้น
ขั้นสูง  

2.4 การใช้เครื่องมือวาด
เส้นร่างระดับสูง 

2.4.1 การสร้างรูปทรง
หลายเหลี่ยม 
2.4.2 การสร้างเส้นโค้ง
จากวงกลม 
2.4.3 การสร้างเส้นโค้ง
ต่อจากเส้นร่าง 
2.4.4 การสร้างเส้นโค้ง
แบบกำหนดจุดเริ่มและ
จุดสิ้นสุด 
2.4.5 การสร้างเส้นรูป
วงรี 
2.4.6 การสร้างเส้นโค้ง
จากวงรี 
2.4.7 การสร้างเส้นโค้ง
แบบพาราโบลา 
2.4.8 การสร้างเส้นโค้ง
แบบกรวย 
2.4.9 การสร้างเส้นโค้ง
ต่อเนื่อง 



งานหลัก 
(Duty) 

งานย่อย 
(Task) 

สมรรถนะย่อย 
(มาตรฐานอาชีพ) 

ความรู้ 
ในการปฏิบัติงาน 

ทักษะ 
ในการปฏิบัติงาน 

งานหลัก 3 
การเขียนเส้นร่าง
ด้วยฟังก์ชันหลัก 
และฟังก์ชันเสริม
ในโปรแกรม 
SOLIDWORKS 

3.1 การใช้ฟังก์ชัน Line 
Format  

- การใช้ฟังก์ชัน Line 
Format 

- ใบงานเพ่ิมเติมที่ 2 
การใช้เครื่องมือวาด
เส้นร่างพ้ืนฐาน 
- ใบงานที่ 3.1 การ
ประยุกต์ ใช้ฟังก์ชัน
หลักใน 
SOLIDWORK 
- ใบงานที่ 3.2 การ
ประยุกต์ ใช้ฟังก์ชัน
เสริมใน 
SOLIDWORK 

3.2 การใช้ฟังก์ชัน Line 
Color 

การใช้ฟังก์ชัน Line 
Color 

3.3 การใช้ฟังก์ชัน 
Centerline 

การใช้ฟังก์ชัน 
Centerline 

3.4 การใช้ฟังก์ชัน 
Offset Entities 

การใช้ฟังก์ชัน Offset 
Entities 

3.5 การใช้ฟังก์ชัน 
Mirror Entities 

การใช้ฟังก์ชัน Mirror 
Entities 

3.6 การใช้ฟังก์ชัน Trim 
Entities 

การใช้ฟังก์ชัน Trim 
Entities 

3.7 การใช้งานฟังก์ชัน
เสริมในโปรแกรม 
SOLIDWORKS 

3.7.1 การใช้ฟังก์ชัน 
Extend 
3.7.2 การใช้ฟังก์ชัน 
Move Entities 
3.7.3 การใช้ฟังก์ชัน 
Copy Entities 
3.7.4 การใช้ฟังก์ชัน 
Move with Angle 
3.7.5 การใช้ฟังก์ชัน 
Scale 
3.7.6 การใช้ฟังก์ชัน 
Stretch 
3.7.7 การใช้ฟังก์ชัน 
Linear Pattern 
3.7.8 การใช้ฟังก์ชัน 
Circular Pattern 

งานหลัก 4 
ระบบ 3 มิติ 
และการสร้าง

4.1 การสร้างระนาบใน
โปรแกรม 
SOLIDWORKS 

- การสร้างระนาบใน
โปรแกรม 
SOLIDWORKS 

- ใบงานเพ่ิมเติมที่ 3 
การสร้างระนาบใน



งานหลัก 
(Duty) 

งานย่อย 
(Task) 

สมรรถนะย่อย 
(มาตรฐานอาชีพ) 

ความรู้ 
ในการปฏิบัติงาน 

ทักษะ 
ในการปฏิบัติงาน 

ชิ้นงาน 3 มิติ
ด้วยการเพ่ิม
ความหนาใน
โปรแกรม 
SOLIDWORKS 

4.2 การสร้างระนาบใหม่
ในรูปแบบต่าง ๆ 

4.2.1 การสร้างระนาบ
แบบขนาน (Parallel 
Plane) 
4.2.2 การสร้างระนาบ
ตั้งฉาก 
(Perpendicular 
Plane) 
4.2.3 การสร้างระนาบ
แบบแนบติด 
(Coincident Plane) 
4.2.4 การสร้างระนาบ
แบบกำหนดมุม (At 
Angle Plane) 
4.2.5 การสร้างระนาบ
แบบกึ่งกลาง (Mid 
Plane) 

โปรแกรม 
SOLIDWORKS 
- ใบงานที่ 4.1 การ
สร้างชิ้นงาน 3 มิติ
ด้วยระนาบพ้ืนฐาน
และระนาบขั้นสูง 
- ใบงานที่ 4.2 การ
สร้างชิ้นงาน 3 มิติ
ด้วยเทคนิคการเพิ่ม
ความหนาขั้นสูง 

4.3 วิธีการสร้างวัตถุใน
ระนาบใหม่ 

วิธีการสร้างวัตถุใน
ระนาบใหม่ 

4.4 การเปลี่ยนแปลง
ระนาบที่สร้างไว้ 

การเปลี่ยนแปลง
ระนาบที่สร้างไว้ 

4.5 การเปลี่ยนการ
แสดงผลของระนาบใหม่ 
 

การเปลี่ยนการแสดงผล
ของระนาบใหม่ 

4.6 การเพ่ิมความหนา
ให้กับชิ้นงานในโปรแกรม 
SOLIDWORKS 

4.6.1 การสร้างความ
หนาแบบอ้างอิงจากมุม 
(Angular Reference 
Extrusion) 
4.6.2 การสร้างความ
หนาโดยอ้างอิงจาก
พ้ืนผิว (Surface 
Reference 
Extrusion) 



งานหลัก 
(Duty) 

งานย่อย 
(Task) 

สมรรถนะย่อย 
(มาตรฐานอาชีพ) 

ความรู้ 
ในการปฏิบัติงาน 

ทักษะ 
ในการปฏิบัติงาน 

4.6.3 การกำหนดความ
หนาจากระยะห่าง
ระนาบผิวหรือพ้ืนผิว 
(Distance 
Plane/Surface 
Extrusion) 
4.6.4 การกำหนดความ
หนาไปยังวัตถุอ่ืน (End 
at Object Extrusion) 
4.6.5 การสร้างความ
หนาจากจุดกึ่งกลาง 
(Mid Plane 
Extrusion) 
4.6.6 การสร้างความ
หนาแบบปรับปลาย 
(Draft Extrusion) 
4.6.7 การสร้างความ
หนาแบบแยก
สองทิศทาง (Dual 
Direction Extrusion) 
4.6.8 การสร้างความ
หนาเฉพาะเส้นร่าง 
(Thim Feature 
Extrusion) 
4.6.9 การสร้างความ
หนาและผลึกรวมกับ
วัตถุ (Merge 
Extrusion) 

4.7 เทคนิคเสริมในการใช้
งาน (Advanced 
Techniques) 

4.7.1 การเลือกวัตถุ 3 
มิต ิ



งานหลัก 
(Duty) 

งานย่อย 
(Task) 

สมรรถนะย่อย 
(มาตรฐานอาชีพ) 

ความรู้ 
ในการปฏิบัติงาน 

ทักษะ 
ในการปฏิบัติงาน 

4.7.2 การซ่อนวัตถุ 3 
มิติแบบเรียงลำดับ
ก่อนหลัง 
4.7.3 การสร้างความ
หนาให้กับเส้นร่าง
หลาย ๆ เส้นพร้อมกัน 

งานหลัก 5 
การสร้างวัตถุ 3 
มิติ ด้วยการตัด 
เจาะ หมุน และ
กำหนดรูปทรง
ให้กับชิ้นงาน 

5.1 การเจาะวัตถุ 3 มิติ - 5.1.1 การเจาะรูวัตถุ 3 
มิต ิ
5.1.2 การสร้างรูปทรง
แบบผกผัน (Inverse 
Hole Feature) 
5.1.3 กระบวนการ
สร้างรูปทรงด้วยการ
เจาะตามแนวเส้นร่าง 
(Profile-Based Hole 
Feature) 

- ใบงานเพ่ิมเติมที่ 4 
การเจาะวัตถุ 3 มิติ   
, หลักการหมุนเพื่อ
สร้างวัตถุ 3 มิต ิ
และการสร้าง
ชิ้นงานแบบแกน
ห่างหน้าตัด 
- ใบงานที่ 5.1 การ
สร้างวัตถุ 3 มิติ 
ด้วยการหมุน 
- ใบงานที่ 5.2 การ
สร้างวัตถุ 3 มิติ
แบบหลายหน้าตัด 

5.2 หลักการหมุนเพ่ือ
สร้างวัตถุ 3 มิติ 

หลักการหมุนเพ่ือสร้าง
วัตถุ 3 มิติ 

5.3 การสร้างชิ้นงานแบบ
แกนห่างหน้าตัด (Offset 
Axis Feature) 

การสร้างชิ้นงานแบบ
แกนห่างหน้าตัด 
(Offset Axis Feature) 

5.4 การสร้างชิ้นงานด้วย
เทคนิคการหมุนแบบแกน
ติดหน้าตัด  
(Attached-Axis 
Revolution)  

การสร้างชิ้นงานด้วย
เทคนิคการหมุนแบบ
แกนติดหน้าตัด  
(Attached-Axis 
Revolution) 

5.5 การคว้านเนื้อในวัตถุ
ออกด้วยการหมุน 

การคว้านเนื้อในวัตถุ
ออกด้วยการหมุน 

5.6 การข้ึนรูปชิ้นงาน
ตามเส้นนำ (Sweep 
Feature) 

การข้ึนรูปชิ้นงานตาม
เส้นนำ (Sweep 
Feature) 



งานหลัก 
(Duty) 

งานย่อย 
(Task) 

สมรรถนะย่อย 
(มาตรฐานอาชีพ) 

ความรู้ 
ในการปฏิบัติงาน 

ทักษะ 
ในการปฏิบัติงาน 

5.7 การสร้างช่องว่างตาม
แนวเส้นนำ (Swept Cut 
Feature) 

การสร้างช่องว่างตาม
แนวเส้นนำ (Swept 
Cut Feature) 

5.8 การสร้างแบบจำลอง 
3 มิติแบบหลายหน้าตัด  
(Multi-Section Solid 
Feature) 

การสร้างแบบจำลอง 3 
มิติแบบหลายหน้าตัด  
(Multi-Section Solid 
Feature) 

5.9 การปรับแต่งรูปทรง
วัตถุ 3 มิติแบบหลาย
หน้าตัด (Multi-Section 
Solid Shape 
Modification) 

5.9.1 การปรับความ
โค้งของพ้ืนผิว 
5.9.2 การหมุนบิดวัตถุ 

5.10 การสร้างช่องว่าง
แบบหลายหน้าตัด  
(Multi-Section Lofted 
Cut) 

การสร้างช่องว่างแบบ
หลายหน้าตัด  
(Multi-Section 
Lofted Cut) 

งานหลัก 6 
การประกอบ
ชิ้นงานย่อยเป็น
ชิ้นงานที่สมบูรณ์ 

6.1 โมดูล Assembly - 6.1.1 วิธีแก้ไข
ส่วนประกอบชิ้นงานใน 
Assembly 
6.1.2 การแยกหน้าต่าง
เรียงไฟล์แก้ไขงานใน 
Assembly 
6.1.3 การสร้าง
ความสัมพันธ์ระหว่าง
ชิ้นงานในแบบต่าง ๆ 

- ใบงานที่ 6.1 การ
ประกอบชิ้นงาน
พ้ืนฐานด้วย  
Mate Commands 
- ใบงานที่ 6.2 การ
จัดการตำแหน่ง
ชิ้นงานด้วย Move 
Component 
- งานที่ 1-3 สร้าง
ชิ้นงานด้วย 
SOLIDWORK 
(ภาคผนวก) 

6.2 การจัดวางตำแหน่ง
ชิ้นส่วนในงานประกอบ 
(Assembly 
Positioning) 

การจัดวางตำแหน่ง
ชิ้นส่วนในงานประกอบ 
(Assembly 
Positioning) 

6.3 การปรับแต่งองศาใน
การประกอบชิ้นงาน 

การปรับแต่งองศาใน
การประกอบชิ้นงาน 



งานหลัก 
(Duty) 

งานย่อย 
(Task) 

สมรรถนะย่อย 
(มาตรฐานอาชีพ) 

ความรู้ 
ในการปฏิบัติงาน 

ทักษะ 
ในการปฏิบัติงาน 

(Angular Orientation 
Adjustment) 

(Angular Orientation 
Adjustment) 

6.4 การจัดการตำแหน่ง
เชิงพิกัดในระบบการ
ออกแบบและประกอบ
ชิ้นงาน 
(Coordinate-based 
Positioning in 
Assembly Design)  

การจัดการตำแหน่งเชิง
พิกัดในระบบการ
ออกแบบและประกอบ
ชิ้นงาน (Coordinate-
based Positioning in 
Assembly Design)  

6.5 การนำเสนองานด้วย
การสร้างภาพฉายแบบ 
Drawing การพิมพ์ การ
พล็อต 

การนำเสนองานด้วย
การสร้างภาพฉายแบบ 
Drawing การพิมพ์ 
การพล็อต 

 
 
 
  



ตารางวิเคราะห์พฤติกรรมการเรียนรู ้

รหัสวิชา    20101-2029     ชื่อวิชา  งานเขียนแบบเครื่องกลด้วยคอมพิวเตอร์ 
(Computer-Aided Mechanical Drafting Job)  . 

ทฤษฎี     1   ชั่วโมง/สัปดาห์  ปฏิบัติ      6     ชั่วโมง/สัปดาห์  จำนวน       3      หน่วยกิต 
 

 
 

หน่วยการเรียนรู้ 

ระดับความสามารถที่คาดหวัง 

รวม 
จำนวน
ชั่วโมง  
ท/ป 

ด้านความรู้ 
ด้าน
ทักษะ 

ด้าน
คุณลักษณะ

ฯ 

ด้าน
ประยุกต์ใช้

และ
รับผิดชอบ รู้ จ

ำ 

เข
้าใ

จ 

นำ
ไป

ใช
้ 

วิเ
คร

าะ
ห์ 

ปร
ะเ

มิน
ค่า

 

สร
้าง

สร
รค

์ 

1. การใช้งาน SOLIDWORKS 
เบื้องต้นและมุมมองช้ินงาน 

1.5 2 1.5 - - - 5 0.5 0.5 11 2/12 

2. การใช้เครื่องมือวาดเส้นร่าง
พื้นฐานและระดับสูง 

1.5 2 1.5 - - - 5 0.5 0.5 11 3/18 

3. การเขียนเส้นร่างด้วยฟังก์ชันหลัก
และฟังก์ชันเสรมิในโปรแกรม 
SOLIDWORKS 

1.5 2 1.5 - - - 5 1 1 12 3/18 

4. ระบบ 3 มิติ และการสร้างช้ินงาน 
3  มิติด้วยการเพิม่ความหนาใน
โปรแกรม SOLIDWORKS 

1.5 1 1.5 - - - 5 1 1 11 3/18 

5. การสร้างวัตถุ 3 มิติ ด้วยการตดั 
เจาะ หมุน และกำหนดรูปทรงใหก้ับ
ช้ินงาน 

2 2 2 - - - 5 1 1 13 3/18 

6. การประกอบช้ินงานย่อยเป็น
ช้ินงานท่ีสมบูรณ ์

2 1 2 - - - 5 1 1 12 3/18 

รวมคะแนนระหว่างภาค (ร้อยละ) 10 10 10 - - - 30 5 5 70 17/102 

ประเมินผลลัพธ์การเรียนรู้ระดับรายวิชา (เมื่อเรียนรายวิชานี้สำเร็จแล้วทำอะไรได้) (ร้อยละ) 30 1/6 
รวมทั้งรายวิชา 100 18/108 

 

 

ระดับความสามารถที่คาดหวัง.....วิเคราะห์ให้สอดคล้องจุดประสงค์รายวิชาหรือสูงกว่า 
ด้านความรู ้(พุทธิพิสัย) ด้านทักษะ (ทักษะพิสัย) ด้านคุณลักษณะฯ (จิตพิสยั) 

K1 = ความรู ้ความจำ, K2 = ความเข้าใจ        
K3 = การนำไปใช้  
K4 = การวิเคราะห ์
K5 = การประเมินค่า 
K6 = การสร้างสรรค์ 
หมายเหต ุใส่ได้มากกวา่ 1 ระดับ 

S1 = เลียนแบบ 
S2 = ทำได้ตามแบบ 
S3 = ทำได้ถูกต้อง 
S4 = ทำได้อย่างต่อเนื่อง 
S5 = ทำได้อย่างเป็นธรรมชาต ิ
หมายเหต ุใส่ระดับที่คาดหวังระดับเดียว 

A1 = รับรู้ 
A2 = ตอบสนอง 
A3 = การสร้างคุณค่า 
A4 = จัดระบบคุณค่านิยม 
A5 = การสร้างลักษณะนิสยั 
หมายเหต ุใส่ระดับที่คาดหวังระดับเดียว 

ด้านประยุกต์ใช้และรบัผิดชอบ (ความสามารถประยุกต์ใชแ้ละรับผิดชอบ) 

Ap1 = สามารถปฏิบัติงานตามแบบแผนที่กำหนด 
Ap2 = สามารถปฏิบัติงานตามแบบแผน และปรับตัวภายใต้ความเปลี่ยนแปลงที่ไม่ซับซ้อน 



Ap3 = สามารถวางแผนการปฏิบัติงานที่ได้รับมอบหมายและแก้ไขปัญหาการปฏิบัติงานที่ไม่อยู่ภายใต้การควบคุมในบางเร่ือง โดยประยกุต์ใช้ความรู้ ทกัษะทางวิชาชีพ 
เทคโนโลยีสารสนเทศและการสื่อสาร 

Ap4 = สามารถวางแผนการปฏิบัติงานที่รับผิดชอบ ปรับตัวและแก้ไขปญัหาการปฏิบัติงานที่ไม่คุ้นเคยหรือซับซ้อนและเป็นนามธรรม โดยประยกุต์ใช้ความรู้ ทกัษะทาง
วิชาชีพ เทคโนโลยีสารสนเทศและการสื่อสาร 

Ap5 = สามารถประยุกต์ใช้ความรู้ ทักษะทางวิชาชพี เทคโนโลยีสารสนเทศและการสื่อสารในการวางแผนแก้ไขปัญหาและพัฒนานวัตกรรมตามสายอาชีพ 
หมายเหต ุใส่ระดับที่คาดหวังระดับเดียว 

 

  



ตารางกำหนดการจัดการเรียนรู้ 

รหัสวิชา    20101-2029     ชื่อวิชา  งานเขียนแบบเครื่องกลด้วยคอมพิวเตอร์ 
(Computer-Aided Mechanical Drafting Job)  . 

ทฤษฎี     1   ชั่วโมง/สัปดาห์  ปฏิบัติ      6     ชั่วโมง/สัปดาห์  จำนวน       3      หน่วยกิต 

คร้ังท่ี หน่วยที ่
หน่วยการเรียนรู้ เวลาเรียน (ชม.) 

ทฤษฎ ี ปฏิบัต ิ ทฤษฎ ี ปฏิบัต ิ รวม 

1 

1 

หน่วยที่ 1 การใช้งาน SOLIDWORKS 
เบื้องต้นและมุมมองช้ินงาน 
1.1 การสร้างเอกสาร (Document) สำหรับ  
ออกแบบชิ้นงาน  
1.2 ส่วนประกอบในหน้าต่างของโปรแกรม 
1.3 การสร้างชิ้นงานใน SOLIDWORKS 
1.4 การเปิดและบันทึกชิ้นงานใน 
SOLIDWORKS 

- ใบงานที่ 1.1 การสร้างชิ้นงาน
พ้ืนฐานใน SOLIDWORK 
- ใบงานที่ 1.2 การจัดการ
มุมมองและการแสดงผลชิ้นงาน 

2 12 14 

2 

1.5 การตั้งค่า SOLIDWORKS เบื้องต้น ก่อน
เริ่มทำงาน  
1.6 ระนาบของชิ้นงาน และมุมมองชิ้นงาน 
1.7 การเปลี่ยนมุมมองระนาบในแบบต่าง ๆ 
1.8 การเลือกการแสดงผลชิ้นงานในหน้าต่าง
โปรแกรม 

3 

2 

หน่วยที่ 2 การใช้เครื่องมือวาดเส้นร่าง
พื้นฐานและระดับสูง 
2.1 ความแตกต่างระหว่าง 2 มิติ และ 3 มิติ 
2.2 การเปลี่ยนมุมมองแบบรวดเร็ว 

- ใบงานเพ่ิมเติมที่ 1 การฝึก
เปลี่ยนระนาบและมุมมองใน 
SOLIDWORKS 
- ใบงานที่ 2.1 การสร้างโลโก้
อย่างง่ายด้วยเครื่องมือวาดเส้น
พ้ืนฐาน 
- ใบงานที่ 2.2 การออกแบบ
ชิ้นส่วนเครื่องจักรด้วยเครื่องมือ
วาดเส้นขั้นสูง 

3 18 21 4 2.3 การวาดเส้นร่างพื้นฐาน 

5 

2.4 การใช้เครื่องมือวาดเส้นร่างระดับสูง 

6 3 
หน่วยที่ 3 การเขียนเส้นร่างด้วยฟังก์ชัน
หลักและฟังก์ชันเสริมในโปรแกรม 
SOLIDWORKS 

- ใบงานเพ่ิมเติมที่ 2 การใช้
เครื่องมือวาดเส้นร่างพ้ืนฐาน 3 18 21 



คร้ังท่ี หน่วยที ่
หน่วยการเรียนรู้ เวลาเรียน (ชม.) 

ทฤษฎ ี ปฏิบัต ิ ทฤษฎ ี ปฏิบัต ิ รวม 

3.1 การใช้ฟังก์ชัน Line Format  
3.2 การใช้ฟังก์ชัน Line Color 
3.3 การใช้ฟังก์ชัน Centerline 

- ใบงานที่ 3.1 การประยุกต์ ใช้
ฟังก์ชันหลักใน SOLIDWORK 
- ใบงานที่ 3.2 การประยุกต์ ใช้
ฟังก์ชันเสริมใน SOLIDWORK 

7 
3.4 การใช้ฟังก์ชัน Offset Entities 
3.5 การใช้ฟังก์ชัน Mirror Entities 
3.6 การใช้ฟังก์ชัน Trim Entities 

8 
3.7 การใช้งานฟังก์ชันเสริมในโปรแกรม 
SOLIDWORKS 

9 

4 

หน่วยที่ 4 ระบบ 3 มิติ และการสร้าง
ชิ้นงาน 3 มิติด้วยการเพิ่มความหนาใน
โปรแกรม SOLIDWORKS 
4.1 การสร้างระนาบในโปรแกรม 
SOLIDWORKS 

- ใบงานเพ่ิมเติมที่ 3 การสร้าง
ระนาบในโปรแกรม 
SOLIDWORKS 
- ใบงานที่ 4.1 การสร้างชิ้นงาน 
3 มิติด้วยระนาบพ้ืนฐานและ
ระนาบขั้นสูง 
- ใบงานที่ 4.2 การสร้างชิ้นงาน 
3 มิติด้วยเทคนิคการเพ่ิมความ
หนาขั้นสูง 

3 18 21 10 
4.2 การสร้างระนาบใหม่ในรูปแบบต่าง ๆ 
4.3 วิธีการสร้างวัตถุในระนาบใหม่ 
4.4 การเปลี่ยนแปลงระนาบที่สร้างไว้ 

11 

4.5 การเปลี่ยนการแสดงผลของระนาบใหม่ 
4.6 การเพ่ิมความหนาให้กับชิ้นงานใน
โปรแกรม SOLIDWORKS 
4.7 เทคนิคเสริมในการใช้งาน  
(Advanced Techniques) 

12 

5 

หน่วยที่ 5 การสร้างวัตถุ 3 มิติ ด้วยการตัด 
เจาะ หมุน และกำหนดรูปทรงให้กับช้ินงาน 
5.1 การเจาะวัตถุ 3 มิติ 
5.2 หลักการหมุนเพ่ือสร้างวัตถุ 3 มิติ 
5.3 การสร้างชิ้นงานแบบแกนห่างหน้าตัด 
(Offset Axis Feature) 

- ใบงานเพ่ิมเติมที่ 4 การเจาะ
วัตถุ 3 มิติ, หลักการหมุนเพ่ือ
สร้างวัตถุ 3 มิติ และการสร้าง
ชิ้นงานแบบแกนห่างหน้าตัด 
- ใบงานที่ 5.1 การสร้างวัตถุ 3 
มิติ ด้วยการหมุน 
- ใบงานที่ 5.2 การสร้างวัตถุ 3 
มิติแบบหลายหน้าตัด 

3 18 21 

13 

5.4 การสร้างชิ้นงานด้วยเทคนิคการหมุนแบบ
แกนติดหน้าตัด (Attached-Axis 
Revolution) 
5.5 การคว้านเนื้อในวัตถุออกด้วยการหมุน 



คร้ังท่ี หน่วยที ่
หน่วยการเรียนรู้ เวลาเรียน (ชม.) 

ทฤษฎ ี ปฏิบัต ิ ทฤษฎ ี ปฏิบัต ิ รวม 

5.6 การข้ึนรูปชิ้นงานตามเส้นนำ (Sweep 
Feature) 

14 

5.7 การสร้างช่องว่างตามแนวเส้นนำ (Swept 
Cut Feature) 
5.8 การสร้างแบบจำลอง 3 มิติแบบหลาย
หน้าตัด  
(Multi-Section Solid Feature) 
5.9 การปรับแต่งรูปทรงวัตถุ 3 มิติแบบหลาย
หน้าตัด (Multi-Section Solid Shape 
Modification) 
5.10 การสร้างช่องว่างแบบหลายหน้าตัด  
(Multi-Section Lofted Cut) 

15 

6 

หน่วยที่ 6 การประกอบชิ้นงานย่อยเป็น
ชิ้นงานที่สมบูรณ์ 
6.1 โมดูล Assembly 
6.2 การจัดวางตำแหน่งชิ้นส่วนในงาน
ประกอบ (Assembly Positioning) 

- ใบงานที่ 6.1 การประกอบ
ชิ้นงานพื้นฐานด้วย Mate 
Commands 
- ใบงานที่ 6.2 การจัดการ
ตำแหน่งชิ้นงานด้วย Move 
Component 
- งานที่ 1-3 สร้างชิ้นงานด้วย 
SOLIDWORK (ภาคผนวก) 

3 18 21 

16 

6.3 การปรับแต่งองศาในการประกอบชิ้นงาน
(Angular Orientation Adjustment) 
6.4 การจัดการตำแหน่งเชิงพิกัดในระบบการ
ออกแบบและประกอบชิ้นงาน 
(Coordinate-based Positioning in 
Assembly Design)  

17 
6.5 การนำเสนองานด้วยการสร้างภาพฉาย
แบบ Drawing การพิมพ์ การพล็อต 

18 ประเมินผลลัพธ์การเรียนรู้ระดับรายวิชา (ปลายภาคเรียน) 1 6 7 
รวม 18 108 126 
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แผนการจัดการเรียนรู้ที่ 1  หน่วยที่     1    . 
รหัสวิชา 20101 – 2029  ชื ่อวิชา งานเขียนแบบเครื ่องกลด้วย
คอมพิวเตอร์ (Computer-Aided Mechanical Drafting Job) 

สอนครั้งที ่ 1 - 2  .  

ชื ่อหน่วยการเร ียนรู้    การใช้งาน SOLIDWORKS เบื ้องต้น และ       
มุมมองชิ้นงาน 

ทฤษฎี     2    ชม.  
ปฏิบัติ    12    ชม. 

ชื่อเรื่อง    การใช้งาน SOLIDWORKS เบื้องต้น และมุมมองชิ้นงาน 

สาระสำคัญ 
SOLIDWORK เป็นซอฟแวร์ CAD (Computer-Aided Design) สำหรับการออกแบบและจำลองผลิตภณัฑ์

แบบ 3 มิติ ที่มีหลักการทำงาน 3 รูปแบบ ได้แก่ Part สำหรับสร้างชิ้นงานเดี่ยว,Assembly สำหรับประกอบ
ชิ้นงานหลายชิ้น และ Drawing สำหรับสร้างแบบ 2 มิติเพ่ือการผลิต โดยมีส่วนประกอบสำคัญในการทำงาน ได้แก่ 
Menu bar, Command Manager, Feature Manager, Property Manager และ Graphics Area ซึ ่งขั ้นตอน
การสร้างชิ้นงานจะเริ่มจากการ สเก็ตซ์ 2 มิติบนระนาบที่เลือก กำหนดขนาดและเงื่อนไข แล้วใช้คำสั่ง Features 
สร้างรูปทรง 3 มิติ จากนั้นเพิ่มรายละเอียดด้วยฟีเจอร์ต่างๆ สามารถปรับมุมมองชิ้นงานได้ใน 3 ระนาบหลัก คือ 
Top, Front และ Right Plane พร้อมเครื่องมือปรับมุมมองแบบต่าง ๆ เช่น Zoom, Pan, Rotate และสามารถ
แบ่งหน้าจอแสดงผลหลายมุมมองพร้อมกัน รวมถึงมีรูปแบบการแสดงผลหลายแบบ ทั้งนี้ผู้ใช้สามารถตั้งค่าพ้ืนฐาน
ต่าง ๆ ได้ เช่น หน่วยวัด การแสดงผล และฉากหลัง ได้ตามต้องการ 
 

ผลลัพธ์การเรียนรู้ระดับหน่วยการเรียน 
ผู้เรียนสามารถใช้งานโปรแกรม SOLIDWORKS เบื้องต้นได้ มีความเข้าใจส่วนประกอบต่าง ๆ ของโปรแกรม 

สามารถสร้างเอกสารออกแบบชิ้นงาน ปรับแต่งการตั้งค่าพื้นฐาน และใช้งานมุมมองชิ้นงานในรูปแบบต่าง ๆ ได้
อย่างเหมาะสม 

 

อ้างอิงมาตรฐาน/เชื่อมโยงกลุ่มอาชีพ 
 - 

สมรรถนะประจำหน่วย 
1. แสดงความรู้เกี่ยวกับส่วนประกอบและการทำงานพ้ืนฐานของโปรแกรม SOLIDWORKS 
2. มีทักษะการใช้คำสั่งพื้นฐานในการสร้างเอกสาร การบันทึก การเปิดไฟล์ และการตั้งค่าโปรแกรม 

SOLIDWORKS 
3. ประยุกต์ใช้มุมมองชิ้นงานและระนาบต่าง ๆ ในการออกแบบชิ้นงานเบื้องต้น 
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จุดประสงค์เชิงพฤติกรรม   

ด้านความรู้ (Knowledge) 
1. อธิบายเกี่ยวกับส่วนประกอบในหน้าต่างของโปรแกรมและประเภทเอกสารสำหรับออกแบบชิ้นงานใน 

SOLIDWORKS เพ่ือใช้งานได้อย่างถูกต้องได้ 

ด้านทักษะ/กระบวนการ (Process) 
1. ใช้คำสั่งในการสร้าง เปิด และบันทึกไฟล์ในโปรแกรม SOLIDWORKS เพื่อจัดการไฟล์งานได้อย่างเป็น

ระบบได้ 
2. ใช้มุมมองและระนาบของชิ ้นงานในรูปแบบต่าง ๆ เพื ่อแสดงผลและทำงานกับชิ ้นงานได้อย่างมี

ประสิทธิภาพได้ 
 

คุณลักษณะท่ีพึงประสงค์ (Attitude)   
1. มีเจตคติและกิจนิสัยที่ดีในการปฏิบัติงานด้วยความละเอียด รอบคอบ  

ด้านการประยุกต์ใช้ (Apply)  
1. ประยุกต์ใช้การตั้งค่าพื้นฐานของโปรแกรม เช่น การเปลี่ยนฉากหลังและการกำหนดหน่วยวัด  เพื่อให้

เหมาะสมกับลักษณะงานที่ออกแบบได้ 

สาระการเรียนรู้ 
 1.1 การสร้างเอกสาร (Document)สำหรับออกแบบชิ้นงาน  

1.2 ส่วนประกอบในหน้าต่างของโปรแกรม 
1.3 การสร้างชิ้นงานใน SOLIDWORKS 
1.4 การเปิดและบันทึกชิ้นงานใน SOLIDWORKS 
1.5 การตั้งค่า SOLIDWORKS เบื้องต้นก่อนเริ่มทำงาน  
 1.5.1 การเปลี่ยนฉากหลัง 

1.5.2 การกำหนดหน่วยวัด 
1.6 ระนาบของชิ้นงาน และมุมมองชิ้นงาน 
 1.6.1 วิธีการแบ่งหน้าจอแสดงผล 

1.6.2 การย่อหรือขยายมุมมอง 
1.7 การเปลี่ยนมุมมองระนาบในแบบต่าง ๆ 
1.8 การเลือกการแสดงผลชิ้นงานในหน้าต่างโปรแกรม 
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กิจกรรมการเรียนรู้ (ครั้งท่ี 1/18, ชั่วโมงที่ 1-7/126) 
ขั้นนำเข้าสู่บทเรียน (Warm up) 
1. ผู้สอนบอกคำอธิบายรายวิชา จุดประสงค์รายวิชา สมรรถนะรายวิขา การวัดและประเมินผลรายวิชา

แนวทางวัดผลและการประเมินผลการเรียนรู้ในรายวิชา งานเขียนแบบเครื่องกลด้วยคอมพิวเตอร์ 
(Computer-Aided Mechanical Drafting Job) 

2. ผู ้สอนบอกจุดประสงค์ สาระการเรียนรู ้ และสมรรถนะประจำหน่วยการเรียนรู ้ที ่ 1 การใช้งาน 
SOLIDWORKS เบื้องต้น และมุมมองชิ้นงาน 

3. ผู้สอนบอกแนวทางวัดผลและการประเมินผลการเรียนรู้หน่วยการเรียนรู้ที่ 1 การใช้งาน SOLIDWORKS 
เบื้องต้น และมุมมองชิ้นงาน 

4. ครูให้ผู ้เรียนแต่ละคนใช้สมาร์ทโฟนของตนเองค้นคว้าหาข้อมูลจากอินเทอร์เน็ตเกี่ยวกับโปรแกรม 
SOLIDWORKS เช่น ใช้ทำอะไร มีประโยชน์อย่างไร ปัจจุบันได้รับความนิยมหรือถูกนำมาใช้งาน
แพร่หลายหรือไม่ และสามารถนำไปประยุกต์ใช้กับงานในด้านไหน จากนั้นผู้สอนสนทนาสลับกับการตั้ง
คำถามกับผู้เรียนเพ่ือสร้างความรู้ความเข้าใจให้ผู้เรียนได้ทราบถึงความสามารถและประโยชน์ที่จะได้รับ
จากการเรียนรู้การใช้งานโปรแกรม SOLIDWORKS 

5. ครูเปิดวิดีโอสั้น ๆ แสดงตัวอย่างผลงานที่สร้างด้วย SOLIDWORKS เช่น ชิ้นส่วนเครื่องกล รถยนต์ หรือ
อุปกรณ์ต่าง ๆ 

6. ผู้เรียนร่วมกันสังเกตและแสดงความคิดเห็นว่าเคยเห็นชิ้นงานเหล่านี้ที่ไหนบ้าง ใช้ทำอะไร 
7. ครูถามคำถามกระตุ้นความคิด 

- โปรแกรม CAD ช่วยให้เราทำงานออกแบบได้อย่างไร 
- ทำไมต้องเรียนรู้การใช้ SOLIDWORKS 
- ผู้เรียนคิดว่าเราจะเริ่มต้นสร้างชิ้นงานอย่างไรในโปรแกรมนี้ 

8. ผู้เรียนแบ่งกลุ่ม 4-5 คน อภิปรายและตอบคำถาม พร้นำเสนอหน้าชั้นเรียนกลุ่มละ 2 นาท ี
9. ครูสรุปความสำคัญของการเรียนรู้ในวันนี้ 

- วันนี้เราจะเรียนรู้การเปิดโปรแกรม สร้างเอกสารใหม่ รู้จักส่วนต่าง ๆ ของโปรแกรม และฝึก
สร้างชิ้นงานง่าย ๆ 

 

ขั้นการสอน/การนำเสนอ (Presentation) 
1.1  การสร้างเอกสาร (Document) สำหรับการออกแบบช้ินงาน 

1. ครูเปิดโปรแกรม SOLIDWORKS บนจอโปรเจคเตอร์ พร้อมสาธิตการสร้างเอกสารใหม่ 
2. ครูอธิบายการสร้างเอกสารใน SOLIDWORKS มี 3 ประเภท คือ Part (ชิ้นงานเดี่ยว), Assembly 

(ชิ้นงานประกอบ), และ Drawing (แบบ 2 มิติ) 
3. ผู้เรียนสังเกตขั้นตอน 

- คลิก New → เลือก Part → OK 
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4. ครูใหผู้้เรียนลองเปิดโปรแกรมที่เครื่องคอมพิวเตอร์ของตนเอง แล้วสร้างเอกสาร Part ใหม ่
5. ผู้เรียนปฏิบัติตามทีละขั้นตอน พร้อมสังเกตหน้าต่างที่ปรากฏ 
6. ครูตรวจเยี่ยมและให้คำแนะนำเป็นรายบุคคล 

1.2  ส่วนประกอบในหน้าต่างของโปรแกรม 
1. ครูแสดงหน้าจอโปรแกรมและชี้แจงส่วนประกอบสำคัญ ได้แก่ 

- Menu Bar (แถบเมนูด้านบน) 
- Command Manager (แถบคำสั่งด้านบน - เครื่องมือสร้างชิ้นงาน) 
- Feature Manager Design Tree (แผงด้านซ้าย - แสดงประวัติการสร้าง) 
- Property Manager (แผงด้านซ้าย - แสดงคุณสมบัติเมื่อใช้คำสั่ง) 
- Graphics Area (พ้ืนที่กลาง - พ้ืนที่วาดและแสดงชิ้นงาน) 
- Task Pane (แผงด้านขวา - File Explorer และเครื่องมือเสริม) 

2. ผู้เรียนเปิดโปรแกรมของตนเองและใช้เมาส์ชี้ไปที่ส่วนประกอบต่าง ๆ ตามที่ครูอธิบาย 
3. ครูสาธิตการปรับแต่ง Toolbar 

- Options → Toolbars → เลือก/ยกเลิกการแสดง Toolbar 
4. ผู้เรียนลองปรับแต่ง Toolbar ของตนเองตามความต้องการ 

1.3  การสร้างช้ินงานใน SOLIDWORKS 
1. ครูอธิบายหลักการสร้างชิ้นงาน 3 มิต ิ

- เราจะเริ่มจากการวาด Sketch บนระนาบ (Plane) แล้วใช้ Feature เพ่ือยืดออก (Extrude) 
ให้เป็น 3 มิติ 

2. ครูสาธิตขั้นตอนการสร้างชิ้นงานสี่เหลี่ยมง่าย ๆ 

- เลือก Sketch → Corner Rectangle 
- เลือกระนาบ Top Plane / Front Plane / Right Plane 
- วาดสี่เหลี่ยมบน Graphics Area 
- กำหนดขนาดใน Property Manager (เช่น 50×50 mm) 

- คลิก Features → Extruded Boss/Base 

- กำหนดความหนา (เช่น 30 mm) → OK 
3. ผู้เรียนลองทำตามทีละข้ันตอนที่เครื่องของตนเอง 
4. ครูถามระหว่างสาธิตทำไมต้องเลือก Plane ก่อน และ Extrude คืออะไร 
5. ผู้เรียนตอบและครูสรุป 

- Plane คือระนาบอ้างอิงในการวาด  
- Extrude คือการยืดรูป 2D ให้กลายเป็น 3D 
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6. ครูสาธิตเพิ่มเติมการสร้างรู (Hole) โดยใช้ Extruded Cut และการสร้างทรงกระบอก (Cylinder)   
โดยใช้ Circle + Extrude 

7. ผู้เรียนสังเกตและจดบันทึกขั้นตอนสำคัญ 
 

ขั้นฝึกฝน/ลงมือปฏิบัติ (Practice) 
1. ครใูห้ผู้เรียนทำใบงานที่ 1.1  
2. ผู้เรียนรับฟังคำอธิบาย อ่านใบงานและทำความเข้าใจตัวอย่างชิ้นงานที่ต้องสร้าง 
3. ผู้เรียนทำงานเป็นรายบุคคล โดยปฏิบัติตามข้ันตอน 
4. ครูเดินดูการทำงานและให้คำแนะนำ 
5. ครูเดินสังเกตการทำงาน ให้คำแนะนำและแก้ปัญหาเมื่อผู้เรียนติดขัด 
6. ผู้เรียนที่ทำเสร็จก่อนช่วยเพื่อนที่ยังทำไม่เสร็จ 
7. ผู้เรียนบันทึกไฟล์งานโดยใช้ชื่อตามท่ีใบงานกำหนด 

 

ขั้นประยุกต์ใช ้(Production)  
1. ครูให้โจทย์ 

- ออกแบบชิ้นงานง่าย ๆ ที่ใช้ประโยชน์ในชีวิตประจำวัน เช่น ที่วางโทรศัพท์ ที่วางปากกา 
หรือกล่องเก็บของเล็ก ๆ โดยใช้ Feature พ้ืนฐานที่เรียนมา 

2. ผู้เรียนคิดและร่างแบบชิ้นงานบนกระดาษ 
3. ผู้เรียนสร้างชิ้นงานตามท่ีออกแบบใน SOLIDWORKS 
4. ผู้เรียนบันทึกไฟล์โดยใช้ชื่อตามท่ีครูกำหนด ยกตัวอย่างเช่น ชื่อ-สกุล_ชิ้นงานสร้างสรรค์ 
5. ผู้เรียนทุกคนเปิดไฟล์งานของตนบนหน้าจอคอมพิวเตอร์ 
6. ผู้เรียนเดินชมผลงานของเพ่ือน ๆ รอบห้องเรียน  
7. ผู้เรียนเขียนความคิดเห็นบน Post-it Note วางไว้ที่โต๊ะเพ่ือน (ชมเชย/ข้อเสนอแนะ) 
8. ผู้เรียนกลับมาที่โต๊ะตนเอง อ่าน Feedback จากเพ่ือน 
9. ครูเลือกผลงานที่น่าสนใจ 3 - 4 ชิ้น ให้ผู้เรียนนำเสนอหน้าชั้นเรียนคนละ 3-5 นาที โดย 

- อธิบายแนวคิดการออกแบบ 
- อธิบายขั้นตอนการสร้าง 
- บอกปัญหาที่พบและวิธีแก้ไข 

10. ผู้เรียนคนอ่ืน ๆ ซักถามและให้ข้อเสนอแนะ 
11. ครูสรุปจุดเด่นของแต่ละชิ้นงานและให้กำลังใจ 
 

ขั้นสรุป/ประเมินผล (Wrap up) 
1. ครูและผู้เรียนร่วมกันสรุปประเด็นสำคัญ 
2. ผู้เรียนฟังการสรุปและจดบันทึกสาระสำคัญ 
3. ครูถามคำถามทบทวนความรู้  
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4. ผู้เรียนตอบคำถามทบทวน 
5. ผู้เรียนสอบถามข้อสงสัยที่ยังไม่เข้าใจ 
6. ครูแจ้งหัวข้อที่จะเรียนครั้งต่อไป 
7. ผู้เรียนเตรียมความพร้อมสำหรับบทเรียนต่อไป 

กิจกรรมการเรียนรู้ (ครั้งท่ี 2/18, ชั่วโมงที่ 8-14/126) 
ขั้นนำเข้าสู่บทเรียน (Warm up) 

1. ครสูุ่มถามผู้เรียนเกี่ยวกับหัวข้อดังนี้ เพ่ือทดสอบความเข้าใจและเป็นการทบทวน 
- การสร้างเอกสารสำหรับออกแบบชิ้นงาน 
- ส่วนประกอบในหน้าต่างของโปรแกรม 
- การสร้างชิ้นงานใน SOLIDWORKS 
- การเปิดและบันทึกชิ้นงานใน SOLIDWORKS 

2. ครูเปิดภาพชิ้นงาน 3D เดียวกันที่แสดงผลในแบบต่าง ๆ (Shaded, Wireframe, Hidden Lines)     
บนจอโปรเจคเตอร์ 

3. ผู้เรียนสังเกตและแสดงความคิดเห็นว่าเห็นความแตกต่างอย่างไร ภาพแบบไหนเห็นรายละเอียด
ชัดเจนที่สุด 

4. ครูถามคำถามกระตุ้นความคิด 
- ทำไมเราต้องมีวิธีแสดงผลชิ้นงานหลายแบบ 
- มุมมองต่างกันมีประโยชน์อย่างไร 
- การตั้งค่าโปรแกรมช่วยให้เราทำงานได้เร็วขึ้นได้อย่างไร 

5. ผู้เรียนแบ่งกลุ่ม 4-5 คน อภิปรายและนำเสนอความคิดเห็น 
6. ครูเชื่อมโยงกับชีวิตจริง 

- เวลาทำงานจริง เราต้องปรับมุมมองและแสดงผลให้เหมาะกับงานแต่ละประเภท เช่น 
ตรวจสอบรายละเอียด ตรวจสอบความสมมาตร หรือนำเสนอให้ลูกค้า 

7. ครูสรุปวัตถุประสงค์การเรียนรู้ 
- วันนี้เราจะเรียนรู้การปรับแต่งโปรแกรม การจัดการมุมมอง และการเลือกรูปแบบการ

แสดงผลที่เหมาะสมกับงานต่าง ๆ 

ขั้นการสอน/การนำเสนอ (Presentation) 
1.5  การตั้งค่า SOLIDWORKS เบื้องต้นก่อนเริ่มใช้งาน 

1.5.1  การเปลี่ยนฉากหลัง  
1. ครูเปิดโปรแกรม SOLIDWORKS และสาธิตการเข้าถึง Graphics Area 
2. ครูอธิบาย 

- ฉากหลังของพ้ืนที่ทำงานสามารถปรับเปลี่ยนได้เพ่ือให้มองเห็นชิ้นงานชัดเจนขึ้น 
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3. ครูสาธิตขั้นตอน 

- ไปที่ Task Pane → คลิก Appearances, Scenes and Decals 
- คลิกท่ี Scenes จะปรากฏชุดฉากหลังต่าง ๆ 
- ลากฉากหลังที่ต้องการวางใน Graphics Area 

4. ผู้เรียนสังเกตการเปลี่ยนแปลงของฉากหลังแต่ละแบบ 
5. ผู้เรียนลองปฏิบัติตามที่เครื่องคอมพิวเตอร์ของตนเอง โดยทดลองเปลี่ยนฉากหลัง 3-4 แบบ 
6. ครูถาม 

- ฉากหลังแบบไหนทำให้เห็นชิ้นงานชัดเจนที่สุด เพราะเหตุใด 
7. ผู้เรียนแลกเปลี่ยนความคิดเห็นและทดลองปรับฉากหลังให้เหมาะสมกับชิ้นงาน 
1.5.2  การกำหนดหน่วยวัด  
1. ครูอธิบายความสำคัญของหน่วยวัด 

- การใช้หน่วยวัดที่ถูกต้องสำคัญมาก เพราะถ้าเราออกแบบเป็น mm แต่ตั ้งค่าเป็น inch 
ชิ้นงานจะผิดขนาด 

2. ครูสาธิตการตั้งค่าหน่วยวัด 

- ไปที่ Menu Bar → คลิก Option (IE) → หน้าต่างการตั้งค่าจะปรากฏ 

- คลิกท่ี Document Properties → เลือก Units 
- เลือกหน่วยวัดที่ต้องการ (millimeters, inches, etc.) 

- กำหนดทศนิยม → คลิก OK 
3. ผู้เรียนสังเกตตัวอย่างการเปลี่ยนหน่วยวัดและผลกระทบต่อตัวเลขบนหน้าจอ 
4. ผู้เรียนลองเปิด Option ที่เครื่องของตนเอง แล้วเปลี่ยนหน่วยวัดเป็น millimeters 
5. ครูทบทวนความรู้เดิม 

- จากครั้งที่แล้ว เราได้เรียนรู้ระนาบ 3 แบบ คือ Top Plane, Front Plane, Right Plane 
6. ครูเปิดชิ้นงานตัวอย่างและสาธิตการมองชิ้นงานจากระนาบต่าง ๆ 
7. ผู้เรียนสังเกตว่าการมองจากระนาบต่างกันให้มุมมองที่แตกต่างกันอย่างไร 
8. ครูอธิบาย 

- สามารถเปลี่ยนมุมมองได้ 2 วิธี คือ ใช้ View (Heads-Up) หรือใช้ Space Bar 
1.6.1  วิธีการแบ่งหน้าจอแสดงผล  
1. ครูอธิบาย 

- บางครั้งเราต้องการมองหลายมุมพร้อมกันเพ่ือตรวจสอบรายละเอียด สามารถแบ่งหน้าจอได้ 
1, 2, หรือ 4 จอ 

2. ครูสาธิตการแบ่งหน้าจอ 
- คลิกท่ีไอคอนแสดงผล เช่น 1 จอ, 2 จอแนวนอน, 2 จอแนวตั้ง, 4 จอ 
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- แต่ละจอสามารถแสดงมุมมองต่างกันได้ 
3. ผู้เรียนลองแบ่งหน้าจอเป็น 4 จอ แล้วปรับแต่ละจอให้แสดงมุมมองต่างกัน (Top, Front, Right, 

Isometric) 
4. ครูถาม 

- การแบ่งหน้าจอหลายจอช่วยให้การออกแบบง่ายขึ้นได้อย่างไร 
5. ผู้เรียนแชร์ประสบการณ์การใช้งานจอหลายจอ 
1.6.2  การย่อหรือขยายมุมมอง - Zoom 
1. ครูอธิบาย 

- เมื่อออกแบบชิ้นงานขนาดใหญ่หรือมีรายละเอียดเล็ก เราต้องใช้ Zoom 
2. ครูสาธิตการใช้ Zoom 

- Zoom to Fit  ขยายชิ้นงานให้เต็มหน้าจอ 
- Zoom to Area ซูมเข้าไปที่บริเวณท่ีต้องการ โดยลากกรอบสี่เหลี่ยม 
- Zoom In/Out  ขยายหรือย่อมุมมองโดยคลิกปุ่มเครื่องหมาย + หรือ - 

3. ผู้เรียนลองใช้ Zoom ทั้ง 3 แบบกับชิ้นงานของตนเอง 
4. ครูแนะนำเทคนิค 

- สามารถใช้ Scroll Mouse เพ่ือ Zoom In/Out ได้เลย ง่ายและรวดเร็ว 
5. ผู้เรียนฝึกใช้ Mouse Scroll ซูมเข้า-ออกชิ้นงาน 

1.7  การเปลี่ยนมุมมองระนาบในแบบต่าง ๆ 
1. ครูอธิบาย 

- การเปลี ่ยนมุมมองสามารถทำได้หลายวิธ ี โดยใช้ Orientation ที ่ Space Bar หรือใช้ 
Shortcut Keys 

2. ครูสาธิตการใช้ Space Bar เพ่ือเปิด Orientation 

- กด Space Bar → หน้าต่าง Orientation จะปรากฏ 
- เล ือกม ุมมองท ี ่ต ้องการ ได ้แก ่  Top, Front, Right, Left, Back, Bottom, Isometric, 

Dimetric, Trimetric 
3. ผู้เรียนลองเปิด Space Bar และเปลี่ยนมุมมองไปมาระหว่างต่าง ๆ 
4. ครูสาธิต Shortcut Keys 

- Ctrl + 5 = Top View 
- Ctrl + 1 = Front View 
- Ctrl + 4 = Right View 
- Ctrl + 3 = Left View 
- Ctrl + 2 = Back View 
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- Ctrl + 6 = Bottom View 
- Ctrl + 7 = Isometric View 

5. ผู้เรียนฝึกใช้ Shortcut Keys โดยครูเรียกชื่อมุมมอง ผู้เรียนกดปุ่มที่ถูกต้องโดยเร็วที่สุด (เกม
แข่งขัน) 

6. ครูอธิบายเพิ่มเติม 
- View (Heads-Up)  คลิกเลือกมุมมองจากแถบด้านบน 
- Orientation  เปิดหน้าต่างกราฟิกเพ่ือเลือกมุมมองและหมุนชิ้นงาน 

7. ผู้เรียนลองใช้ทั้ง 3 วิธี (Space Bar, Shortcut Keys, View Heads-Up) แล้วเปรียบเทียบว่าวิธี
ไหนสะดวกท่ีสุด 

1.8  การเลือกการแสดงผลช้ินงานในหน้าต่างโปรแกรม 
1. ครูเปิดชิ้นงานเดียวกันในรูปแบบการแสดงผลต่าง ๆ 
2. ครูอธิบายรูปแบบการแสดงผล 

- Shaded with Edges: แสดงผลพร้อมเส้นขอบ (ใช้งานทั่วไป) 
- Shaded: แสดงผลแบบเรียบ ไม่มีเส้นขอบ (ดูสวยงาม) 
- Hidden Lines Remove: แสดงเส้นที่มองเห็น ซ่อนเส้นที่บังด้วยผิวชิ้นงาน 
- Hidden Lines Visible: แสดงเส้นทั้งหมดรวมถึงเส้นที่ถูกบัง (ใช้เส้นประ) 
- Wireframe: แสดงเฉพาะโครงสร้างของชิ้นงาน (ดูโครงสร้างภายใน) 

3. ครูสาธิตการเปลี่ยนรูปแบบการแสดงผล 

- ไปที่ View (Heads-Up) → คลิก Display Style 
- เลือกรูปแบบที่ต้องการ 

4. ผู้เรียนลองเปลี่ยนรูปแบบการแสดงผลไปมา แล้วสังเกตความแตกต่าง 
5. ครูถาม 

- รูปแบบไหนเหมาะกับการใช้งานประเภทไหน 
6. ผู้เรียนอภิปรายและสรุป เช่น 

- Shaded with Edges → ทำงานทั่วไป 

- Wireframe → ตรวจสอบโครงสร้างภายใน 

- Hidden Lines Remove → เตรียมทำ Drawing 
 

ขั้นฝึกฝน/ลงมือปฏิบัติ (Practice) 
1. ครใูห้ผู้เรียนทำใบงานที่ 1.2 
2. ผู้เรียนรับฟังคำอธิบาย อ่านใบงานและทำความเข้าใจตัวอย่างชิ้นงานที่ต้องสร้าง 
3. ผู้เรียนทำงานเป็นรายบุคคล โดยปฏิบัติตามข้ันตอน 
4. ครูเดินดูการทำงานและให้คำแนะนำ 
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5. ครูเดินสังเกตการทำงาน ให้คำแนะนำและแก้ปัญหาเมื่อผู้เรียนติดขัด 
6. ผู้เรียนที่ทำเสร็จก่อนช่วยเพื่อนที่ยังทำไม่เสร็จ 
7. ผู้เรียนบันทึกไฟล์งานโดยใช้ชื่อตามท่ีใบงานกำหนด 

 

ขั้นประยุกต์ใช ้(Production)  
กิจกรรม สร้างชุดภาพนำเสนอชิ้นงาน (Presentation Set) 

1. ครูให้โจทย์ สร้างชุดภาพนำเสนอชิ้นงานของคุณ โดยต้องมีภาพทั้งหมด 6 ภาพ ดังนี้ 
- มุมมอง Top View (Shaded with Edges) 
- มุมมอง Front View (Shaded with Edges) 
- มุมมอง Isometric (Shaded with Edges) 
- มุมมอง Isometric (Wireframe) 
- หน้าจอแบ่ง 4 จอ แสดงมุมมองทั้ง 4 ด้าน 
- มุมมองที่สวยงามที่สุดที่ผู้เรียนจัดวาง (เลือกฉากหลังและรูปแบบการแสดงผลเอง) 

2. ผู้เรียนทำงานเป็นรายบุคคล โดย 
- เปิดชิ้นงานที่สร้างไว้ 
- จัดมุมมองและรูปแบบการแสดงผลตามที่กำหนด 
- Screenshot ภาพแต่ละมุมมอง 
- รวบรวมภาพทั้งหมดใส่ไฟล์ Word พร้อมเขียนคำอธิบายแต่ละภาพ 

3. ผู้เรียนบันทึกไฟล์โดยใช้ชื่อที่ครูกำหนด เช่น  ชื่อ-สกุล_Presentation_Set 
4. ครูเดินสังเกตและให้คำแนะนำ 
5. ผู้เรียนแลกเปลี่ยนไฟล์ Presentation Set กับเพ่ือนข้างเคียง 
6. ผู้เรียนดูผลงานของเพ่ือนและให้ข้อเสนอแนะ 

- มุมมองชัดเจนหรือไม่ 
- รูปแบบการแสดงผลเหมาะสมหรือไม่ 
- มีข้อเสนอแนะเพ่ิมเติมอย่างไร 

7. ผู้เรียนเขียนข้อเสนอแนะลงในกระดาษ Post-it ติดให้เพ่ือน 
8. ครูเลือกผลงานที่โดดเด่น 3-4 ชิ้น ให้ผู้เรียนนำเสนอหน้าชั้นเรียน 
9. ผู้เรียนอธิบายว่าทำไมเลือกมุมมองและรูปแบบนั้น ๆ 
 

ขั้นสรุป/ประเมินผล (Wrap up) 
1. ครูใหผู้้เรียนทำแบบฝึกหัดหลังเรียน หน่วยที่ 1  
2. ผู้เรียนทำแบบฝึกหัดหลังเรียน หน่วยที่ 1 ตามที่ครูมอบหมาย 
3. ครแูละผู้เรียนร่วมสรุปเนื้อหาและประเด็นสำคัญ 
4. ผู้เรียนตั้งคำถามและข้อสงสัย  
5. ครแูจ้งหัวข้อที่จะเรียนครั้งต่อไป 
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6. ผู้เรียนเตรียมความพร้อมสำหรับบทเรียนต่อไป 
 
สื่อและแหล่งการเรียนรู้ 

เอกสาร/หนังสือ/ตำรา:  
หนังสือเรียนวิชา งานเขียนแบบเครื่องกลด้วยคอมพิวเตอร์ (Computer-Aided Mechanical Drafting 

Job) รหัสวิชา 20101-2029 หน่วยการเรียนรู้ที่ 1 เรื่อง การใช้งาน SOLIDWORKS เบื้องต้น และมุมมองชิ้นงาน 
ของบริษัท สำนักพิมพ์เอมพันธ์ จำกัด 

สื่อโสตทัศน์ 
สไลด์ Power Point หน่วยการเรียนรู้ที่ 1 การใช้งาน SOLIDWORKS เบื้องต้น และมุมมองชิ้นงาน 

ส่ือออนไลน์ 
  - 

ส่ือจำลองหรือของจริง 
 - 

 อื่น ๆ  
  - 

หลักฐานการเรียนรู้ 
หลักฐานความรู้ 
1. ผลการทำแบบฝึกหัดหลังเรียน หน่วยที่ 1 
2. ผลการตอบคำถามทบทวนความรู้ 
3. ผลการตรวจแบบทดสอบหลังเรียน หน่วยที่ 1 

 หลักฐานการปฏิบัติงาน 
1. ผลการปฏิบัติงานตามใบงานที่ 1.1 
2. ผลการปฏิบัติงานตามใบงานที่ 1.2 
3. ผลการออกแบบชิ้นงานง่าย ๆ ที่ใช้ประโยชน์ในชีวิตประจำวัน โดยใช้ Feature พ้ืนฐานที่เรียนมา 
4. ผลสร้างชุดภาพนำเสนอชิ้นงาน (Presentation Set) 

 หลักฐานคุณลักษณะอันพึงประสงค์ 
1. ผลการประเมินตามแบบประเมินคุณธรรม จริยธรรม ตามสภาพจริง 

การวัดและประเมินผล 
เครื่องมือวัด วิธีวัด การประเมินตามเกณฑ ์

1. ใบงานที่ 1.1 ปฏิบัติ-ตรวจแบบฝึกหัด เกณฑ์ผ่าน 50% 

2. ใบงานที่ 1.2 ปฏิบัติ-ตรวจแบบฝึกหัด เกณฑ์ผ่าน 50% 
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3. แบบฝึกหัดหลังเรียน หน่วยที่ 1 ตรวจแบบฝึกหัด เกณฑ์ผ่าน 50% 

4. แบบทดสอบหลังเรียน หน่วยที่ 1 ทดสอบ-ตรวจแบบทดสอบ เกณฑ์ผ่าน 50% 

5. แบบประเมินคุณธรรม จริยธรรม ตามสภาพจริง สังเกต/ผู้เรียนประเมินตนเอง เกณฑ์ผ่าน 70% 
 

งานที่มอบหมาย 
1. งานที่มอบหมายนอกเหนือเวลาเรียน ให้ทำแบบฝึกหัดที่ทำไม่แล้วเสร็จในห้องเรียนให้เรียบร้อย 
2. ออกแบบชิ้นงานง่าย ๆ ที่ใช้ประโยชน์ในชีวิตประจำวัน โดยใช้ Feature พ้ืนฐานที่เรียนมา 
3. สร้างชุดภาพนำเสนอชิ้นงาน (Presentation Set) 
4. สืบค้นข้อมูลเพิ่มเติมเก่ียวกับเนื้อหาที่จะเรียนในครั้งถัดไป 

 

เอกสารอ้างอิง 
 ผศ.กีรดิษ สายพัทลุง. (2567). งานเขียนแบบเครื่องกลด้วยคอมพิวเตอร์ (Computer-Aided Mechanical 
Drafting Job). เอมพันธ์. 
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บันทึกผลหลังการจัดการเรียนรู้ (ครั้งที่ 1/18, ชั่วโมงท่ี 1-7/126) 
1. ผลการจัดการเรียนรู้ที่เกิดขึ้นกับผู้เรียน 

               
               
               

2. ปัญหา อุปสรรคที่พบ 
               
               
               

3. การแก้ไขปัญหา 
3.1) ผลการแก้ไขปัญหาที่ส่งผลลัพธ์ที่ดีต่อผู้เรียน 

               
               

3.2) แนวทางแก้ปัญหาในครั้งต่อไป 
               
               

 
 

ลงชื่อ 
                        (.........................................)

                    ครูผู้สอน   
     ………./…………/………… 
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บันทึกผลหลังการจัดการเรียนรู้ (ครั้งที่ 2/18, ชั่วโมงท่ี 8-14/126) 
1. ผลการจัดการเรียนรู้ที่เกิดขึ้นกับผู้เรียน 

               
               
               

2. ปัญหา อุปสรรคที่พบ 
               
               
               

3. การแก้ไขปัญหา 
3.1) ผลการแก้ไขปัญหาที่ส่งผลลัพธ์ที่ดีต่อผู้เรียน 

               
               

3.2) แนวทางแก้ปัญหาในครั้งต่อไป 
               
               

 
 

ลงชื่อ 
                        (.........................................)

                    ครูผู้สอน   
     ………./…………/………… 
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แผนการจัดการเรียนรู้ที่ 2  หน่วยที่    2    . 
รหัสวิชา 20101 – 2029  ชื ่อวิชา งานเขียนแบบเครื ่องกลด้วย
คอมพิวเตอร์ (Computer-Aided Mechanical Drafting Job) 

สอนครั้งที ่ 3 - 5  .  

ชื่อหน่วยการเรียนรู้   การใช้เครื่องมือวาดเส้นร่างพ้ืนฐาน และระดับสูง ทฤษฎี    3    ชม.  
ปฏิบัติ   18   ชม. ชื่อเรื่อง     การใช้เครื่องมือวาดเส้นร่างพ้ืนฐาน และระดับสูง      

สาระสำคัญ 
 การใช้เครื่องมือวาดเส้นในโปรแกรม SOLIDWORK มีความสำคัญอย่างยิ่งต่อการออกแบบชิ้นงาน 3 มิติ 
โดยแบ่งเป็นเครื ่องมือพื ้นฐานที ่ใช้สร้างรูปทรงเบื ้องต้น ได้แก่ เครื ่องมือสร้างเส้นตรง (Line) ที ่สามารถ         
กำหนดความยาวและองศาได้, เครื ่องมือสร้างสี ่ เหลี ่ยม  (Rectangle) ที ่ม ีหลายรูปแบบทั ้งแบบมุมและ             
แบบกำหนดจุดศูนย์กลาง, และเครื่องมือสร้างวงกลม (Circle) ที่สามารถกำหนดรัศมีได้ และเครื่องมือขั้นสูง  
สำหรับสร้างรูปทรงที ่ซ ับซ้อนขึ ้น เช่น เครื ่องมือสร้างรูปหลายเหลี ่ยม (Polygon), เครื ่องมือสร้างเส้นโค้ง     
ประเภทต่างๆ ทั้งแบบต่อเนื่องจากเส้นตรง (Tangent Arc), แบบกำหนดจุดเริ่มต้นและสิ้นสุด (3 Point Arc), 
แบบวงร ี  (Ellipse), แบบพารา โบลา  (Parabola), แบบกรวย  (Conic), และแบบต ่ อ เน ื ่ อ ง  (Spline)                        
ซึ่งเครื่องมือเหล่านี้มีความสำคัญ   ในการสร้างแบบร่าง 2 มิติ ที่จะนำไปพัฒนาเป็นชิ้นงาน 3 มิติ ที่มีความซับซ้อน
ต่อไป 
 

ผลลัพธ์การเรียนรู้ระดับหน่วยการเรียน 
ผู้เรียนสามารถแยกแยะความแตกต่างระหว่างงานออกแบบ 2 มิติ และ 3 มิติ ใช้เครื่องมือวาดเส้นร่าง

พื้นฐานและระดับสูงได้อย่างถูกต้อง ตลอดจนประยุกต์ใช้เครื่องมือต่าง ๆ เพื่อสร้างรูปทรงที่หลากหลายได้อย่างมี
ประสิทธิภาพ 

 
 

อ้างอิงมาตรฐาน/เชื่อมโยงกลุ่มอาชีพ 
 - 

 

สมรรถนะประจำหน่วย 
4. แสดงความรู้เกี่ยวกับความแตกต่างระหว่าง 2 มิติ และ 3 มิติ และหลักการใช้เครื่องมือวาดเส้นร่าง

ประเภทต่าง ๆ 
5. มีทักษะการใช้เครื่องมือวาดเส้นร่างพื้นฐานและระดับสูงในการสร้างรูปทรงที่หลากหลาย 
6. ประยุกต์ใช้เทคนิคการวาดเส้นร่างในการออกแบบและสร้างชิ้นงานที่มีความซับซ้อน 

จุดประสงค์เชิงพฤติกรรม   

ด้านความรู้ (Knowledge) 
2. อธิบายเกี่ยวกับความแตกต่างระหว่าง 2 มิติ และ 3 มิติ และการเปลี่ยนมุมมองในงานออกแบบเพ่ือเพ่ิม

ประสิทธิภาพในการทำงานได้ 
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ด้านทักษะ/กระบวนการ (Process) 
3. ใช้เครื่องมือวาดเส้นร่างพื้นฐานในการสร้างรูปทรงเรขาคณิตเบื้องต้นเพื่อเป็นพื้นฐานในการออกแบบ

ชิ้นงานได ้
4. ผสมผสานการใช้เครื่องมือวาดเส้นร่างประเภทต่าง ๆ เพื่อสร้างสรรค์ชิ้นงานที่มีความหลากหลายและ

สวยงามได้ 
 

คุณลักษณะท่ีพึงประสงค์ (Attitude)   
2. มีเจตคติและกิจนิสัยที่ดีในการปฏิบัติงานด้วยความละเอียด รอบคอบ และถูกต้องตามหลักการออกแบบ

และการใช้เครื่องมือวาดเส้นร่าง 

ด้านการประยุกต์ใช้ (Apply)  
1. ประยุกต์ใช้เครื่องมือวาดเส้นร่างระดับสูงในการสร้างรูปทรงที่มีความซับซ้อนเพ่ือพัฒนางานออกแบบที่มี

ประสิทธิภาพได้ 

สาระการเรียนรู้ 
 2.1 ความแตกต่างระหว่าง 2 มิติ และ  3 มิติ 

2.2 การเปลี่ยนมุมมองแบบรวดเร็ว 
2.3 การวาดเส้นร่างพื้นฐาน 
 2.3.1 การทำงานกับเส้นตรง 

2.3.2 การกำหนดความยาวให้กับเส้นตรง 
2.3.3 การกำหนดให้เส้นตรงมีความยาวเท่ากัน 
2.3.4 การกำหนดองศาในมุมของเส้นตรง 
2.3.5 การทำงานกับเส้นสี่เหลี่ยม 
2.3.6 การทำงานกับเส้นวงกลม 

2.4 การใช้เครื่องมือวาดเส้นร่างระดับสูง 
 2.4.1 การสร้างรูปทรงหลายเหลี่ยม 

2.4.2 การสร้างเส้นโค้งจากวงกลม 
2.4.3 การสร้างเส้นโค้งต่อจากเส้นร่าง 
2.4.4 การสร้างเส้นโค้งแบบกำหนดจุดเริ่มและจุดสิ้นสุด 
2.4.5 การสร้างเส้นรูปวงรี 
2.4.6 การสร้างเส้นโค้งจากวงรี 
2.4.7 การสร้างเส้นโค้งแบบพาราโบลา 
2.4.8 การสร้างเส้นโค้งแบบกรวย 
2.4.9 การสร้างเส้นโค้งต่อเนื่อง 
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กิจกรรมการเรียนรู้ (ครั้งท่ี 3/18, ชั่วโมงที่ 15-21/126) 
ขั้นนำเข้าสู่บทเรียน (Warm up) 
10. ครูฉายภาพวัตถุ 3 มิติจริง (เช่น กล่อง ถ้วย เฟือง) และภาพเขียนแบบ 2D ของวัตถุเหล่านั้นบนจอ 
11. ผู้เรียนแบ่งกลุ่มย่อย 3-4 คน สังเกตและเปรียบเทียบความแตกต่าง 
12. ครูถามกระตุ้นความคิด 

- ถ้าเราต้องการสร้างชิ้นงานจริง เราจะใช้แบบ 2D หรือ 3D ดีกว่า เพราะอะไร 
13. ตัวแทนกลุ่มแชร์ความคิดเห็น 2-3 กลุ่ม 
14. ครูแนะนำวัตถุประสงค์การเรียนรู้วันนี้ 
15. ผู้เรียนดูตัวอย่างชิ้นงานที่สร้างจาก SOLIDWORKS (ครูเปิดไฟล์ตัวอย่างให้ดู) 
16. ครูหมุนวัตถุ 3D บนหน้าจอและถามผู้เรียน 

- ถ้าเราต้องการมองจากมุมต่างๆ เราจะทำอย่างไร 
17. ผู้เรียนร่วมแสดงความคิดเห็นและคาดเดาวิธีการ 

 

ขั้นการสอน/การนำเสนอ (Presentation) 
2.1  ความแตกต่างระหว่าง 2 มิติ และ 3 มิติ 
1. ครูเปิดโปรแกรม SOLIDWORKS และผู้เรียนเปิดตามที่เครื่องของตนเอง 
2. ครูอธิบายระบบ 3 ระนาบ พร้อมสาธิต ได้แก่ 

- Front Plane 
- Top Plane 
- Right Plane  

3. ผู้เรียนสังเกตแกน X, Y, Z บนหน้าจอของตนเอง 
4. ครูใหผู้้เรียนลองคลิกที่ระนาบต่างๆ และสังเกตการเปลี่ยนแปลง 
5. ผู้เรียนจับคู่อภิปรายว่า 

- แต่ละระนาบใช้สำหรับมองจากมุมใด 
6. ครูสร้างรูปทรงสี่เหลี่ยมบน Top Plane เป็นตัวอย่าง 
7. ผู้เรียนทำตามทีละข้ันตอน 
8. ครูใหผู้้เรียนช่วยกันบอกว่า  

- ถ้าเราสร้างบน Front Plane รูปจะออกมาเป็นอย่างไร 
9. ผู้เรียน 2-3 คนสาธิตหน้าชั้นเรียน (ครูสนับสนุนและชี้แนะ) 
2.2  การเปลี่ยนมุมมองแบบรวดเร็ว 
1. ครูแนะนำ Graphics Area และสาธิตการหมุนมุมมอง (Top, Left, Right, Bottom) 
2. ผู้เรียนลองหมุนดูชิ้นงานที่สร้างไว้ของตนเองจากทุกมุม 
3. ครูท้าทายผู้เรียน 
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- หาวิธีเปลี่ยนไปมุม Front Plane ให้เร็วที่สุด ภายใน 3 วินาที 
4. ผู้เรียนฝึกหัดและแข่งกันภายในกลุ่ม 
5. ครูแนะนำ Feature Manager Design Tree และวิธีเลือกระนาบด้วยการคลิก 
6. ผู้เรียนฝึกเปลี่ยนระนาบด้วย Feature Manager 
7. ครูถาม 

- วิธีใดสะดวกกว่ากัน Graphics Area หรือ Feature Manager  เพราะเหตุใด 
8. ผู้เรียนแชร์ประสบการณ์และเหตุผล 4-5 คน 

 

ขั้นฝึกฝน/ลงมือปฏิบัติ (Practice) 
1. ครใูห้ผู้เรียนทำใบงานเพ่ิมเติมที่ 1 
2. ผู้เรียนรับฟังคำอธิบาย อ่านใบงานและทำความเข้าใจใบงานที่ต้องทำ 
3. ผู้เรียนทำงานเป็นรายบุคคล โดยปฏิบัติตามข้ันตอน 
4. ครูเดินดูการทำงานและให้คำแนะนำ 
5. ครูเดินสังเกตการทำงาน ให้คำแนะนำและแก้ปัญหาเมื่อผู้เรียนติดขัด 
6. ผู้เรียนที่ทำเสร็จก่อนช่วยเพื่อนที่ยังทำไม่เสร็จ 
7. ผู้เรียนบันทึกไฟล์งานโดยใช้ชื่อตามท่ีใบงานกำหนด 
 

ขั้นประยุกต์ใช ้(Production)  
กิจกรรม Mini Challenge ออกแบบโลโก้ 3D 
1. ครูให้โจทย์ ดังนี้ 

- ผู้เรียนแบ่งกลุ่ม 4 คน 
- แต่ละกลุ่มออกแบบโลโก้ตัวอักษรชื่อกลุ่มตนเอง (1 ตัวอักษร) 
- ใช้ความรู้ทั้งหมดที่เรียนมา ได้แก่ เลือกระนาบ  วาดรูปทรง, Extrude, เปลี่ยนมุมมอง โดยใช้

เวลา 15 นาที 
- นำเสนอผลงานหน้าชั้นเรียน กลุ่มละ 1 นาที 

2. ครูระบุขั้นตอนกิจกรรม ดังนี้ 
- ผู้เรียนปรึกษากลุ่มและสเก็ตช์ร่างแบบบนกระดาษ 
- แบ่งหน ้าท ี ่ก ันทำใน SOLIDWORKS  ได ้แก ่  คนวาด , คนเล ือกระนาบ , คน Extrude,              

คนตรวจสอบ  
- ฝึกนำเสนอภายในกลุ่ม  

3. ครูเดินสังเกตการทำงานกลุ่ม คอยให้คำแนะนำ 
4. ผู้เรียนนำเสนอหน้าชั้นเรียนพร้อมอธิบาย 

- ใช้ระนาบอะไร  
- ทำไมเลือกระนาบนั้น  
- และมุมมองไหนดูสวยที่สุด  
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5. ทุกคนในชั้นให้ feedback เชิงบวกกับแต่ละกลุ่ม และ โหวตกลุ่มท่ีมีความคิดสร้างสรรค์ท่ีสุด 
 

ขั้นสรุป/ประเมินผล (Wrap up) 
1. ครูและผู้เรียนร่วมกันสรุปประเด็นสำคัญ 
2. ผู้เรียนฟังการสรุปและจดบันทึกสาระสำคัญ 
3. ครูถามคำถามทบทวนความรู้  
4. ผู้เรียนตอบคำถามทบทวน 
5. ผู้เรียนสอบถามข้อสงสัยที่ยังไม่เข้าใจ 
6. ครูแจ้งหัวข้อที่จะเรียนครั้งต่อไป 
7. ผู้เรียนเตรียมความพร้อมสำหรับบทเรียนต่อไป 
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ใบงานเพิ่มเติมที ่1 หน่วยที่   2   .   
รหัสวิชา 20101 – 2029  ช ื ่อว ิชา  งานเขียนแบบเครื ่องกลด ้วย
คอมพิวเตอร์       

สอนครั้งที ่ 3  .       

ชื่อหน่วยการเรียนรู้   การใช้เครื่องมือวาดเส้นร่างพ้ืนฐาน และระดับสูง     ทฤษฎี   3  ชม.  
ปฏิบัติ  18 ชม. ชื่อเรื่อง  การฝึกเปลี่ยนระนาบและมุมมองใน SOLIDWORKS       

 

1.  ผลลัพธ์การเรียนรู้จากการปฏิบัติงาน 
 ผู้เรียนจะได้พัฒนาทักษะพ้ืนฐานที่สำคัญในการใช้งานโปรแกรม SOLIDWORKS ได้แก่ ความเข้าใจเกี่ยวกับ
ระบบแกนพิกัด 3 มิติ (X, Y, Z) และระนาบอ้างอิงทั้ง 3 ระนาบ ได้แก่ Front Plane, Top Plane และ Right 
Plane รวมถึงความสามารถในการสลับเปลี่ยนมุมมองการแสดงผลอย่างคล่องแคล่วและรวดเร็ว ซึ่งเป็นทักษะ
จำเป็นสำหรับการออกแบบและเขียนแบบ 3 มิติอย่างมีประสิทธิภาพ นอกจากนี้ผู้เรียนยังได้เรียนรู้การวิเคราะห์
ความแตกต่างระหว่างการแสดงผลแบบ 2 มิติและ 3 มิติ ซึ ่งจะช่วยให้สามารถเลื อกใช้วิธีการแสดงผล     ที่
เหมาะสมกับลักษณะงานได้อย่างถูกต้อง 
 

2.  อ้างอิงมาตรฐาน/เชื่อมโยงกลุ่มอาชีพ 
 - 

 

3. สมรรถนะการปฏิบัติงาน 
3.1  อธิบายความแตกต่างระหว่าง 2D และ 3D และระบุระนาบทั้ง 3 (Front, Top, Right Plane) ได้ถูกต้อง 
3.2  สร้างรูปทรงเรขาคณิตพ้ืนฐานบนระนาบที่กำหนดและใช้คำสั่ง Extrude ได้อย่างถูกต้อง 
3.3  เปลี่ยนมุมมองการแสดงผล (Top, Front, Right, Trimetric) ได้อย่างรวดเร็วและคล่องแคล่ว 
3.4  ใช้เครื่องมือ Graphics Area และ Feature Manager Design Tree ในการทำงานได้อย่างเหมาะสม 
3.5  บันทึกและจัดเก็บไฟล์งานได้ถูกต้องตามระบบ 
 

4.  จุดประสงค์เชิงพฤติกรรม  
ด้านความรู้ (Knowledge) 
1. อธิบายเกี่ยวกับความแตกต่างระหว่าง 2 มิติ และ 3 มิติ และการเปลี่ยนมุมมองในงานออกแบบเพ่ือเพ่ิม

ประสิทธิภาพในการทำงานได้ 
 

ด้านทักษะ/กระบวนการ  (Process) 
1. ใช้เครื่องมือวาดเส้นร่างพื้นฐานในการสร้างรูปทรงเรขาคณิตเบื้องต้นเพื่อเป็นพื้นฐานในการออกแบบ

ชิ้นงานได ้
2. ผสมผสานการใช้เครื่องมือวาดเส้นร่างประเภทต่าง ๆ เพื่อสร้างสรรค์ชิ้นงานที่มีความหลากหลายและ

สวยงามได้ 
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คุณลักษณะท่ีพึงประสงค์ (Attitude)   
1. มีเจตคติและกิจนิสัยที ่ดีในการปฏิบัติงานด้วยความละเอียด รอบคอบ และถูกต้องตามหลักการ

ออกแบบและการใช้เครื่องมือวาดเส้นร่าง 

ด้านการประยุกต์ใช้ (Apply)  
ประยุกต์ใช้เครื่องมือวาดเส้นร่างระดับสูงในการสร้างรูปทรงที่มีความซับซ้อนเพื่อพัฒนางานออกแบบที่มี

ประสิทธิภาพได้ 
  

5.  เครื่องมือ วัสดุ และอุปกรณ์ 
5.1  เครื่องคอมพิวเตอร์ที่มีคุณสมบัติรองรับ SOLIDWORKS จำนวน 1 เครื่อง/คน 

- เมาส์ 3 ปุ่ม (แนะนำใช้เมาส์ที่มี scroll wheel) 
- จอภาพขนาดไม่น้อยกว่า 15 นิ้ว 

5.2 ซอฟต์แวร์ 
- โปรแกรม SOLIDWORKS 
- โปรแกรมจับภาพหน้าจอ (Snipping Tool, Windows + Shift + S หรือ Print Screen) 
- โปรแกรม Microsoft Word หรือ PDF Reader สำหรับเปิดใบงาน 

5.3 กระดาษ A4 สำหรับจดบันทึกและร่างแบบ 
 

6.  คำแนะนำ/ข้อควรระวัง  
6.1  ตรวจสอบการทำงานของเมาส์ให้พร้อมใช้งาน โดยเฉพาะ scroll wheel 
6.2  ตั้งชื่อไฟล์ตามที่ครูกำหนด เช่น "ชื่อ-นามสกุล_ใบงานเพ่ิมเติมที1่_วันที่" 
6.3  บันทึกไฟล์ทุกๆ 10-15 นาที โดยใช้ Ctrl + S 
6.4  ตั้งชื่อไฟล์ที่มีความหมายชัดเจน 
6.5  สำรองไฟล์ในตำแหน่งอ่ืนด้วย (เช่น USB Drive, Cloud Storage) 

 

7.  ขั้นตอนการปฏิบัติงาน 
ภารกิจที่ 1  ทำความรู้จักกับระบบระนาบและแกนพิกัด  

ขั้นตอนที่ 1.1 เปิดโปรแกรม SOLIDWORKS 
1. คลิกไอคอน SOLIDWORKS บนเดสก์ท็อป 
2. เลือก File > New > Part > OK 
3. จะปรากฏหน้าจอการทำงาน (Graphics Area) พร้อมระนาบทั้ง 3 

ขั้นตอนที่ 1.2 สำรวจระบบระนาบ 
1. สังเกตแกนสีต่างๆ ที่มุมล่างซ้าย  

- แกน X (สีแดง) - แนวนอน 
- แกน Y (สีเขียว) - แนวตั้ง 
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- แกน Z (สีน้ำเงิน) - แนวลึก 
2. ในพ้ืนที่ทำงานจะมี 3 ระนาบ 

- Front Plane (สีน้ำเงินอ่อน) - ระนาบหน้า 
- Top Plane (สีเขียวอ่อน) - ระนาบบน 
- Right Plane (สีแดงอ่อน) - ระนาบขวา 

ขั้นตอนที่ 1.3 ฝึกการเลือกระนาบ 
1. คลิกท่ี "Front Plane" ใน Feature Manager Design Tree (แถบด้านซ้าย)  

- สังเกตว่าระนาบจะเปลี่ยนเป็นสีส้ม (แสดงว่าถูกเลือก) 
2. ทำซ้ำกับ "Top Plane" และ "Right Plane" 
3. บันทึกการสังเกต  

- ระนาบแต่ละระนาบขนานกับแกนใดบ้าง 
4. ให้จดบันทึก 

- Front Plane ขนานกับแกน ______  และ ______ 
- Top Plane ขนานกับแกน ______  และ ______ 
- Right Plane ขนานกับแกน ______  และ ______ 

ภารกิจที่ 2  ฝึกการสร้างรูปทรงบนระนาบต่างๆ  
ขั้นตอนที่ 2.1 สร้างรูปสี่เหลี่ยมบน Top Plane 

1. คลิกเลือก "Top Plane" จาก Feature Manager Design Tree 
2. คลิกท่ี Sketch > เลือก Center Rectangle จากแถบเครื่องมือ 
3. คลิกท่ีจุดกึ่งกลาง (Origin) แล้วลากออกมา 
4. ใส่ขนาด 

- กว้าง 50 mm ยาว 30 mm 
5. คลิก OK หรือกด ESC เพ่ือออกจากโหมด Sketch 

ขั้นตอนที่ 2.2 Extrude รูปที่สร้าง 
1. คลิกเลือกรูปสี่เหลี่ยมที่สร้าง 
2. คลิก Features > Extruded Boss/Base 
3. ตั้งค่า  

- Direction 1: Blind 
- Depth: 10 mm 

4. คลิก OK (เครื่องหมายถูกสีเขียว) 
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ขั้นตอนที่ 2.3 สร้างวงกลมบน Front Plane 
1. คลิกเลือก  Front Plane 
2. คลิก Sketch > เลือก Circle 
3. คลิกท่ีจุดกึ่งกลาง (Origin) แล้วลากออกมา 
4. ใส่ขนาด  

- Diameter (เส้นผ่านศูนย์กลาง) 25 mm 
5. ออกจากโหมด Sketch 

ขั้นตอนที่ 2.4 Extrude วงกลม 
1. คลิกเลือกวงกลมที่สร้าง 
2. คลิก Features > Extruded Boss/Base 
3. ตั้งค่า  

- Direction 1: Blind 
- Depth: 15 mm 

4. คลิก OK 
5.  ให้บันทึกภาพ  

- จับภาพหน้าจอชิ้นงานที่สร้างเสร็จแล้ว (มุมมอง Trimetric) 
- บันทึกเป็น "ชื่อ_ภารกิจ2_เสร็จสิ้น.jpg" 

ภารกิจที่ 3  ฝึกการเปลี่ยนมุมมองอย่างรวดเร็ว 
ขั้นตอนที่ 3.1 เปลี่ยนมุมมองด้วย Graphics Area 

1. สังเกต Graphics Area (พ้ืนที่ 4 เหลี่ยมที่มุมบนขวา) มี 4 มุมมอง 
- Top (บน) 
- Front (หน้า) 
- Right (ขวา) 
- Trimetric (มุม 3 มิติ) 

2. คลิกท่ี  Top - บันทึกภาพหน้าจอ 
3. คลิกท่ี  Front - บันทึกภาพหน้าจอ 
4. คลิกท่ี  Right - บันทึกภาพหน้าจอ 
5. คลิกท่ี  Trimetric - บันทึกภาพหน้าจอ 

 สังเกตและเปรียบเทียบ 
- มุมมองใดเห็นสี่เหลี่ยมชัดที่สุด ……………………………………………………………………………… 
- มุมมองใดเห็นวงกลมชัดที่สุด ………………………………………………………………………………… 
- มุมมองใดเหมาะสำหรับดูภาพรวมของชิ้นงาน........................................................................ 
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ขั้นตอนท่ี 3.2 เปลี่ยนระนาบด้วย Feature Manager 
1. เปิด Feature Manager Design Tree (แถบซ้าย) 
2. คลิกขวาท่ี "Front Plane" > เลือก "Normal To"  

- มุมมองจะเปลี่ยนเป็นการมองตรง (90°) กับระนาบน้ัน 
3. ทำซ้ำกับ "Top Plane" และ "Right Plane" 

ขั้นตอนที่ 3.3 ทดสอบความเร็ว (จับเวลา) 
1. ต้ังเวลาถอยหลัง 30 วินาที 
2. เปลี่ยนมุมมองตามลำดับ  

- Top → Front → Right → Trimetric → Top 
3. ทำซ้ำจนครบ 30 วินาที 
4. บันทึกจำนวนรอบท่ีทำได้...................................รอบ 
5. เป้าหมาย 

- เก่ง : 5 รอบขึ้นไป 
- ดี : 3-4 รอบ 
- พอใช ้: 2 รอบ 

ขั้นตอนที่ 3.4  ฝึกการหมุนมุมมองแบบอิสระ 
1. กดปุ่มกลางเมาส์ (Scroll Wheel) ค้างไว้ 
2. เลื่อนเมาส์ไปรอบๆ เพ่ือหมุนชิ้นงาน 
3. ฝึกจนหมุนได้คล่องแคล่ว 360 องศา 
4. ลองซูมเข้า-ออกด้วยการหมุน Scroll Wheel 

ภารกิจที่ 4  บันทึกและจัดเก็บผลงาน 
ขั้นตอนที่ 4.1 บันทึกไฟล์ 

1. คลิก File > Save As 
2. ตั้งชื่อไฟล์ เช่น "ชื่อ-นามสกุล_ใบงานเพ่ิมเติม 1" 
3. เลือกตำแหน่งที่บันทึก เช่น  D:/SOLIDWORKS_Workshop/Lesson02 
4. คลิก Save 

ขั้นตอนที่ 4.2 จัดเก็บภาพหน้าจอท้ังหมด 
1. สร้างโฟลเดอร์ย่อย "Screenshots" 
2. ย้ายภาพทั้งหมดที่บันทึกไว้เข้าโฟลเดอร์ 
3. ตรวจสอบว่ามีภาพครบทั้ง 4 มุมมอง 
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ขั้นตอนที่ 4.3 สำรองไฟล์ 
1. คัดลอกไฟล์ .SLDPRT ไปยัง USB Drive หรือ Cloud 
2. บีบอัดไฟล์ (Zip) พร้อมภาพหน้าจอ 
3. เตรียมส่งอาจารย์ผู้สอน 

 
8.  สรุปและวิจารณ์ผล 
 8.1  สรุปผลการปฏิบัติงาน (กรอกข้อมูลต่อไปนี้หลังจากทำภารกิจเสร็จสิ้น) 

ผลการปฏิบัติงาน 
ภารกิจที่ 1  ทำสำเร็จ / ไม่สำเร็จ (เหตุผล : ............................................................................. ) 
ภารกิจที่ 2  ทำสำเร็จ / ไม่สำเร็จ (เหตุผล : ............................................................................. ) 
ภารกิจที่ 3  ทำสำเร็จ / ไม่สำเร็จ (เหตุผล : ............................................................................. ) 
ภารกิจที่ 4  ทำสำเร็จ / ไม่สำเร็จ (เหตุผล : ............................................................................. ) 

เวลาที่ใช้จริง 
ภารกิจที่ 1.........................................................นาท ี
ภารกิจที่ 2.........................................................นาท ี
ภารกิจที่ 3.........................................................นาท ี
ภารกิจที่ 4.........................................................นาท ี
รวมเวลาทั้งหมด.................................................นาท ี

 8.2  ปัญหาที่พบและวิธีแก้ไข 
ปัญหาที่พบ สาเหตุ วิธีแก้ไข ผลลัพธ์ 

ไม่สามารถเลือกระนาบได้ คลิกผดิตำแหน่ง 
คลิกท่ีชื่อระนาบใน Feature 

Manager แทน 
แก้ไขได้สำเร็จ 

1. 
   

2. 
   

3. 
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9.  การประเมินผล 

หัวข้อการประเมิน 
คะแนน

เต็ม 
คะแนน

ที่ได้ 
หมายเหตุ 

1. ความถูกต้องของงาน  
   

1.1 สร้างรูปทรงบน Top Plane ถูกต้อง (ขนาด 50x30 mm, Extrude 10 
mm) 

2 
  

1.2 สร้างวงกลมบน Front Plane ถูกต้อง (Ø25 mm, Extrude 15 mm) 2 
  

1.3 ตำแหน่งการวางรูปทรงเหมาะสม (ไม่ทบัซ้อนหรือห่างเกินไป) 2 
  

1.4 บันทึกไฟล์ถูกต้องตามรปูแบบที่กำหนด 2 
  

2. ความครบถ้วนของภาพหน้าจอ  
   

2.1 ภาพหน้าจอ 4 มุมมอง (Top, Front, Right, Trimetric) ครบถ้วน 2 
  

2.2 ภาพมีความชัดเจน มชีื่อไฟล์ถูกต้อง 2 
  

3. การวิเคราะห์และวิจารณ์ผล  
   

3.1 ตอบคำถามครบถ้วน มีเหตุผลและตวัอย่างประกอบ 2 
  

3.2 วิเคราะห์ปัญหาและเสนอแนวทางแก้ไขได้อย่างเหมาะสม 2 
  

3.3 ประเมินทักษะตนเองได้อยา่งตรงประเดน็  1 
  

4. ความเร็วและประสิทธิภาพ  
   

4.1 ทำภารกิจให้เสร็จภายในเวลาที่กำหนด (60 นาที) 1 
  

4.2 ทดสอบความเร็วในการเปลีย่นมุมมอง (3 รอบขึ้นไป) 2 
  

รวมคะแนนทั้งหมด 20 
  

 

10.  หนังสืออ้างอิง /หนังสือค้นคว้าเพิ่มเติม 
 หนังสือเรียนวิชา งานเขียนแบบเครื่องกลด้วยคอมพิวเตอร์ (Computer-Aided Mechanical Drafting 
Job) รหัสวิชา 20101-2029 หน่วยการเรียนรู้ที่ 2 เรื่อง การใช้เครื่องมือวาดเส้นร่างพื้นฐาน และระดับสูง  ของ
บริษัท สำนักพิมพ์เอมพันธ์ จำกัด 
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กิจกรรมการเรียนรู้ (ครั้งท่ี 4/18, ชั่วโมงที่ 22-28/126) 

ขั้นนำเข้าสู่บทเรียน (Warm up) 
8. ครูนำเสนอโลโก้บริษัทรถยนต์ชื่อดังหลายแบบ (เช่น Mercedes-Benz, BMW, Toyota, Volkswagen) 

บนจอ 
9. ผู้เรียนแบ่งกลุ่ม 3-4 คน สังเกตและวิเคราะห์ว่าโลโก้แต่ละแบบประกอบด้วยรูปเรขาคณิตพื้นฐาน

อะไรบ้าง 
10. ครูถามกระตุ้น 

- โลโก้ Mercedes-Benz ประกอบด้วยรูปทรงอะไรบ้าง (วงกลม,  เส้นตรง,  สามเหลี่ยม) 
11. ตัวแทนกลุ่มแชร์ความคิดเห็น 2-3 กลุ่ม 
12. ครูแนะนำวัตถุประสงค์การเรียนรู้ 

- วันนี้เราจะเรียนรู้เครื่องมือพื้นฐาน 3 อย่างคือ Line (เส้นตรง), Rectangle (สี่เหลี่ยม), และ 
Circle (วงกลม) 

13. ครูสาธิตโลโกง้่ายๆ ที่สร้างจากรูปเรขาคณิตพ้ืนฐาน (ตัวอย่างจากใบงาน 2.1) 
14. ผู้เรียนคาดเดาว่าจะใช้เครื่องมือใดในการสร้างโลโก้แต่ละส่วน 
15. ครูแจ้งว่า 

- วันนี้เราจะสร้างโลโก้บริษัทของเราเองกัน 

ขั้นการสอน/การนำเสนอ (Presentation) 

การวาดเส้นตรง (Line) 
1. ครูเปิด SOLIDWORKS และสร้าง Sketch บน Front Plane 
2. ผู้เรียนเปิดโปรแกรมตามและสร้าง Sketch บน Front Plane พร้อมกัน 
3. ครูสาธิตการเลือกคำสั่ง Line จาก Sketch toolbar 
4. ผู้เรียนลองคลิกเลือก Line ตามครู 
5. ครูสาธิตการวาดเส้นตรง 2 แบบ 

- แบบที่ 1  คลิก จุดเริ่มต้น → ลากเมาส์ → คลิกจุดสิ้นสุด (ยังไม่กำหนดขนาด) 

- แบบที่ 2  คลิกจุดเริ่มต้น → ลากในแนวนอน → พิมพ์ตัวเลข 50 (ความยาว 50 mm) → 
Enter 

6. ผู้เรียนฝึกวาดเส้นตรง 3 เส้น 
- นอน 40 mm 
- ตั้ง 30 mm 
- และเส้นเฉียง 

7. ครูเดินสังเกตและให้คำแนะนำเมื่อผู้เรียนติดขัด 
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8. ครูสาธิตการใช้ Property Manager เพ่ือกำหนดความยาวและมุม (Horizontal, Vertical, Angle) 
9. ผู้เรียน 2-3 คนสาธิตการวาดเส้นพร้อมกำหนดความยาวหน้าชั้น 

การวาดสี่เหลี่ยม (Rectangle) 
1. ครูแนะนำเครื่องมือ Rectangle 3 แบบ 

- Corner Rectangle (วาดจากมุม)  คลิกมุมแรก → ลาก → คลิกมุมตรงข้าม 

- Center Rectangle (วาดจากก่ึงกลาง)  คลิกจุดก่ึงกลาง → ลากออก 
- 3 Point Corner Rectangle (วาดจาก 3 จุด)  คลิก 3 จุดเพื่อกำหนดด้านและความสูง 

2. ครูสาธิต Corner Rectangle ขนาด 50x50 mm บนหน้าจอ 
3. ผู้เรียนฝึกวาด Corner Rectangle 50x50 mm ตามครู 
4. ครูสาธิต Center Rectangle และอธิบายความแตกต่าง 
5. ผู้เรียนลองวาด Center Rectangle ขนาด 40x40 mm 
6. ครูถาม 

- ถ้าเราต้องการวาดสี่เหลี่ยมที่หมุน 45 องศา เราจะทำอย่างไร 
7. ผู้เรียนแสดงความคิดเห็น และครูสาธิตการใช้ Properties > Add Relations > Equal เพื่อให้เส้นทุก

ด้านเท่ากัน 
8. ครูสาธิตการหมุนสี่เหลี่ยม 

- เลือกสี่เหลี่ยม → Properties > Add Relations → Modify → ตั้งมุม 45° 

การวาดวงกลม (Circle) 
1. ครูสาธิตคำสั่ง Circle จาก Sketch toolbar 
2. ครูอธิบายว่า  

- วงกลมต้องการ 2 สิ่ง คือ จุดศูนย์กลางและรัศมี 
3. ครูสาธิตการวาดวงกลม โดย 

- คลิกท่ีจุด Origin (จุดศูนย์กลาง) 
- ลากออกมา 

- พิมพ์ 20 (รัศมี 20 mm) → Enter 
4. ผู้เรียนฝึกวาดวงกลม 3 ขนาด 

- รัศมี  15 mm 
- รัศม ี 20 mm 
- รัศม ี 30 mm 

5. ครูสาธิตการวาดวงกลมที่ตำแหน่งที่ต้องการ (ไม่ใช่ Origin) 
6. ครูสาธิตการใช้ Smart Dimension เพ่ือกำหนดเส้นผ่านศูนย์กลาง (Diameter) แทนรัศมี 
7. ผู้เรียนฝึกวาดวงกลม Ø40 mm (เส้นผ่านศูนย์กลาง 40 mm) 
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8. ครูสรุปความแตกต่างระหว่าง Radius (รัศมี) และ Diameter (เส้นผ่านศูนย์กลาง) 
 

ขั้นฝึกฝน/ลงมือปฏิบัติ (Practice) 
1. ครใูห้ผู้เรียนทำใบงานที่ 2.1 
2. ผู้เรียนรับฟังคำอธิบาย อ่านใบงานและทำความเข้าใจตัวอย่างชิ้นงานที่ต้องสร้าง 
3. ผู้เรียนทำงานเป็นรายบุคคล โดยปฏิบัติตามข้ันตอน 
4. ครูเดินดูการทำงานและให้คำแนะนำ 
5. ครูเดินสังเกตการทำงาน ให้คำแนะนำและแก้ปัญหาเมื่อผู้เรียนติดขัด 
6. ผู้เรียนที่ทำเสร็จก่อนช่วยเพื่อนที่ยังทำไม่เสร็จ 
7. ผู้เรียนบันทึกไฟล์งานโดยใช้ชื่อตามท่ีใบงานกำหนด 
 

ขั้นประยุกต์ใช ้(Production)  
กิจกรรม ออกแบบโลโก้บริษัทในฝัน 
1. ครูใหก้ติกา 

- ผู้เรียนทำงานเดี่ยว 
- ออกแบบโลโก้บริษัทในฝันของตนเอง 
- ต้องใช้เครื่องมือครบทั้ง 3 อย่าง ได้แก่ Line, Rectangle, Circle 
- ต้องมีรูปทรงอย่างน้อย 5 ชิ้น (เช่น สี่เหลี่ยม 2 ชิ้น + วงกลม 2 ชิ้น + เส้น 4 เส้น = 8 ชิ้น) 
- ใช้เวลา 15 นาที 
- Extrude เป็น 3D 
- บันทึกเป็น ตามท่ีครูกำหนด เช่น " ชื่อ-สกุล_โลโก้บริษัทในฝัน " 

2. ผู้เรียนทำกิจกรรมตามขั้นตอน ดังนี้ 
- ผู้เรียนสเก็ตช์ร่างบนกระดาษก่อน  
- สร้างใน SOLIDWORKS  
- ถ่ายภาพและส่งในช่องมางที่ครูกำหนด 

3. นำเสนอหน้าชั้น (อาสา 3-5 คน) โดยอธิบายว่า 
- โลโก้นี้เป็นบริษัทอะไร 
- ใช้เครื่องมืออะไรบ้างในการสร้าง 
- ความหมายของโลโก้ 

4. ในระหว่างทำกิจกรรมครูเดินสังเกตและให้กำลังใจ โดย เน้นความคิดสร้างสรรค์มากกว่าความสมบูรณ์ 
5. ผู้เรียนให้ feedback เชิงบวกกับเพื่อนๆ 
6. ครูถ่ายภาพผลงานดีๆ เพ่ือเก็บไว้เป็นตัวอย่าง 

ขั้นสรุป/ประเมินผล (Wrap up) 
1. ครูและผู้เรียนร่วมกันสรุปประเด็นสำคัญ 
2. ผู้เรียนฟังการสรุปและจดบันทึกสาระสำคัญ 
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3. ครูถามคำถามทบทวนความรู้  
4. ผู้เรียนตอบคำถามทบทวน 
5. ผู้เรียนสอบถามข้อสงสัยที่ยังไม่เข้าใจ 
6. ครูแจ้งหัวข้อที่จะเรียนครั้งต่อไป 
7. ผู้เรียนเตรียมความพร้อมสำหรับบทเรียนต่อไป 

กิจกรรมการเรียนรู้ (ครั้งท่ี 5/18, ชั่วโมงที่ 29–35/126) 

ขั้นนำเข้าสู่บทเรียน (Warm up) 
1. ครูฉายภาพ  กังหันลม, ใบพัด, วงล้อจักรยาน, ใบไม,้ คลื่นน้ำ, เปลวไฟ, ทางโค้ง 
2. ผู้เรียนแบ่งกลุ่ม 3-4 คน สังเกตลักษณะเส้นโค้งในภาพ 
3. ครูถาม 

- รูปทรงเหล่านี้มีอะไรเหมือนกัน  (คำตอบ  มีเส้นโค้ง, สมมาตร, หมุนซ้ำ) 
4. ครูถามต่อ 

- ถ้าเราจะวาดกังหันลม 3 ใบ ใน SOLIDWORKS เราจะเริ่มอย่างไร 
5. ผู้เรียนช่วยกันแสดงความคิดเห็น 
6. ครูนำเสนอตัวอย่างชิ้นงานที่สร้างด้วยเครื่องมือระดับสูง 

- ใบพัดพลาสติก (ใช้ Spline, Polygon) 
- โค้งรถยนต์ (ใช้ Ellipse, Parabola, Conic) 
- ตัวโครงรถจักรยาน (ใช้ 3 Point Arc) 

7. ครูหมุนชิ้นงานและให้ผู้เรียนสังเกต และถาม 
- เส้นโค้งแบบนี้ต่างจากวงกลมธรรมดายังไง 

8. ผู้เรียนแชร์ความคิด 
- เส้นโค้งซับซ้อนกว่า, ไม่กลม, มีทิศทางไหล 

9. ครูสรุป วันนี้เราจะเรียนรู้เครื่องมือ 9 อย่างท่ีจะทำให้เราสร้างเส้นโค้งสวยๆ ได้ 
 

ขั้นการสอน/การนำเสนอ (Presentation) 
2.4  เครื่องมือสร้างรูปทรงหลายเหลี่ยมและเส้นโค้งจากวงกลม 

2.4.1  Polygon (รูปหลายเหลี่ยม) 
1. ครูเปิด SOLIDWORKS > New Part > Front Plane > Sketch 
2. ผู้เรียนทำตามพร้อมกัน 
3. ครูแนะนำคำสั่ง Polygon จาก Sketch toolbar 
4. ครูสาธิตการสร้างหกเหลี่ยม 

- คลิก Polygon 
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- ตั้งค่า Number of Sides = 6 
- เลือก Inscribed circle (วงกลมอยู่ในรูปหลายเหลี่ยม) 
- คลิกจุดศูนย์กลาง (Origin) 
- ลากออกมา พิมพ์ 20 (รัศมีวงกลมล้อม) > Enter 

5. ผู้เรียนฝึกสร้างหกเหลี่ยมตาม 
6. ครูสาธิตแบบ Circumscribed circle (รูปหลายเหลี่ยมอยู่ในวงกลม) 
7. ผู้เรียนสังเกตความแตกต่าง 
8. ครูใหผู้้เรียนลองสร้างรูป 8 เหลี่ยม, 10 เหลี่ยม 
9. ผู้เรียน 2 คนสาธิตหน้าชั้น 

2.4.2  CenterPoint Arc (เส้นโค้งจากจุดศูนย์กลาง) 
1. ครูสาธิตคำสั่ง CenterPoint Arc 
2. ครูอธิบาย 

- เหมือนวาดส่วนหนึ่งของวงกลม แต่กำหนดจุดเริ่ม-จุดจบได้ 
3. ครูสาธิตการวาด 

- คลิก CenterPoint Arc 
- คลิกจุดศูนย์กลาง 
- คลิกจุดเริ่มต้นของส่วนโค้ง 
- ลากไปยังจุดสิ้นสุด 

4. ผู้เรียนลองวาดส่วนโค้ง 90°, 180°, 270° 
5. ครูสาธิตการใช้ Smart Dimension กำหนดรัศมีและมุม 
6. ผู้เรียนฝึกวาดส่วนโค้งท่ีมีรัศมี 30 mm มุม 120° 

2.4.3  เครื่องมือสร้างเส้นโค้งข้ันสูง 
Tangent Arc และ 3 Point Arc 

1. ครูสาธิต Tangent Arc (เส้นโค้งต่อจากเส้นร่าง) 
- วาด Line ยาว 40 mm แนวนอน 
- คลิก Tangent Arc 
- คลิกท่ีจุดสิ้นสุดของเส้น (จะต่อเนื่องอัตโนมัติ) 
- ลากเป็นส่วนโค้ง คลิกจุดสิ้นสุด 

2. ผู้เรียนฝึกวาดเส้นตรงและต่อด้วย Tangent Arc 
3. ครูสาธิต 3 Point Arc (กำหนดจุดเริ่ม-กลาง-จบ) 

- คลิก 3 Point Arc 
- คลิกจุดเริ่มต้น 
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- คลิกจุดที่อยู่ระหว่างทาง (ควบคุมความโค้ง) 
- คลิกจุดสิ้นสุด 

4. ผู้เรียนลองสร้างส่วนโค้งท่ีผ่าน 3 จุดที่กำหนด 
5. ครูอธิบายความแตกต่าง 

- CenterPoint ใช้จุดศูนย์กลาง, 3 Point ใช้ 3 จุดบนเส้นโค้ง 
Ellipse (วงรี) 

1. ครูสาธิต Ellipse 
- คลิก Ellipse 
- คลิกจุดศูนย์กลาง (Origin) 
- ลากตามแนวนอน (แกน Major) พิมพ์ 40 > Enter 
- ลากตามแนวตั้ง (แกน Minor) พิมพ์ 20 > Enter 

2. ผู้เรียนลองสร้างวงรี 80x40 mm 
3. ครูสาธิต Partial Ellipse (ส่วนหนึ่งของวงรี) 

- คลิก Ellipse (เลือก Partial Ellipse ใน Property Manager) 
- กำหนดจุดศูนย์กลางและแกนเหมือนเดิม 
- กำหนดจุดเริ่มต้นและจุดสิ้นสุดบนวงรี 

4. ผู้เรียนฝึกสร้างส่วนโค้งวงรี 
2.4.7 เครื่องมือสร้างเส้นโค้งพิเศษ 
Parabola (พาราโบลา) 

1. ครูอธิบาย 
- พาราโบลาคือเส้นโค้งท่ีเห็นในจานดาวเทียม, สะพาน, ทางน้ำตก 

2. ครูสาธิต Parabola 
- คลิก Ellipse > เลือก Parabola 
- คลิกจุดยอด (Apex) ของพาราโบลา 
- กำหนดทิศทางแกน 
- คลิกจุดโฟกัส (Focus) หรือกำหนดความลึก 

3. ผู้เรียนลองสร้างพาราโบลาความลึก 10 mm ความกว้าง 30 mm 
4. ครูยกตัวอย่างการใช้งานจริง ได้แก่ ไฟส่องสว่าง, เสาอากาศ 

Conic (กรวย) และ Spline 
1. ครูสาธิต Conic 

- คลิก Ellipse > เลือก Conic 
- คลิกจุดเริ่มต้นและจุดสิ้นสุด 
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- กำหนด Rho (ค่าความโค้ง 0-1) 
Rho < 0.5 = แบน 
Rho = 0.5 = พาราโบลา 
Rho > 0.5 = โค้งมาก 

2. ผู้เรียนลองปรับค่า Rho และสังเกตความเปลี่ยนแปลง 
3. ครูสาธิต Spline (เส้นโค้งต่อเนื่อง) 

- คลิก Spline 
- คลิกจุดต่างๆ อย่างน้อย 3 จุด (เส้นจะลื่นไหลผ่านทุกจุด) 
- กด ESC เพ่ือเสร็จสิ้น 
- ลากจุดควบคุม (Handle) เพ่ือปรับความโค้ง 

4. ผู้เรียนลองสร้าง Spline ที่ผ่าน 5 จุด 
5. ครูเปรียบเทียบ Spline ยืดหยุ่น แต ่Arc แข็งตัว 

 

ขั้นฝึกฝน/ลงมือปฏิบัติ (Practice) 
1. ครใูห้ผู้เรียนทำใบงานที่ 2.2 
2. ผู้เรียนรับฟังคำอธิบาย อ่านใบงานและทำความเข้าใจตัวอย่างชิ้นงานที่ต้องสร้าง 
3. ผู้เรียนทำงานเป็นรายบุคคล โดยปฏิบัติตามข้ันตอน 
4. ครูเดินดูการทำงานและให้คำแนะนำ 
5. ครูเดินสังเกตการทำงาน ให้คำแนะนำและแก้ปัญหาเมื่อผู้เรียนติดขัด 
6. ผู้เรียนที่ทำเสร็จก่อนช่วยเพื่อนที่ยังทำไม่เสร็จ 
7. ผู้เรียนบันทึกไฟล์งานโดยใช้ชื่อตามท่ีใบงานกำหนด 
 

ขั้นประยุกต์ใช ้(Production)  
กิจกรรม ออกแบบโลโก้บริษัทยานยนต์แห่งอนาคต 
1. ครูกำหนดกติกา คือ 

- ผู้เรียนทำงานเดี่ยว 
- ออกแบบโลโก้บริษัทรถยนต์/รถจักรยานยนต์ของตนเอง 
- ต้องใช้เครื่องมือระดับสูงอย่างน้อย 3 อย่าง จาก Polygon, Arc, Ellipse, Parabola, Conic, 

Spline 
- โลโก้ต้องสื่อถึง  ความเร็ว, ความทันสมัย, หรือความหรูหรา 
- ใช้เวลา 15 นาที 
- Extrude เป็น 3D 
- บันทึกไฟล์โดยใช้ชื่อที่ครูกำหนด เช่น "ชื่อ-สกุล_โลโก้ยานยนต์" 

2. ผู้เรียนทำกิจกรรมตามขั้นตอน ดังนี้ 
- ผู้เรียนสเก็ตช์ร่างบนกระดาษ  
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- เลือกเครื่องมือที่จะใช้และวางแผน 
- สร้างใน SOLIDWORKS  
- Extrude และใส่สี/วัสดุ  

3. ผู้เรียนนำเสนอหน้าชั้น (อาสา 5 คน) โดยอธิบาย ดังนี้ 
- โลโก้นี้เป็นบริษัทอะไร ทำอะไร 
- ใช้เครื่องมืออะไรบ้าง 
- เลือกใช้เครื่องมือนั้นเพราะอะไร 
- ความหมายของรูปทรง/สี 

4. ครูใหต้ัวอย่างแนวคิด 
- ใช้ Polygon 6 เหลี่ยม + Ellipse = สื่อถึงความแข็งแกร่งและความเร็ว 
- ใช้ Parabola + Spline = สื่อถึงความลื่นไหลและอากาศพลศาสตร์ 
- ใช้ 3 Point Arc + Conic = สื่อถึงความโค้งมนและหรูหรา 

5. ครูเดินให้กำลังใจและให้คำแนะนำสั้นๆ เน้นความคิดสร้างสรรค์และการกล้าทดลอง 
6. ผู้เรียนให้ feedback กัน "สิ่งที่ชอบ" และ "คำแนะนำ" 
7. ครูถ่ายภาพผลงานทั้งหมดเพื่อจัดแสดง 

 

ขั้นสรุป/ประเมินผล (Wrap up) 
1. ครูให้ผู้เรียนทำแบบฝึกหัดหลังเรียน หน่วยที่ 2  
2. ผู้เรียนทำแบบฝึกหัดหลังเรียน หน่วยที่ 2 ตามที่ครูมอบหมาย 
3. ครแูละผู้เรียนร่วมสรุปเนื้อหาและประเด็นสำคัญ 
4. ผู้เรียนตั้งคำถามและข้อสงสัย  
5. ครแูจ้งหัวข้อที่จะเรียนครั้งต่อไป 
6. ผู้เรียนเตรียมความพร้อมสำหรับบทเรียนต่อไป 

 
สื่อและแหล่งการเรียนรู้ 

ส่ือสิ่งพิมพ์ 
หนังสือเรียนวิชา งานเขียนแบบเครื่องกลด้วยคอมพิวเตอร์ (Computer-Aided Mechanical Drafting 

Job) รหัสวิชา 20101-2029 หน่วยการเรียนรู้ที่ 2 เรื่อง การใช้เครื่องมือวาดเส้นร่างพื้นฐาน และระดับสูง ของ
บริษัท สำนักพิมพ์เอมพันธ์ จำกัด 

สื่อโสตทัศน์ 
สไลด์ Power Point หน่วยการเรียนรู้ที่ 2 การใช้เครื่องมือวาดเส้นร่างพ้ืนฐาน และระดับสูง 

ส่ือออนไลน์ 
  - 
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ส่ือจำลองหรือของจริง 
 - 

 อื่น ๆ  
  - 

หลักฐานการเรียนรู้ 
หลักฐานความรู้ 
1. ผลการทำแบบฝึกหัดหลังเรียน หน่วยที่ 2  
2. ผลการตอบคำถามทบทวนความรู้ 
3. ผลการตรวจแบบทดสอบหลังเรียน หน่วยที่ 2 

 หลักฐานการปฏิบัติงาน 
1. ผลการปฏิบัติงานตามใบงานเพ่ิมเติมที่ 1 
2. ผลการปฏิบัติงานตามใบงานที่ 2.1 
3. ผลการปฏิบัติงานตามใบงานที่ 2.2 
4. ผลการทำ Mini Challenge  ออกแบบโลโก้ 3D 
5. ผลของการออกแบบโลโก้บริษัทในฝัน 
6. ผลของการออกแบบโลโก้บริษัทยานยนต์แห่งอนาคต 

 หลักฐานคุณลักษณะอันพึงประสงค์ 
1. ผลการประเมินตามแบบประเมินคุณธรรม จริยธรรม ตามสภาพจริง 

การวัดและประเมินผล 
เครื่องมือวัด วิธีวัด การประเมินตามเกณฑ ์

1. ใบงานเพ่ิมเติมที่ 1 ปฏิบัติ-ตรวจแบบฝึกหัด เกณฑ์ผ่าน 50% 

2. ใบงานที่ 2.1 ปฏิบัติ-ตรวจแบบฝึกหัด เกณฑ์ผ่าน 50% 

3. ใบงานที่ 2.2 ปฏิบัติ-ตรวจแบบฝึกหัด เกณฑ์ผ่าน 50% 

4. แบบฝึกหัดหลังเรียน หน่วยที่ 2 ตรวจแบบฝึกหัด เกณฑ์ผ่าน 50% 

5. แบบทดสอบหลังเรียน หน่วยที่ 2 ทดสอบ-ตรวจแบบทดสอบ เกณฑ์ผ่าน 50% 

6. แบบประเมินคุณธรรม จริยธรรม ตามสภาพจริง สังเกต/ผู้เรียนประเมินตนเอง เกณฑ์ผ่าน 70% 
 

งานที่มอบหมาย 
1. งานที่มอบหมายนอกเหนือเวลาเรียน ให้ทำแบบฝึกหัดที่ทำไม่แล้วเสร็จในห้องเรียนให้เรียบร้อย 
2. ทำ Mini Challenge ออกแบบโลโก้ 3D 
3. ออกแบบโลโก้บริษัทในฝัน 
4. ออกแบบโลโก้บริษัทยานยนต์แห่งอนาคต 
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5. สืบค้นข้อมูลเพิ่มเติมเก่ียวกับเนื้อหาที่จะเรียนในครั้งถัดไป 
 

เอกสารอ้างอิง 

 ผศ.กีรดิษ สายพัทลุง. (2567). งานเขียนแบบเครื่องกลด้วยคอมพิวเตอร์ (Computer-Aided Mechanical 
Drafting Job). เอมพันธ์. 
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บันทึกผลหลังการจัดการเรียนรู้ (ครั้งที่ 3/18, ชั่วโมงท่ี 15-21/126) 
1. ผลการจัดการเรียนรู้ที่เกิดขึ้นกับผู้เรียน 

               
               
               

2. ปัญหา อุปสรรคที่พบ 
               
               
               

3. การแก้ไขปัญหา 
3.1) ผลการแก้ไขปัญหาที่ส่งผลลัพธ์ที่ดีต่อผู้เรียน 

               
               

3.2) แนวทางแก้ปัญหาในครั้งต่อไป 
               
               

 
 

ลงชื่อ 
                        (.........................................)

                    ครูผู้สอน   
     ………./…………/………… 
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บันทึกผลหลังการจัดการเรียนรู้ (ครั้งที่ 4/18, ชั่วโมงท่ี 22-28/126) 
1. ผลการจัดการเรียนรู้ที่เกิดขึ้นกับผู้เรียน 

               
               
               

2. ปัญหา อุปสรรคที่พบ 
               
               
               

3. การแก้ไขปัญหา 
3.1) ผลการแก้ไขปัญหาที่ส่งผลลัพธ์ที่ดีต่อผู้เรียน 

               
               

3.2) แนวทางแก้ปัญหาในครั้งต่อไป 
               
               

 
 

ลงชื่อ 
                        (.........................................)

                    ครูผู้สอน   
                    ………./…………/………… 
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บันทึกผลหลังการจัดการเรียนรู้ (ครั้งที่ 5/18, ชั่วโมงท่ี 29–35/126) 
1. ผลการจัดการเรียนรู้ที่เกิดขึ้นกับผู้เรียน 

               
               
               

2. ปัญหา อุปสรรคที่พบ 
               
               
               

3. การแก้ไขปัญหา 
3.1) ผลการแก้ไขปัญหาที่ส่งผลลัพธ์ที่ดีต่อผู้เรียน 

               
               

3.2) แนวทางแก้ปัญหาในครั้งต่อไป 
               
               

 
 

ลงชื่อ 
                        (.........................................)

                    ครูผู้สอน   
     ………./…………/………… 
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แผนการจัดการเรียนรู้ที่ 3  หน่วยที่    3     . 
รหัสวิชา 20101 – 2029  ชื ่อวิชา งานเขียนแบบเครื ่องกลด้วย
คอมพิวเตอร์ (Computer-Aided Mechanical Drafting Job) 

สอนครั้งที ่ 6 - 8  .  

ชื่อหน่วยการเรียนรู้   การเขียนเส้นร่างด้วยฟังก์ชันหลัก และฟังก์ชัน
เสริมในโปรแกรม SOLIDWORKS    

ทฤษฎี     3    ชม.  
ปฏิบัติ    18    ชม. 

ชื่อเรื่อง  การเขียนเส้นร่างด้วยฟังก์ชันหลัก และฟังก์ชันเสริมในโปรแกรม SOLIDWORKS    

สาระสำคัญ 
 โปรแกรม SOLIDWORKS มีฟังก์ชันสำคัญในการจัดการเส้นร่างที ่หลากหลาย โดยฟังก์ชันพื ้นฐาน
ประกอบด้วยการปร ับแต ่งล ักษณะเส ้น (Line Format), การใช ้ เส ้นอ ้างอ ิงจ ุดก ึ ่ งกลาง (Center Line)               
การสร้างเส้นร่างคู่ (Offset Entities) ส่วนฟังก์ชันขั้นสูงรวมถึงการคัดลอกแบบภาพสะท้อน (Mirror), การตัดเส้น
ส่วนเกินส่วนเกิน (Trim) และฟังก์ชันเสริมต่าง ๆ เช่น การยืดเส้น (Extend), การย้ายตำแหน่ง (Move),          
การคัดลอก (Copy), การหมุน (Rotate), การปรับขนาด (Scale), และการสร้างแพตเทิร์น (Pattern) ซึ่งฟังก์ชัน
เหล่านี้ช่วยเพิ่มประสิทธิภาพในการออกแบบและลดระยะเวลาในการทำงาน 
 

ผลลัพธ์การเรียนรู้ระดับหน่วยการเรียน 
ผู้เรียนสามารถใช้งานโปรแกรม SOLIDWORKS เบื้องต้นได้ มีความเข้าใจส่วนประกอบต่าง ๆ ของโปรแกรม 

สามารถสร้างหนังสือออกแบบชิ้นงาน ปรับแต่งการตั้งค่าพื้นฐาน และใช้งานมุมมองชิ้นงานในรูปแบบต่าง ๆ ได้
อย่างเหมาะสม 

 

อ้างอิงมาตรฐาน/เชื่อมโยงกลุ่มอาชีพ 
 - 

สมรรถนะประจำหน่วย 
7. แสดงความรู้เกี่ยวกับฟังก์ชันหลักและฟังก์ชันเสริมในการเขียนเส้นร่างในโปรแกรม SOLIDWORKS 
8. มีทักษะการใช้ฟังก์ชันในการปรับแต่ง จัดการและแก้ไขเส้นร่างในโปรแกรม SOLIDWORKS 
9. ประยุกต์ใช้ฟังก์ชันหลักและฟังก์ชันเสริมในการสร้างเส้นร่างที่มีความซับซ้อนเพื่อการออกแบบชิ้นงาน 

จุดประสงค์เชิงพฤติกรรม   
ด้านความรู้ (Knowledge) 
3. อธิบายเกี่ยวกับหลักการทำงานของฟังก์ชันหลักและฟังก์ชันเสริมในการเขียนเส้นร่างเพื่อให้เข้าใจการ

นำไปใช้งานได้อย่างถูกต้องได้ 
ด้านทักษะ/กระบวนการ  (Process) 
5. ใช้ฟังก์ชันหลักในการปรับแต่งลักษณะและรูปแบบของเส้นร่างเพื่อสร้างเส้นร่างพื้นฐานที่ถูกต้องตาม

หลักการเขียนแบบได้ 
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6. ใช้ฟังก์ชันการจัดการเส้นร่างเพื่อปรับปรุงประสิทธิภาพในกระบวนการออกแบบและลดเวลาในการ
ทำงานได้ 

 

คุณลักษณะท่ีพึงประสงค์ (Attitude)   
3. มีเจตคติและกิจนิสัยที่ดีในการปฏิบัติงานด้วยความละเอียด รอบคอบ  
ด้านการประยุกต์ใช้ (Apply)  
1. ประยุกต์ใช้ฟังก์ชันเสริมเพื่อปรับแต่ง แก้ไข และสร้างรูปแบบซ้ำของเส้นร่างในการออกแบบชิ้นงานที่มี

ความซับซ้อนได ้
 

สาระการเรียนรู้ 
 3.1 การใช้ฟังก์ชัน Line Format  

3.2 การใช้ฟังก์ชัน Line Color 
3.3 การใช้ฟังก์ชัน Centerline 
3.4 การใช้ฟังก์ชัน Offset Entities 
3.5 การใช้ฟังก์ชัน Mirror Entities 
3.6 การใช้ฟังก์ชัน Trim Entities 
3.7 การใช้งานฟังก์ชันเสริมในโปรแกรม SOLIDWORKS 
 3.7.1 การใช้ฟังก์ชัน Extend 

3.7.2 การใช้ฟังก์ชัน Move Entities 
3.7.3 การใช้ฟังก์ชัน Copy Entities 
3.7.4 การใช้ฟังก์ชัน Move with Angle 
3.7.5 การใช้ฟังก์ชัน Scale 
3.7.6 การใช้ฟังก์ชัน Stretch 
3.7.7 การใช้ฟังก์ชัน Linear Pattern 
3.7.8 การใช้ฟังก์ชัน Circular Pattern 

กิจกรรมการเรียนรู้ (ครั้งท่ี 6/18, ชั่วโมงที่ 36-42/126) 
ขั้นนำเข้าสู่บทเรียน (Warm up) 
18. ครูเปิดโปรแกรม SOLIDWORKS แสดงบนจอโปรเจคเตอร์ พร้อมถามผู้เรียนว่า 

- ในการเขียนแบบบนกระดาษ เราใช้อุปกรณ์อะไรบ้างในการสร้างเส้นที่มีความหนาต่างกัน 
19. ผู้เรียนช่วยกันตอบ (ดินสอ HB, 2B, ปากกาหัวตัด, ปากกาสีต่างๆ) 
20. ครูถามต่อ  

- ในโปรแกรม SOLIDWORKS เราสามารถควบคุมรูปแบบของเส้นได้อย่างไร 
21. ผู้เรียนร่วมแสดงความคิดเห็นจากประสบการณ์ที่ผ่านมา 
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22. ครูสรุปเชื่อมโยง 
- วันนี้เราจะเรียนรู้การควบคุมเส้นให้มีรูปแบบ สี และชนิดที่แตกต่างกัน เพื่อให้แบบที่เรา

เขียนมีความชัดเจนและเป็นมาตรฐาน 
23. ครูแสดงตัวอย่างแบบเขียนแบบ 2 แบบบนหน้าจอ 

- แบบที่ 1  ใช้เส้นแบบเดียวกันทั้งหมด (เส้นทึบ ขนาดเท่ากัน สีดำทั้งหมด) 
- แบบที่ 2  ใช้เส้นหลากหลายรูปแบบ (เส้นทึบ เส้นประ Center Line มีสีแยกประเภท) 

24. ผู้เรียนสังเกตและเปรียบเทียบความแตกต่าง 
25. ครูถาม 

- แบบใดอ่านง่ายกว่ากัน เพราะเหตุใด 
26. ผู้เรียนร่วมอภิปราย พบว่าการใช้เส้นที่หลากหลายช่วยให้เข้าใจแบบได้ง่ายขึ้น 
27. ครูเปิดเผยวัตถุประสงค์การเรียนรู้วันนี้ 

ขั้นการสอน/การนำเสนอ (Presentation) 
1. ผู้เรียนเปิดโปรแกรม SOLIDWORKS บนเครื่องคอมพิวเตอร์ของตนเอง 
2. ครูใหผู้้เรียนเข้าสู่โหมด Sketch บน Front Plane 
3. ผู้เรียนปฏิบัติตาม 

- คลิกเครื่องมือ Line และวาดเส้นตรง 1 เส้น 
4. ครูแนะนำให้ผู้เรียนสำรวจ 

- ลองคลิกขวาที่เส้นที่วาด แล้วดูว่ามีตัวเลือกอะไรบ้าง 
- ลองหาคำว่า 'Line Format' หรือ 'Line Color'  

5. ผู้เรียนสำรวจด้วยตนเองและแจ้งผลที่พบ 
6. ครูและผู้เรียนร่วมกันสรุปตำแหน่งเมนู Line Format, Line Color 
7. ครูแบ่งผู้เรียนเป็น 3 กลุ่ม 

- กลุ่มท่ี 1  ผู้เชี่ยวชาญ Line Format (รูปแบบเส้น: ทึบ, ประ, จุดประ) 
- กลุ่มท่ี 2  ผู้เชี่ยวชาญ Line Color (สีของเส้น และความหนาเส้น) 
- กลุ่มท่ี 3  ผู้เชี่ยวชาญ Centerline (เส้นศูนย์กลาง) 

8. ผู้เรียนแต่ละกลุ่มศึกษาหัวข้อของตนจากหนังสือ หัวข้อที่ 1-3 
- ทดลองใช้งานฟังก์ชันจริงบนโปรแกรม 
- สรุปวิธีการใช้งานและข้อควรระวัง 

9. หลังจากศึกษา 20 นาที แต่ละกลุ่มส่งตัวแทน 1 คน มานำเสนอหน้าชั้นเรียน 
10. ผู้เรียนทุกคนจดบันทึกข้อมูลจากการนำเสนอของแต่ละกลุ่ม 
11. ครูสาธิตการใช้งานทั้ง 3 ฟังก์ชันแบบบูรณาการ 

- วาดเส้นทึบ (Solid Line) สีดำ ความหนา 0.5 mm 
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- วาดเส้นประ (Dashed Line) สีแดง ความหนา 0.3 mm 
- วาดเส้นศูนย์กลาง (Centerline) สีน้ำเงิน 

12. ผู้เรียนสังเกตและถามคำถามเพ่ือความเข้าใจ 
13. ครูอธิบายมาตรฐานการเขียนแบบ 

- เส้นทึบหนา  แสดงขอบเขตชิ้นงานที่มองเห็น 
- เส้นประ  แสดงขอบเขตที่มองไม่เห็น (Hidden Line) 
- Centerline  แสดงแกนสมมาตรของวัตถุ 

14. ผู้เรียนจดบันทึกมาตรฐานการใช้เส้นในแบบเครื่องกล 
 

ขั้นฝึกฝน/ลงมือปฏิบัติ (Practice) 
1. ครใูห้ผู้เรียนทำใบงานเพ่ิมเติมที่ 2 
2. ผู้เรียนรับฟังคำอธิบาย อ่านใบงานและทำความเข้าใจใบงานที่ต้องทำ 
3. ผู้เรียนทำงานเป็นรายบุคคล โดยปฏิบัติตามข้ันตอน 
4. ครูเดินดูการทำงานและให้คำแนะนำ 
5. ครูเดินสังเกตการทำงาน ให้คำแนะนำและแก้ปัญหาเมื่อผู้เรียนติดขัด 
6. ผู้เรียนที่ทำเสร็จก่อนช่วยเพื่อนที่ยังทำไม่เสร็จ 
7. ผู้เรียนบันทึกไฟล์งานโดยใช้ชื่อตามท่ีใบงานกำหนด 
 

ขั้นประยุกต์ใช ้(Production)  
กิจกรรม Mini Challenge  ออกแบบโลโก้บริษัทของฉัน 
1. ครูมอบหมาย Challenge ให้ผู ้เรียนออกแบบโลโก้บริษัทจำลอง โดยใช้เส้นตรงเท่านั ้น และต้อง

ประยุกต์ใช้ทั้ง 3 ฟังก์ชันที่เรียน โดยมีเงื่อนไข ดังนี้ 
- ใช้เฉพาะเส้นตรง (Line) เท่านั้น อย่างน้อย 8 เส้น 
- ต้องมี Line Format อย่างน้อย 2 แบบ (เช่น ทึบ + ประ) 
- ต้องมี Line Color อย่างน้อย 3 สี 
- ต้องมี Centerline แสดงแกนสมมาตร 
- ออกแบบให้มีความสมดุลและสวยงาม 

2. ครูระบุขั้นตอนกิจกรรม ดังนี้ 
- ผู้เรียนร่างแบบบนกระดาษก่อน  
- สร้างบน SOLIDWORKS  
- บันทึกไฟล์ตามชื่อท่ีครูกำหนด เช่น "LogoProject_ชื่อ-นามสกุล" 

3. ครูเดินสังเกตการทำงานกลุ่ม คอยให้คำแนะนำ 
4. ผู้เรียนทุกคนบันทึกภาพหน้าจอผลงานของตน 
5. ครูใหผู้้เรียนเดินชมผลงานของเพ่ือนๆ บนจอคอมพิวเตอร์  
6. ผู้เรียนแต่ละคนเลือกผลงาน 3 ชิ้นที่ชอบที่สุด และเขียนจุดเด่นลงใน Post it เช่น 
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- ใช้ Line Format หลากหลายและเหมาะสม 
- เลือก Line Color สวยงามและเห็นชัดเจน 
- ใช้ Centerline ถูกต้องตามหลักการ 
- ความคิดสร้างสรรค์ 

7. ครูเลือกผลงานที่ได้คะแนนโหวตสูงสุด 3 อันดับแรก ให้เจ้าของผลงานอธิบายกระบวนการออกแบบ  
 

ขั้นสรุป/ประเมินผล (Wrap up) 
1. ครูและผู้เรียนร่วมกันสรุปประเด็นสำคัญ 
2. ผู้เรียนฟังการสรุปและจดบันทึกสาระสำคัญ 
3. ครูถามคำถามทบทวนความรู้  
4. ผู้เรียนตอบคำถามทบทวน 
5. ผู้เรียนสอบถามข้อสงสัยที่ยังไม่เข้าใจ 
6. ครูแจ้งหัวข้อที่จะเรียนครั้งต่อไป 
7. ผู้เรียนเตรียมความพร้อมสำหรับบทเรียนต่อไป 
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ใบงานเพิ่มเติมที ่2 หน่วยที่    3    .   
รหัสวิชา 20101 – 2029  ชื ่อวิชา งานเขียนแบบเครื ่องกลด้วย
คอมพิวเตอร์ (Computer-Aided Mechanical Drafting Job) 

สอนครั้งที ่6 - 8  .       

ชื่อหน่วยการเรียนรู้   การเขียนเส้นร่างด้วยฟังก์ชันหลัก และฟังก์ชัน
เสริมในโปรแกรม SOLIDWORKS    

ทฤษฎี     3    ชม.  
ปฏิบัติ    18   ชม. 

ชื่อเรื่อง  การเขียนเส้นร่างด้วยฟังก์ชันหลัก และฟังก์ชันเสริมในโปรแกรม SOLIDWORKS    
 

1.  ผลลัพธ์การเรียนรู้จากการปฏิบัติงาน 
 ผู้เรียนจะสามารถควบคุมคุณสมบัติของเส้นในโปรแกรม SOLIDWORKS ได้อย่างมีประสิทธิภาพ          โดย
เข้าใจการใช้ฟังก์ชัน Line Format ในการปรับเปลี่ยนรูปแบบเส้นให้เป็นไปตามมาตรฐานการเขียนแบบเครื่องกล 
ทั้งเส้นทึบ (Solid) สำหรับแสดงขอบชิ้นงานที่มองเห็น เส้นประ (Dashed) สำหรับขอบที่ถูกบัง และเส้นจุดประ 
(Phantom) สำหรับเส้นก่อสร้าง นอกจากนี้ยังสามารถประยุกต์ใช้ฟังก์ชัน Line Color ในการกำหนดสีและความ
หนาของเส้นเพ่ือแยกประเภทองค์ประกอบต่างๆ ในแบบให้ชัดเจน ตลอดจนเข้าใจหลักการใช้ Centerline ในการ
แสดงแกนสมมาตรของชิ้นงาน ซึ่งเป็นพ้ืนฐานสำคัญในการสื่อสารทางวิศวกรรมและการผลิตชิ้นงานจริง ผู้เรียนจะ
ได้พัฒนาทักษะการคิดวิเคราะห์ในการเลือกใช้เครื่องมือที่เหมาะสมกับลักษณะของแบบที่ต้องการนำเสนอ รวมถึง
การตรวจสอบความถูกต้องของงานด้วยตนเองตามมาตรฐานสากล 
 

2.  อ้างอิงมาตรฐาน/เชื่อมโยงกลุ่มอาชีพ 
 - 

 

3. สมรรถนะการปฏิบัติงาน 
3.1  ทักษะการใช้โปรแกรม CAD (SOLIDWORKS) ในการควบคุมคุณสมบัติของเส้น 
3.2  ความเข้าใจมาตรฐานการเขียนแบบเครื่องกล 
3.3  ความสามารถในการแก้ปัญหาเมื่อพบข้อผิดพลาดในการปฏิบัติงาน 
 

4.  จุดประสงค์เชิงพฤติกรรม  
ด้านความรู้ (Knowledge) 
1. อธิบายเกี่ยวกับส่วนประกอบในหน้าต่างของโปรแกรมและประเภทหนังสือสำหรับออกแบบชิ้นงานใน 

SOLIDWORKS เพ่ือใช้งานได้อย่างถูกต้องได้ 

ด้านทักษะ/กระบวนการ  (Process) 
1. ใช้คำสั่งในการสร้าง เปิด และบันทึกไฟล์ในโปรแกรม SOLIDWORKS เพื่อจัดการไฟล์งานได้อย่างเป็น

ระบบได้ 
2. ใช้มุมมองและระนาบของชิ ้นงานในรูปแบบต่าง ๆ เพื ่อแสดงผลและทำงานกับชิ ้นงานได้อย่างมี

ประสิทธิภาพได้ 
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คุณลักษณะท่ีพึงประสงค์ (Attitude)   
1. มีเจตคติและกิจนิสัยที่ดีในการปฏิบัติงานด้วยความละเอียด รอบคอบ  
2. มีระเบียบในการจัดการไฟล์งานเพื่อให้การออกแบบชิ้นงานมีความถูกต้องและเป็นระบบ 

ด้านการประยุกต์ใช้ (Apply)  
ประยุกต์ใช้การตั้งค่าพ้ืนฐานของโปรแกรม เช่น การเปลี่ยนฉากหลังและการกำหนดหน่วยวัด เพื่อให้

เหมาะสมกับลักษณะงานที่ออกแบบได้ 
  

5.  เครื่องมือ วัสดุ และอุปกรณ์ 
5.1  เครื่องคอมพิวเตอร์ที่มีคุณสมบัติเพียงพอสำหรับโปรแกรม SOLIDWORKS (1 เครื่อง/คน) 
5.2  เมาส์คอมพิวเตอร์ที่ใช้งานได้ดี 
5.3  แป้นพิมพ์ (Keyboard) 
5.4  โปรแกรม SOLIDWORKS  

 

6.  คำแนะนำ/ข้อควรระวัง  
6.1  บันทึกงานบ่อยๆ กด Ctrl+S ทุกๆ 5-10 นาที เพื่อป้องกันข้อมูลสูญหาย 
6.2  ตรวจสอบ Plane ก่อนเริ่ม Sketch ให้แน่ใจว่าเลือก Plane ที่ถูกต้อง (Front, Top, หรือ Right) 
6.3  การเลือกเส้น คลิกเส้นที่ต้องการแก้ไขให้แม่นยำ หากเลือกผิดให้กด Esc และเลือกใหม่ 
6.4  ชนิดของเส้น 

- Solid (เส้นทึบ) = ขอบชิ้นงานที่มองเห็นได้ 
- Dashed (เส้นประ) = ขอบชิ้นงานที่ถูกบัง/มองไม่เห็น 
- Centerline (เส้นศูนย์กลาง) = แกนสมมาตรของชิ้นงาน 

6.5  ความหนาเส้น  เส้นหลัก (Outlines) ควรหนากว่าเส้นรอง (Construction Lines, Centerlines) 
6.6  ตรวจสอบว่าทุก Sketch ได้รับการบันทึกแล้ว 
6.7  ตรวจสอบความถูกต้องของสี รูปแบบ และความหนาของเส้น 
6.8  ตรวจสอบว่าไฟล์เปิดได้ปกติก่อนส่งงาน 

 

7.  ขั้นตอนการปฏิบัติงาน 
3.1  การใช้งาน Line Format  
งานที่ 1.1  สร้างเส้นแสดงประเภทต่างๆ 

ขั้นตอน 
1. เปิดโปรแกรมและสร้างไฟล์ใหม่  

- เปิดโปรแกรม SOLIDWORKS 
- ไปที่ File > New > Part > OK 
- บันทึกไฟล์ทันที File > Save As > ตั้งชื่อ "LineFormat_ชื่อ-นามสกุล" 
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2. เข้าสู่โหมด Sketch  
- คลิกเลือก Front Plane จาก Feature Manager 
- คลิกปุ่ม Sketch หรือไปที่ Insert > Sketch 

3. วาดเส้นตรงแนวนอน 3 เส้น  
- คลิกเครื่องมือ Line (หรือกด L บนคีย์บอร์ด) 
- วาดเส้นแนวนอนเส้นที่ 1  จุดเริ่มต้น (0, 0) ไปยัง (100, 0) 
- กด Esc เพ่ือสิ้นสุดคำสั่ง 
- วาดเส้นแนวนอนเส้นที่ 2  จุดเริ่มต้น (0, 20) ไปยัง (100, 20) 
- วาดเส้นแนวนอนเส้นที่ 3  จุดเริ่มต้น (0, 40) ไปยัง (100, 40) 

4. เปลี่ยน Line Format ของเส้นที่ 1 เป็น Solid  
- คลิกเลือกเส้นที่ 1 
- คลิกขวา > เลือก Line Format (หรือ Format > Line Style) 
- ในหน้าต่าง Line Format เลือก 

- Style  > Solid (เส้นทึบ) 
- Thickness > 0.5mm 

- คลิก OK 
5. เปลี่ยน Line Format ของเส้นที่ 2 เป็น Dashed  

- คลิกเลือกเส้นที่ 2 
- คลิกขวา > Line Format 
- เลือก Style >  Dashed (เสน้ประ) 
- Thickness = 0.35mm 
- คลิก OK 

6. เปลี่ยน Line Format ของเส้นที่ 3 เป็น Phantom  
- คลิกเลือกเส้นที่ 3 
- คลิกขวา > Line Format 
- เลือก Style >  Phantom (เส้นจุดประ) 
- Thickness > 0.25mm 
- คลิก OK 

7. เพ่ิมข้อความอธิบาย (Text)  
- ไปที่ Tools > Sketch Entities > Text 
- คลิกตำแหน่งด้านขวาของเส้นที่ 1 พิมพ์ Solid Line 
- ทำเช่นเดียวกันกับเส้นที่ 2 และ 3 ("Dashed Line", "Phantom Line") 
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8. บันทึกงาน  
- กด Ctrl+S หรือ File > Save 
- คลิก Exit Sketch (เครื่องหมายถูกสีเขียว) 

หมายเหตุ : จุดตรวจสอบ เส้นทั้ง 3 เส้นมีรูปแบบที่แตกต่างกันชัดเจนหรือไม่ 
3.2  การใช้งาน Line Color 
งานที่ 2.1  สร้างรูปสี่เหลี่ยมจัตุรัสด้วยเส้นหลายสี 

ขั้นตอน 
1. สร้าง Sketch ใหม ่ 

- คลิกเลือก Top Plane 
- คลิก Sketch เพ่ือเข้าสู่โหมดวาด 

2. วาดรูปสี่เหลี่ยมจัตุรัส  
- เลือกเครื่องมือ Line (L) 
- วาดสี่เหลี่ยมจัตุรัสขนาด 50x50 mm โดย  

- จุดเริ่มต้น (0, 0) 

- ด้านบน  (0, 0) → (50, 0) 

- ด้านขวา  (50, 0) → (50, 50) 

- ด้านบน  (50, 50) → (0, 50) 

- ด้านซ้าย  (0, 50) → (0, 0) 
3. กำหนดสีให้แต่ละด้าน ด้านล่าง (Bottom) 

- คลิกเลือกเส้นด้านล่าง 
- คลิกขวา > Line Color 
- เลือกสี > สีแดง (Red) 
- Thickness = 0.7mm 
- คลิก OK 

ด้านขวา (Right)  
- คลิกเลือกเส้นด้านขวา 
- คลิกขวา > Line Color 
- เลือกสี > สีน้ำเงิน (Blue) 
- Thickness =  0.5mm 
- คลิก OK 

ด้านบน (Top) 
- คลิกเลือกเส้นด้านบน 
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- คลิกขวา > Line Color 
- เลือกสี > สีเขียว (Green) 
- Thickness = 0.5mm 
- คลิก OK 

ด้านซ้าย (Left)  
- คลิกเลือกเส้นด้านซ้าย 
- คลิกขวา > Line Color 
- เลือกสี > สีส้ม (Orange) 
- Thickness = 0.3mm 
- คลิก OK 

4. ตรวจสอบและบันทึกงาน  
- ตรวจสอบว่าทุกด้านมีสีและความหนาตามที่กำหนด 
- กด Ctrl+S 
- Exit Sketch 

หมายเหตุ : จุดตรวจสอบ  รูปสี่เหลี่ยมมี 4 สีที่ชัดเจนและความหนาที่แตกต่างกันหรือไม่ 
3.3  การใช้งาน Centerline 
งานที่ 3.1  สร้างวงกลมพร้อมเส้นศูนย์กลาง 

ขั้นตอน 
1. สร้าง Sketch ใหม ่ 

- คลิกเลือก Front Plane 
- คลิก Sketch 

2. วาดวงกลม  
- เลือกเครื่องมือ Circle (C) 
- คลิกท่ีจุดกึ่งกลาง (Origin = 0, 0) 
- ลากเมาส์ออกมาและคลิกอีกครั้งเพ่ือสร้างวงกลม 
- พิมพ์ขนาดเส้นผ่านศูนย์กลาง = 60 mm 

3. สร้าง Centerline แนวนอน  
- ไปที่ Tools > Sketch Entities > Centerline (หรือคลิกปุ่ม Centerline บน 

Toolbar) 
- หรือกด Shift+V บนแป้นพิมพ์ (Shortcut) 
- วาดเส้นแนวนอนผ่านจุดศูนย์กลาง 

- จุดเริ่มต้น: (-40, 0) 
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- จุดสิ้นสุด: (40, 0) 
- กด Esc 

4. สร้าง Centerline แนวตั้ง  
- คลิกปุ่ม Centerline อีกครั้ง 
- วาดเส้นแนวตั้งผ่านจุดศูนย์กลาง  

- จุดเริ่มต้น  (0, -40) , จุดสิ้นสุด  (0, 40) 
- กด Esc 

5. ปรับแต่งสีและความหนาของเส้น วงกลม 
- คลิกเลือกวงกลม 
- คลิกขวา > Line Format 
- Style: Solid 
- Thickness: 0.7mm 
- Color: สีดำ (Black) 

Centerline ทั้งหมด  
- กดปุ่ม Ctrl ค้างไว้ และคลิกเลือก Centerline ทั้ง 2 เส้น 
- คลิกขวา > Line Color 
- เลือกสี  สีน้ำเงิน (Blue) หรือตามมาตรฐาน 
- Thickness = 0.18mm (ควรบางกว่าเส้นหลัก) 
- คลิก OK 

6. ตรวจสอบและบันทึกงาน  
- ตรวจสอบว่า Centerline ทั้ง 2 เส้นตัดกันที่จุดศูนย์กลางวงกลม 
- ตรวจสอบว่า Centerline ยาวเกินขอบวงกลมประมาณ 10mm ทั้งสองด้าน 
- กด Ctrl+S 
- Exit Sketch 

หมายเหตุ : จุดตรวจสอบ 
- วงกลมมีศูนย์กลางตรงกับจุด Origin (0,0) หรือไม่ 
- Centerline ทั้ง 2 เส้นตัดกันที่จุดศูนย์กลางวงกลมหรือไม่ 
- Centerline มีสีและความหนาที่แตกต่างจากวงกลมหรือไม่ 
บันทึกไฟล์สุดท้าย 

7. บันทึกและตั้งชื่อไฟล์  
- File > Save As 
- ตั้งชื่อ เช่น LineSketch_Complete_ชื่อ-นามสกุล_วันที่ 
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- เลือกตำแหน่งบันทึกตามที่อาจารย์กำหนด 
- คลิก Save 

8. Capture หน้าจอ (Screenshot)  
- จัด View มุมมองที่เห็นงานทั้งหมดชัดเจน (View > Modify > Zoom to Fit หรือกด F) 
- กด Print Screen หรือ Snipping Tool 
- บันทึกภาพชื่อ เช่น  LineSketch_Screenshot_ชื่อ-นามสกุล 

8.  สรุปและวิจารณ์ผล 
 8.1  สรุปผลการปฏิบัติงาน (กรุณาตอบคำถามต่อไปนี้ในสมุดบันทึก) 

1. ฟังก์ชัน Line Format  
ผู้เรียนสามารถเปลี่ยนรูปแบบเส้นได้กี่แบบ 

ตอบ.......................................................................................................................... .................. 
รูปแบบเส้นแบบใด ที่ใช้แสดงขอบชิ้นงานที่มองเห็นได้ 

ตอบ.......................................................................................................................... .................. 
รูปแบบเส้นแบบใด ที่ใช้แสดงขอบชิ้นงานที่ถูกบัง 

ตอบ.......................................................................................................................... .................. 
2. ฟังก์ชัน Line Color  

การใช้สีต่างๆ ในแบบเครื่องกลช่วยให้เกิดประโยชน์อย่างไร 
ตอบ.......................................................................................................................... ..................  

3. ฟังก์ชัน Centerline  
Centerline มีหน้าที่อะไร ในการเขียนแบบเครื่องกล  

ตอบ.......................................................................................................................... .................. 
ควรวาด Centerline ให้ยาวเกินขอบชิ้นงานหรือไม่ เพราะเหตุใด 

ตอบ.......................................................................................................................... .................. 
8.2 ปัญหาที่พบและแนวทางแก้ไข 

ปัญหาที่พบระหว่างปฏิบัติงาน วิธีแก้ไขท่ีใช้ 

1. 
 

2. 
 

3. 
 

 
8.3 ข้อเสนอแนะ/ความคิดเห็น กรุณาเขียนความคิดเห็นเกี่ยวกับการปฏิบัติงานในครั้งนี้ 

- สิ่งที่ได้เรียนรู้ใหม่………………………………………………………………………………………………………………. 
- สิ่งที่ยากที่สุด…………………………………………………………………………………………………………………….. 
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- สิ่งที่อยากเรียนรู้เพิ่มเติม…………………………………………………………………………………………………….. 
 
9.  การประเมินผล 

รายการประเมิน คะแนน
เต็ม 

คะแนนที่
ได้ 

หมายเหตุ 

ส่วนที่ 1  Line Format  
   

1.1 เส้น Solid สร้างถูกต้อง ขนาดเหมาะสม 2 
  

1.2 เส้น Dashed สร้างถูกต้อง รูปแบบชัดเจน 3 
  

1.3 เส้น Phantom สร้างถูกต้อง รูปแบบชัดเจน 3 
  

ส่วนที่ 2  Line Color   
  

2.1 รูปสี่เหลี่ยมสร้างถูกต้อง ขนาด 50x50mm 3 
  

2.2 กำหนดสีทั้ง 4 ด้านถูกต้องและชัดเจน 3 
  

2.3 กำหนดความหนาเส้นแตกต่างกันเหมาะสม 3 
  

ส่วนที่ 3  Centerline   
  

3.1 วงกลมสร้างถูกต้อง เส้นผ่านศูนย์กลาง 60 mm 3 
  

3.2 Centerline แนวนอนและแนวต ั ้ งสร ้างถ ูกต ้อง ผ ่านจุด
ศูนย์กลาง 

3 
  

3.3 Centerline มีสีและความหนาที่เหมาะสม แตกต่างจากเส้น
หลัก 

3 
  

การประเมินทั่วไป   
  

4.1 ความสะอาดเรียบร้อยของงาน 1 
  

4.2 การตั้งชื่อและบันทึกไฟล์ถูกต้อง 1 
  

4.3 ส่งงานตรงเวลา 1 
  

4.4 สรุปและวิจารณ์ผลครบถ้วน 1 
  

รวมคะแนน 30 
  

 

10.  หนังสืออ้างอิง/หนังสือค้นคว้าเพิ่มเติม 
 หนังสือเรียนวิชา งานเขียนแบบเครื่องกลด้วยคอมพิวเตอร์ (Computer-Aided Mechanical Drafting 
Job) รหัสวิชา 20101-2029 หน่วยการเรียนรู้ที่ 3 เรื่อง การเขียนเส้นร่างด้วยฟังก์ชันหลัก และฟังก์ชันเสริมใน
โปรแกรม SOLIDWORKS ของบริษัท สำนักพิมพ์เอมพันธ์ จำกัด 
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กิจกรรมการเรียนรู้ (ครั้งท่ี 7/18, ชั่วโมงที่ 43-49/126) 

ขั้นนำเข้าสู่บทเรียน (Warm up) 
16. ครูเตรียมภาพแบบเครื่องกล 3 แบบบนหน้าจอ 

- แบบที่ 1  รูปสี่เหลี่ยมธรรมดา ไม่มีช่องหรือขอบซ้อน 
- แบบที่ 2  แผ่นโลหะที่ต้องการขอบยกข้ึน (Flange) 
- แบบที่ 3  ชิ้นงานที่มีความสมมาตรซ้าย-ขวา 

17. ครูถามผู้เรียนทีละแบบ 
- หากต้องการสร้างขอบของแผ่นโลหะที่ห่างจากขอบเดิม 5mm ทุกด้าน เราจะวาดทีละเส้น

หรือมีวิธีที่เร็วกว่า 
- หากออกแบบครึ่งหนึ่งของชิ้นงานแล้ว แล้วอีกครึ่งเป็นแบบเดียวกัน จะต้องวาดซ้ำหรือไม่ 
- เมื่อเส้นต่างๆ ตัดกัน แล้วมีส่วนเกินที่ไม่ต้องการ จะลบทีละเส้นหรือมีวิธีที่ดีกว่า 

18. ผู้เรียนแบ่งกลุ่มช่วยกันอภิปราย และแชร์ความคิดเห็น 
19. ครูสรุป 

- วันนี้เราจะเรียนรู้ฟังก์ชันที่ช่วยทำงานซ้ำ สร้างสมมาตร และตัดแต่งเส้นให้รวดเร็วขึ้น 
20. ครูให้ผู้เรียนเปิดโปรแกรม SOLIDWORKS และให้ผู้เรียนวาดรูปสี่เหลี่ยมผืนผ้าง่ายๆ บน         Front 

Plane ขนาด 100x60 mm 
21. ครูถาม 

- ถ้าต้องการวาดสี่เหลี่ยมอีกอันที่ใหญ่กว่านี้ 10mm ทุกด้าน จะต้องคำนวณและวาดใหม่หรือไม่ 
22. ผู้เรียนตอบและแสดงความคิดเห็น 
23. ครูเปิดเผยหัวข้อเรียนวันนี้ 

- Offset Entities 
- Mirror Entities 
- Trim Entities 

ขั้นการสอน/การนำเสนอ (Presentation) 
1. ครูสาธิตบนหน้าจอใหญ่ 

- วาดรูปสี่เหลี่ยม 80x50 mm 
- เข้าสู่ Offset Entities จาก Command Manager หรือ Tools > Sketch Entities > Offset 
- แสดงให้เห็นว่าเส้นใหม่ถูกสร้างขึ้นโดยอัตโนมัติ 

2. ผู้เรียนสังเกตและจดบันทึกขั้นตอน 
3. ครูใหผู้้เรียน Explore เอง 

- ลองปรับค่า Distance ดู จะเกิดอะไรขึ้น 
- ลองเลือก Reverse เพ่ือเปลี่ยนทิศทาง 
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- ลองเลือก Select Chain เพ่ือเลือกเส้นหลายเส้นพร้อมกัน 
- ลองเลือก Bi-directional เพ่ือสร้าง Offset ทั้ง 2 ทาง 

4. ผู้เรียนทดลองและพบว่า 
- Distance = ระยะห่างจากเส้นเดิม 
- Reverse = สลับด้านใน-นอก 
- Select Chain = เลือกเส้นต่อเนื่องอัตโนมัติ 
- Bi-directional = Offset ทั้ง 2 ด้าน 

5. ครูใหผู้้เรียน 2-3 คนนำเสนอผลการทดลองหน้าชั้นเรียน 
6. ครูแบ่งผู้เรียนเป็น 2 กลุ่ม 

- กลุ่มท่ี 1  ผู้เชี่ยวชาญ Mirror with Copy (สร้างสำเนา) 
- กลุ่มท่ี 2  ผู้เชี่ยวชาญ Mirror without Copy (สร้างแบบไม่เก็บต้นฉบับ) 

7. ผู้เรียนแต่ละกลุ่มศึกษาจากหนังสือหน้า 76-77 และทดลองใช้งาน โดย 
- วาดรูปสามเหลี่ยมด้านหนึ่งของ Centerline 
- ใช้ Mirror Entities 
- สังเกตผลลัพธ์ 

8. ผู้เรียนแต่ละกลุ่มส่งตัวแทนนำเสนอ โดย 
- กลุ่ม 1  อธิบายการใช้ Mirror with Copy (Ctrl+C) 
- กลุ่ม 2  อธิบายการใช้ Mirror without Copy (ลบต้นฉบับ) 

9. ครูสรุปความแตกต่างและข้อควรระวัง 
- ต้องมี Mirror Line (เส้นศูนย์กลาง/Centerline) ก่อนเสมอ 
- Copy = เก็บท้ังต้นฉบับและภาพสะท้อน 
- ไม่ Copy = เหลือแต่ภาพสะท้อน 

10. ครูตั้ง 4 สถานี โดยแต่ละสถานีมีคอมพิวเตอร์พร้อมโจทย์ที่ต่างกัน 
- สถานีที่ 1  Power Trim  

โจทย์  วาดสามเหลี่ยม 2 รูปซ้อนกัน ใช้ Power Trim ลบเส้นที่ไม่ต้องการด้วยการลากเมาส์ 
- สถานีที่ 2  Corner  

โจทย์  วาดเส้นตรง 2 เส้นที่ไม่ได้ตัดกัน ใช้ Corner เพ่ือต่อเส้นให้บรรจบ 
- สถานีที่ 3  Trim Away Inside  

โจทย์  วาดสี่เหลี่ยมและวงกลมที่ซ้อนกัน ใช้ Trim Away Inside ลบเส้นภายใน 
- สถานีที่ 4  Trim to Closest 

โจทย์  วาดเส้นหลายเส้นตัดกัน ใช้ Trim to Closest ลบส่วนที่ใกล้ที่สุด 
11. ผู้เรียนหมุนเวียนไปทำทุกสถานี 
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12. ในแต่ละสถานีมีใบงานให้ติ๊กถูกเม่ือทำสำเร็จ 
13. ครูสรุปความแตกต่างของ Trim แต่ละแบบ 

- Power Trim  ลากผ่านเส้นที่ต้องการลบ 
- Corner  ต่อเส้น 2 เส้นให้บรรจบ 
- Trim Away Inside  ลบเส้นภายในรูปที่เลือก 
- Trim Away Outside  ลบเส้นนอกรูปที่เลือก 
- Trim to Closest  ลบส่วนที่ใกล้จุดตัดที่สุด 

ขั้นฝึกฝน/ลงมือปฏิบัติ (Practice) 
1. ครใูห้ผู้เรียนทำใบงานที่ 3.1 
2. ผู้เรียนรับฟังคำอธิบาย อ่านใบงานและทำความเข้าใจตัวอย่างชิ้นงานที่ต้องสร้าง 
3. ผู้เรียนทำงานเป็นรายบุคคล โดยปฏิบัติตามข้ันตอน 
4. ครูเดินดูการทำงานและให้คำแนะนำ 
5. ครูเดินสังเกตการทำงาน ให้คำแนะนำและแก้ปัญหาเมื่อผู้เรียนติดขัด 
6. ผู้เรียนที่ทำเสร็จก่อนช่วยเพื่อนที่ยังทำไม่เสร็จ 
7. ผู้เรียนบันทึกไฟล์งานโดยใช้ชื่อตามท่ีใบงานกำหนด 

ขั้นประยุกต์ใช ้(Production) 
กิจกรรม ออกแบบ Logo บริษัทสมมาตร 
1. ครูใหก้ติกา 

- ผู้เรียนทำงานเดี่ยว 
- ออกแบบ Logo ของบริษัทจำลอง โดยใช้ทั้ง 3 ฟังก์ชันที่เรียน 
- Logo ต้องมีความสมมาตร (ใช้ Mirror) 
- มีการสร้างเส้นขอบหรือกรอบ (ใช้ Offset) 
- มีการตัดแต่งเส้นให้สวยงาม (ใช้ Trim) 
- ใช้ Line Color อย่างน้อย 2 สี 
- ขนาดพ้ืนที่ไม่เกิน 100x100 mm 

2. ผู้เรียนทำกิจกรรมตามขั้นตอน ดังนี้ 
- ผู้เรียนร่างแบบบนกระดาษ 
- สร้างครึ่งหนึ่งของ Logo บน SOLIDWORKS 
- ใช้ Mirror สร้างอีกครึ่ง 
- ใช้ Offset สร้างกรอบ 
- ใช้ Trim ตัดแต่งรายละเอียด 
- บันทึกไฟล์ ตามท่ีครูกำหนด  เช่น "Logo_ชื่อ-นามสกุล"  

3. ในระหว่างทำกิจกรรมครูเดินสังเกตและให้กำลังใจ โดยเน้นความคิดสร้างสรรค์มากกว่าความสมบูรณ์ 
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4. ผู้เรียนให้ feedback เชิงบวกกับเพื่อนๆ 
5. ครูถ่ายภาพผลงานดีๆ เพ่ือเก็บไว้เป็นตัวอย่าง 

ขั้นสรุป/ประเมินผล (Wrap up) 
1. ครูและผู้เรียนร่วมกันสรุปประเด็นสำคัญ 
2. ผู้เรียนฟังการสรุปและจดบันทึกสาระสำคัญ 
3. ครูถามคำถามทบทวนความรู้  
4. ผู้เรียนตอบคำถามทบทวน 
5. ผู้เรียนสอบถามข้อสงสัยที่ยังไม่เข้าใจ 
6. ครูแจ้งหัวข้อที่จะเรียนครั้งต่อไป 
7. ผู้เรียนเตรียมความพร้อมสำหรับบทเรียนต่อไป 

กิจกรรมการเรียนรู้ (ครั้งท่ี 8/18, ชั่วโมงที่ 50-56/126) 

ขั้นนำเข้าสู่บทเรียน (Warm up) 
10. ครูแสดงภาพแบบเครื่องกล 4 สถานการณ์บนจอ 

- สถานการณ์ท่ี 1  เส้นที่ไม่ยาวพอ โดยแสดงภาพ 2 เส้นที่เกือบจะบรรจบแต่ยังห่างกัน 2 mm 
- สถานการณ์ท่ี 2  ต้องการสร้างชิ้นงานหลายชิ้น โดย แสดงภาพชิ้นงานที่ต้องมี 10 รู เหมือนกัน

เรียงเป็นแถว 
- สถานการณ์ท่ี 3  ขนาดไม่พอดี โดย แสดงภาพรูปที่เขียนแล้ว แต่ต้องการขยายเป็น 1.5 เท่า 
- สถานการณ์ท่ี 4  ต้องการหมุนและวาง โดย แสดงภาพชิ้นงานที่ต้องวางเป็นวงกลม 8 ชิ้น 

11. ครูถามคำถามผู้เรียน จากสถานการณ์ทั้ง 4 
- ถ้าต้องการให้เส้นทั้งสองต่อกัน แต่ไม่อยากวาดใหม่ จะทำอย่างไร 
- ถ้าต้องวาด 10 รูเหมือนกัน จะต้องวาดทีละรูหรือมีวิธีที่เร็วกว่า 
- หากรูปขนาดไม่พอดี จะวาดใหม่หรือมีวิธีปรับขนาดทั้งรูปพร้อมกัน 
- หากต้องการหมุนชิ้นงาน จะต้องวาดและหมุนทีละชิ้นหรือไม่ หรือมีวิธีที่ง่ายกว่า 

12. ผู้เรียนแบ่งกลุ่ม 4 กลุ่ม แต่ละกลุ่มรับผิดชอบ กลุ่มละ 1 สถานการณ ์
13. ผู้เรียนอภิปรายและเสนอวิธีแก้ปัญหา และ แต่ละกลุ่มนำเสนอ 
14. ครูสรุป 

- วันนี้เราจะเรียนฟังก์ชันเสริมที่จะช่วยแก้ปัญหาทั้ง 4 สถานการณ์นี้ได้อย่างรวดเร็ว 

ขั้นการสอน/การนำเสนอ (Presentation) 
1. ครูตั้ง 4 สถานี โดยแต่ละสถานีมีคอมพิวเตอร์และหนังสือประกอบ 
2. ผู้เรียนหมุนเวียนไปเรียนรู้ทุกสถานี 

สถานีที่ 1 Extend & Move Entities 
 Extend Entities (หนังสือหน้า 81-82) ยืดเส้นให้ยาวขึ้น 
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 Move Entities (หนังสือหน้า 83) ย้ายเส้นไปตำแหน่งใหม่ 
3. ผู้เรียนอ่านหนังสือและดู Video สั้นๆ และทดลองปฏิบัติตามใบงานสถานี 

- วาดสี่เหลี่ยม 60x40 mm 
- วาดเส้นทแยงมุมแต่ไม่ถึงจุดมุม (ห่างจาก 10mm) 
- ใช้ Extend ยืดเส้นทแยงให้ถึงจุดมุม 
- วาดวงกลมเส้นผ่านศูนย์กลาง 20mm ที่ตำแหน่ง (0,0) 
- ใช้ Move ย้ายวงกลมไปท่ีตำแหน่ง (30,20) 

4. ผู้เรียนบันทึกผลและตอบคำถาม 
- Extend ต่างจาก Trim อย่างไร 
- Move ต่างจาก Copy อย่างไร 
สถานีที่ 2 Copy & Scale 

 Copy Entities (หนังสือหน้า 84-85) คัดลอกเส้นไปตำแหน่งใหม่ 
 Scale Entities (หนังสือหน้า 88-89) ปรับขนาดรูปหรือเส้น 

5. ผู้เรียนอ่านหนังสือและดู Video สั้นๆ และทดลองปฏิบัติตามใบงานสถานี 
- วาดรูปห้าเหลี่ยม 
- ใช้ Copy คัดลอกห้าเหลี่ยมไปด้านขวา 3 รูป 
- เลือกห้าเหลี่ยมต้นฉบับ 
- ใช้ Scale ขยายเป็น 1.5 เท่า 
- สังเกตว่าของที่ Copy ไปไม่เปลี่ยนขนาด 

6. ผู้เรียนบันทึกผลและตอบคำถาม 
- Copy ต่างจาก Mirror อย่างไร 
- Scale ทำให้เส้นทุกเส้นเปลี่ยนแปลงอย่างไร 
สถานีที่ 3 Move with Angle & Stretch 

 Move with Angle (หนังสือหน้า 86-87) ย้ายและหมุนพร้อมกัน 
 Stretch (หนังสือหน้า 90-92) ยืดเส้นหรือรูป 

7. ผู้เรียนอ่านหนังสือและดู Video สั้นๆ และ ทดลองปฏิบัติตามใบงานสถานี 
- วาดบ้านรูปห้าเหลี่ยม (สี่เหลี่ยม + หลังคาสามเหลี่ยม) 
- ใช้ Move with Angle ย้ายและหมุน 45 องศา 
- วาดสี่เหลี่ยม 80x40 mm 
- ใช้ Stretch เลือกด้านบนและยืดขึ้น 20mm 
- สังเกตว่าด้านล่างไม่เปลี่ยนแปลง 

8. ผู้เรียนบันทึกผลและตอบคำถาม 
- Move with Angle ใช้เมื่อไร 
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- Stretch ต่างจาก Scale อย่างไร 

สถานีที่ 4 Linear Pattern & Circular Pattern 

 Linear Pattern (หนังสือหน้า 92-93) ทำซ้ำเชิงเส้นตรง 
 Circular Pattern (หนังสือหน้า 94-95) ทำซ้ำเป็นวงกลม 

9. ผู้เรียนอ่านหนังสือและดู Video สั้นๆ  และ ทดลองปฏิบัติตามใบงานสถานี 
Linear Pattern 

- วาดสี่เหลี่ยม 20x20 mm 
- ใช้ Linear Pattern ทำซ้ำ 

- Direction 1  แนวนอน, Spacing =  30mm, Instances =  5 
- Direction 2  แนวตั้ง, Spacing =  30mm, Instances = 3 
- สังเกต Pattern 5x3 = 15 รูป 

Circular Pattern 
10. วาดวงกลมใหญ่เส้นผ่านศูนย์กลาง 100mm 
11. วาดวงกลมเล็กเส้นผ่านศูนย์กลาง 15mm ที่ขอบวงกลมใหญ่ 
12. ใช้ Circular Pattern ทำซ้ำ 8 รอบวงกลมใหญ ่
13. ผู้เรียนบันทึกผลและตอบคำถาม 

- Linear Pattern ช่วยประหยัดเวลาอย่างไร 
- Circular Pattern ใช้ในชิ้นงานแบบใด 

14. ผู้เรียนกลับมานั่งรวมกัน แต่ละสถานีส่งตัวแทน 1 คนนำเสนอสิ่งที่เรียนรู้  
- ฟังก์ชันที่เรียนคืออะไร 
- ใช้ทำอะไร 
- ข้อควรระวังหรือเทคนิคพิเศษ คืออะไร 

15. ครูสร้างตารางสรุปบนกระดาน 
16. ครูสร้างตารางสรุปบนกระดาน 

ฟังก์ชัน หน้าที ่ คำสั่งเข้าถึง เมื่อไหร่ควรใช้ 
Extend ยืดเส้น Tools > Sketch > Extend เส้นไม่ยาวพอ 

Move ย้าย Move Entities เปลี่ยนตำแหน่ง 

Copy คัดลอก Copy Entities ต้องการสำเนา 
Move with Angle ย้ายและหมุน Rotate Entities วางแบบหมุน 

Scale ปรับขนาด Scale Entities เปลี่ยนขนาด 

Stretch ยืด Stretch Entities ยืดด้านใดด้านหนึ่ง 
Linear Pattern ทำซ้ำเชิงเส้น Linear Pattern Heat Sink, ซี่รัว้ 
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Circular Pattern ทำซ้ำวงกลม Circular Pattern เฟือง, ใบพัด 

17. ครูเน้นย้ำจุดสำคัญและข้อควรระวังแต่ละฟังก์ชัน 

ขั้นฝึกฝน/ลงมือปฏิบัติ (Practice) 
1. ครใูห้ผู้เรียนทำใบงานที่ 3.2 
2. ผู้เรียนรับฟังคำอธิบาย อ่านใบงานและทำความเข้าใจตัวอย่างชิ้นงานที่ต้องสร้าง 
3. ผู้เรียนทำงานเป็นรายบุคคล โดยปฏิบัติตามข้ันตอน 
4. ครูเดินดูการทำงานและให้คำแนะนำ 
5. ครูเดินสังเกตการทำงาน ให้คำแนะนำและแก้ปัญหาเมื่อผู้เรียนติดขัด 
6. ผู้เรียนที่ทำเสร็จก่อนช่วยเพื่อนที่ยังทำไม่เสร็จ 
7. ผู้เรียนบันทึกไฟล์งานโดยใช้ชื่อตามท่ีใบงานกำหนด 
 

ขั้นประยุกต์ใช ้(Production)  
กิจกรรม ออกแบบชิ้นส่วนเครื่องจักร 
1. ครูมอบหมายโจทย์ คือ ออกแบบชิ้นส่วนเครื่องจักรที่ใช้ฟังก์ชันเสริมอย่างน้อย 5 ฟังก์ชัน 

ตัวเลือกโจทย์ (เลือก 1 ใน 3) 
โจทย์ A  ฐานติดตั้งมอเตอร์ (Motor Mounting Plate) 

- มีฐานสี่เหลี่ยม 200x150 mm 
- มีรูสกรู 4 รู ที่มุมทั้ง 4 (ใช้ Pattern หรือ Copy) 
- มีรูกลางสำหรับเพลา เส้นผ่านศูนย์กลาง 30mm 
- มีช่องระบายอากาศเป็นรูยาว 6 รู (ใช้ Linear Pattern) 
- มีขอบยกสูงรอบๆ (ใช้ Offset) 

โจทย์ B  ล้อหัวเฟือง (Gear Wheel) 
- วงกลมหลักเส้นผ่านศูนย์กลาง 150mm 
- ฟันเฟือง 12 ซี่ รอบวงกลม (ใช้ Circular Pattern) 
- รูเพลาตรงกลาง เส้นผ่านศูนย์กลาง 25mm 
- รูสกรูยึด 6 รู รอบรูเพลา (ใช้ Circular Pattern) 
- ช่องลดน้ำหนัก 3 ช่อง (ใช้ Pattern) 

โจทย์ C  แผ่นระบายความร้อน (Heat Sink) 
- ฐาน 120x120 mm 
- ครีบระบายความร้อน 15 ครีบ (ใช้ Linear Pattern) 
- รูยึด 4 รู ที่มุม (ใช้ Copy หรือ Pattern) 
- ครีบแต่ละอันมีความสูงไล่ระดับ (ใช้ Scale) 

2. ครูใหเ้งื่อนไข ดังนี้ 
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- ใช้ฟังก์ชันเสริมอย่างน้อย 5 ฟังก์ชัน 
- มีการใช้ Line Format แยกเส้นหลัก-เส้นรอง 
- มีการใช้ Centerline แสดงแกนสมมาตร 
- มีการกำหนดขนาดครบถ้วน 
- บันทึกไฟล์ ตามชื่อท่ีครูกำหนด เช่น "Project_ชื่อชิ้นส่วน_ชื่อ-นามสกุล" 

3. ผู้เรียนปฏิบัติงานตามขั้นตอน คือ 
- ผู้เรียนร่างแบบบนกระดาษและระบุฟังก์ชันที่จะใช้ 
- สร้างชิ้นส่วนบน SOLIDWORKS 
- ตรวจสอบและแก้ไข  

4. ผู้เรียนทุกคนนำเสนอผลงานของตนหน้าจอคอมพิวเตอร์ 
5. ครูและเพ่ือนๆ เดินชมผลงาน  
6. แต่ละคนแสดงความคิดเห็นผลงานเพ่ือน 3 คนที่ชอบที่สุด 

- ชื่อ: ...................................................เพราะ: ………………………………… 
- ชื่อ: ...................................................เพราะ: ………………………………… 
- ชื่อ: ...................................................เพราะ: ………………………………… 

7. ครูเลือก Top 3 ให้นำเสนอ ภายใต้หัวข้อ 
- ออกแบบชิ้นส่วนอะไร 
- ใช้ฟังก์ชันอะไรบ้าง อย่างไร 
- ปัญหาที่พบและวิธีแก้ไขคืออะไร 
- ข้อดีของฟังก์ชันที่ใช้คืออะไร 

 

ขั้นสรุป/ประเมินผล (Wrap up) 
1. ครูให้ผู้เรียนทำแบบฝึกหัดหลังเรียน หน่วยที่ 3  
2. ผู้เรียนทำแบบฝึกหัดหลังเรียน หน่วยที่ 3 ตามที่ครูมอบหมาย 
3. ครแูละผู้เรียนร่วมสรุปเนื้อหาและประเด็นสำคัญ 
4. ผู้เรียนตั้งคำถามและข้อสงสัย  
5. ครแูจ้งหัวข้อที่จะเรียนครั้งต่อไป 
6. ผู้เรียนเตรียมความพร้อมสำหรับบทเรียนต่อไป 

 

สื่อและแหล่งการเรียนรู้ 
สื่อสิ่งพิมพ์ 
หนังสือเรียนวิชา งานเขียนแบบเครื่องกลด้วยคอมพิวเตอร์ (Computer-Aided Mechanical Drafting 

Job) รหัสวิชา 20101-2029 หน่วยการเรียนรู้ที่ 3 เรื่อง การเขียนเส้นร่างด้วยฟังก์ชันหลัก และฟังก์ชันเสริมใน
โปรแกรม SOLIDWORKS ของบริษัท สำนักพิมพ์เอมพันธ์ จำกัด 

สื่อโสตทัศน์ 
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สไลด์ Power Point หน่วยการเรียนรู้ที่ 3 การเขียนเส้นร่างด้วยฟังก์ชันหลัก และฟังก์ชันเสริมในโปรแกรม 
SOLIDWORKS 

สื่อออนไลน์ 
  - 

สื่อจำลองหรือของจริง 
 - 

 อ่ืน ๆ  
  - 

หลักฐานการเรียนรู้ 
หลักฐานความรู้ 
1. ผลการทำแบบฝึกหัดหลังเรียน หน่วยที่ 3  
2. ผลการตอบคำถามทบทวนความรู้ 
3. ผลการตรวจแบบทดสอบหลังเรียน หน่วยที่ 3 

 หลักฐานการปฏิบัติงาน 
1. ผลการปฏิบัติงานตามใบงานเพ่ิมเติมที่ 2 
2. ผลการปฏิบัติงานตามใบงานที่ 3.1 
3. ผลการปฏิบัติงานตามใบงานที่ 3.2 
4. ผลการทำ Mini Challenge ออกแบบโลโก้บริษัท 
5. ผลการออกแบบ Logo บริษัทสมมาตร 
6. ผลการออกแบบชิ้นส่วนเครื่องจักร 

 หลักฐานคุณลักษณะอันพึงประสงค์ 
1. ผลการประเมินตามแบบประเมินคุณธรรม จริยธรรม ตามสภาพจริง 

การวัดและประเมินผล 
เครื่องมือวัด วิธีวัด การประเมินตามเกณฑ ์

1. ใบงานเพ่ิมเติมที่ 2 ปฏิบัติ-ตรวจแบบฝึกหัด เกณฑ์ผ่าน 50% 

2. ใบงานที่ 3.1 ปฏิบัติ-ตรวจแบบฝึกหัด เกณฑ์ผ่าน 50% 

3. ใบงานที่ 3.2 ปฏิบัติ-ตรวจแบบฝึกหัด เกณฑ์ผ่าน 50% 

4. แบบฝึกหัดหลังเรียน หน่วยที่ 3 ตรวจแบบฝึกหัด เกณฑ์ผ่าน 50% 

5. แบบทดสอบหลังเรียน หน่วยที่ 3 ทดสอบ-ตรวจแบบทดสอบ เกณฑ์ผ่าน 50% 

6. แบบประเมินคุณธรรม จริยธรรม ตามสภาพจริง สังเกต/ผู้เรียนประเมินตนเอง เกณฑ์ผ่าน 70% 

งานที่มอบหมาย 
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1. งานที่มอบหมายนอกเหนือเวลาเรียน ให้ทำแบบฝึกหัดที่ทำไม่แล้วเสร็จในห้องเรียนให้เรียบร้อย 
2. ทำ Mini Challenge ออกแบบโลโก้บริษัท 
3. ออกแบบ Logo บริษัทสมมาตร 
4. ออกแบบชิ้นส่วนเครื่องจักร 
5. สืบค้นข้อมูลเพิ่มเติมเก่ียวกับเนื้อหาที่จะเรียนในครั้งถัดไป 

 

หนังสืออ้างอิง 
 ผศ.กีรดิษ สายพัทลุง. (2567). งานเขียนแบบเครื่องกลด้วยคอมพิวเตอร์ (Computer-Aided Mechanical 
Drafting Job). เอมพันธ์. 
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บันทึกผลหลังการจัดการเรียนรู้ (ครั้งที่ 6/18, ชั่วโมงท่ี 36-42/126) 
1. ผลการจัดการเรียนรู้ที่เกิดขึ้นกับผู้เรียน 

               
               
               

2. ปัญหา อุปสรรคที่พบ 
               
               
               

3. การแก้ไขปัญหา 
3.1) ผลการแก้ไขปัญหาที่ส่งผลลัพธ์ที่ดีต่อผู้เรียน 

               
               

3.2) แนวทางแก้ปัญหาในครั้งต่อไป 
               
               

 
 

ลงชื่อ 
                        (.........................................)

                    ครูผู้สอน   
     ………./…………/………… 

 
 
 
 
 
 
 
 
 
 
 



177 
 

 
 

บันทึกผลหลังการจัดการเรียนรู้ (ครั้งที่ 7/18, ชั่วโมงท่ี 43-49/126) 
1. ผลการจัดการเรียนรู้ที่เกิดขึ้นกับผู้เรียน 

               
               
               

2. ปัญหา อุปสรรคที่พบ 
               
               
               

3. การแก้ไขปัญหา 
3.1) ผลการแก้ไขปัญหาที่ส่งผลลัพธ์ที่ดีต่อผู้เรียน 

               
               

3.2) แนวทางแก้ปัญหาในครั้งต่อไป 
               
               

 
 

ลงชื่อ 
                        (.........................................)

                    ครูผู้สอน   
     ………./…………/………… 
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บันทึกผลหลังการจัดการเรียนรู้ (ครั้งที่ 8/18, ชั่วโมงท่ี 50-56/126) 
1. ผลการจัดการเรียนรู้ที่เกิดขึ้นกับผู้เรียน 

               
               
               

2. ปัญหา อุปสรรคที่พบ 
               
               
               

3. การแก้ไขปัญหา 
3.1) ผลการแก้ไขปัญหาที่ส่งผลลัพธ์ที่ดีต่อผู้เรียน 

               
               

3.2) แนวทางแก้ปัญหาในครั้งต่อไป 
               
               

 
 

ลงชื่อ 
                        (.........................................)

                    ครูผู้สอน   
     ………./…………/………… 
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แผนการจัดการเรียนรู้ที่ 4  หน่วยที่     4      . 
รหัสวิชา 20101 – 2029  ชื ่อวิชา งานเขียนแบบเครื ่องกลด้วย
คอมพิวเตอร์ (Computer-Aided Mechanical Drafting Job) 

สอนครั้งที ่9 - 11 

ชื่อหน่วยการเรียนรู้   ระบบ 3 มิติ และการสร้างชิ้นงาน 3 มิติด้วยการ
เพ่ิมความหนาในโปรแกรม SOLIDWORKS    ทฤษฎี    3    ชม.  

ปฏิบัติ   18    ชม. ชื่อเรื ่อง   ระบบ 3 มิติ และการสร้างชิ้นงาน 3 มิติด้วยการเพิ่มความหนาในโปรแกรม 
SOLIDWORKS 

สาระสำคัญ 
 การสร้างชิ้นงานสามมิติในโปรแกรม SOLIDWORKS คือการพัฒนางานจาก 2 มิติ สู ่ 3 มิติ ผ่านการใช้
ระนาบและเพ่ิมความหนา โดยระนาบมีทั้งแบบพ้ืนฐานและแบบที่สร้างเพ่ิมเติม เช่น ระนาบขนาน ตั้งฉาก แนบติด 
กำหนดมุม และระนาบกึ่งกลาง เพ่ือรองรับการวางวัตถุในตำแหน่งที่ต้องการ 
 การเพิ่มความหนามีหลายเทคนิค ตั้งแต่การใช้คำสั่ง Extruded Boss/Bass พื้นฐาน ไปจนถึงเทคนิคขั้นสูง 
เช่น การอ้างอิงจากมุมหรือพื้นผิว การกำหนดระยะห่าง การสร้างจากจุดกึ่งกลาง และการแยกสองทิศทาง 
นอกจากนี้ยังมีเทคนิคเสริมที่ช่วยเพิ่มประสิทธิภาพการทำงาน เช่น การจัดการวัตถุหลายชิ้นและการผนึกรวมวัตถุ 
ทำให้สามารถควบคุมทุกมิติการออกแบบได้อย่างแม่นยำ 
 

ผลลัพธ์การเรียนรู้ระดับหน่วยการเรียน 
ผู้เรียนสามารถสร้างระนาบในรูปแบบต่าง ๆ และเพ่ิมความหนาให้กับเส้นร่าง 2 มิต ิเพ่ือสร้างเป็นชิ้นงาน 3 

มิต ิในโปรแกรม SOLIDWORKS โดยใช้เทคนิคการสร้างความหนาที่เหมาะสมกับลักษณะของชิ้นงาน 
 

อ้างอิงมาตรฐาน/เชื่อมโยงกลุ่มอาชีพ 
 - 

สมรรถนะประจำหน่วย 
10. แสดงความรู้เกี่ยวกับระบบ 3 มิติและการสร้างระนาบในรูปแบบต่าง ๆ ในโปรแกรม SOLIDWORKS 
11. มีทักษะการใช้คำสั ่งและเครื ่องมือในการสร้างชิ ้นงาน 3 มิติด้วยการเพิ ่มความหนาในโปรแกรม 

SOLIDWORKS 
12. ประยุกต์ใช้เทคนิคการสร้างความหนารูปแบบต่าง ๆ เพื่อออกแบบและสร้างชิ้นงาน 3 มิติที่มีความ

ซับซ้อน 

จุดประสงค์เชิงพฤติกรรม  
ด้านความรู้ (Knowledge) 
4. อธิบายเกี่ยวกับระบบ 3 มิติและหลักการสร้างระนาบในรูปแบบต่าง ๆ เพื่อใช้เป็นพื้นฐานในการสร้าง

ชิ้นงาน 3 มิติได้ 
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ด้านทักษะ/กระบวนการ  (Process) 
1. ใช้คำสั่งและเครื่องมือในการสร้างระนาบและเพ่ิมความหนาให้กับชิ้นงาน 2 มิติ เพ่ือสร้างเป็นชิ้นงาน 3 

มิติในโปรแกรม SOLIDWORKS ได ้

2. แก้ไขปัญหาและใช้เทคนิคข้ันสูงในการสร้างและจัดการชิ้นงาน 3 มิติเพ่ือเพ่ิมประสิทธิภาพในการทำงาน
ได ้

 

คุณลักษณะท่ีพึงประสงค์ (Attitude)   
1. มีเจตคติและกิจนิสัยที่ดีในการปฏิบัติงานด้วยความละเอียด รอบคอบ และมีความคิดสร้างสรรค์ในการ

ออกแบบชิ้นงาน 3 มิต ิ
 

ด้านการประยุกต์ใช้ (Apply)  
1. ประยุกต์ใช้เทคนิคการเพิ่มความหนาในรูปแบบต่าง ๆ เพื่อสร้างชิ้นงาน 3 มิติที่มีความซับซ้อนและตรง

ตามความต้องการได้ 
 

สาระการเรียนรู้ 
 4.1 การสร้างระนาบในโปรแกรม SOLIDWORKS 

4.2 การสร้างระนาบใหม่ในรูปแบบต่าง ๆ 
 4.2.1 การสร้างระนาบแบบขนาน ( Parallel Plane ) 

4.2.2 การสร้างระนาบตั้งฉาก (Perpendicular Plane) 
4.2.3 การสร้างระนาบแบบแนบติด (Coincident Plane) 
4.2.4 การสร้างระนาบแบบกำหนดมุม (At Angle Plane) 
4.2.5 การสร้างระนาบแบบกึ่งกลาง (Mid Plane) 

4.3 วิธีการสร้างวัตถุในระนาบใหม่ 
4.4 การเปลี่ยนแปลงระนาบที่สร้างไว้ 
4.5 การเปลี่ยนการแสดงผลของระนาบใหม่ 
4.6 การเพ่ิมความหนาให้กับชิ้นงานในโปรแกรม SOLIDWORKS 
 4.6.1 การสร้างความหนาแบบอ้างอิงจากมุม (Angular Reference Extrusion) 

4.6.2 การสร้างความหนาโดยอ้างอิงจากพ้ืนผิว (Surface Reference Extrusion) 
4.6.3 การกำหนดความหนาจากระยะห่างระนาบผิวหรือพ้ืนผิว (Distance Plane/Surface Extrusion) 
4.6.4 การกำหนดความหนาไปยังวัตถุอ่ืน (End at Object Extrusion) 
4.6.5 การสร้างความหนาจากจุดกึ่งกลาง (Mid Plane Extrusion) 
4.6.6 การสร้างความหนาแบบปรับปลาย (Draft Extrusion) 
4.6.7 การสร้างความหนาแบบแยกสองทิศทาง (Dual Direction Extrusion) 
4.6.8 การสร้างความหนาเฉพาะเส้นร่าง (Thim Feature Extrusion) 
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4.6.9 การสร้างความหนาและผลึกรวมกับวัตถุ (Merge Extrusion) 
4.7 เทคนิคเสริมในการใช้งาน  (Advanced Techniques) 
 4.7.1 การเลือกวัตถุ 3 มิติ 

4.7.2 การซ่อนวัตถุ 3 มิติแบบเรียงลำดับก่อนหลัง 
4.7.3 การสร้างความหนาให้กับเส้นร่างหลายๆเส้น พร้อมกัน 

กิจกรรมการเรียนรู้ (ครั้งท่ี 9/18, ชั่วโมงที่ 57-63/126 ) 

ขั้นนำเข้าสู่บทเรียน (Warm up) 
28. ครูเปิดโปรแกรม SOLIDWORKS แสดงชิ้นงาน 3 มิติที่มีความซับซ้อน (เช่น ฝาครอบเครื่องจักร) และ

ถามผู้เรียนว่า  
- ถ้าเราต้องการสร้างรูทะลุหรือเพิ่มรายละเอียดบนผิวที่ไม่ใช่ระนาบหลัก (Front, Top, Right) 

เราจะทำอย่างไร 
29. ผู้เรียนแสดงความคิดเห็นและแลกเปลี่ยนประสบการณ์จากการเขียนแบบที่ผ่านมา 
30. ครูสรุปประเด็นปัญหาและนำเข้าสู่แนวคิดเรื่อง การสร้างระนาบใหม่ (New Plane) 
31. ครูนำตัวอย่างชิ้นงานจริง (เช่น ฝาปิดกล่อง, แผ่นยึดโยง) มาให้ผู้เรียนสังเกต 
32. ผู้เรียนวิเคราะห์และระบุว่าชิ้นงานมีรูทะลุ, ร่องติด, หรือลักษณะพิเศษอยู่ที่ตำแหน่งใด 
33. ครูและผู้เรียนร่วมกันอภิปรายว่า 

- จะสร้างลักษณะเหล่านี้ใน SOLIDWORKS ได้อย่างไร ถ้าไม่มีระนาบอ้างอิง 
34. ครูสรุปความสำคัญของการสร้างระนาบใหม่ในการออกแบบชิ้นงานจริง 

ขั้นการสอน/การนำเสนอ (Presentation) 
1. ครูอธิบายความแตกต่างระหว่าง "ระนาบหลัก" (Front, Top, Right) กับ "ระนาบใหม่" (New Plane) 
2. ผู้เรียนจดบันทึกและถามคำถามเพ่ือความเข้าใจ 
3. ครูใช้ภาพประกอบจากหนังสือ (รูปที่ 4.1) แสดงตำแหน่งระนาบอ้างอิงใน 3 มิติ 
4. ครูสาธิตบนจอโปรเจคเตอร์ 

- เลือกระนาบแบบ Top Plane → แสดงวิธีเลือกอย่างถูกต้อง 
5. ผู้เรียนดูและจดขั้นตอน พร้อมทดลองปฏิบัติตามบนเครื่องของตนเอง 
6. ครูสาธิต 

- คลิกเลือกใหม่ผ่าน Features > Command Manager → เลือก Extruded Boss/Base 
เพ่ือสร้างรูปทรงเสริมแบบ 3 มิติที่ข้ึนมา 

7. ครูสาธิต 
- จากนั้นคลิกคำสั่ง Reference Geometry > Plane (รูปที่ 4.2) 



182 
 

 
 

8. ครูสาธิตการคลิกเปิดบริเวณด้านใดด้านหนึ่งของวัตถุ 3 มิติที่ต้องการให้จุดอ้างอิงในการสร้างระนาบ
ใหม ่

9. ผู้เรียนสังเกตและจดบันทึกตำแหน่งที่เหมาะสม 
10. ครูสาธิตการกำหนดระยะห่างระหว่างจุดอ้างอิงกับระนาบใหม่ (รูปที่ 4.3) 

- กรณีต้องการสร้างระนาบใหม่ที่จะสร้างชิ ้นอีก 2 ระนาบ ซึ ่งระยะห่างของแต่ละระนาบ       
จะเพ่ิมข้ึนอีกเท่าตัวจากจุดอ้างอิง เช่น กำหนดที่ระนาบแรกไว้ที่ 20 ระนาบถัดไปจะห่างที่ 40 
เป็นต้น 

11. ครูสาธิตการใช้ Property Manager เพ่ือตรวจสอบและปรับแต่งระนาบใหม่ที่สร้างขึ้น (รูปที่ 4.4) 
12. ผู้เรียนฝึกเปิด-ปิด Property Manager และสังเกตการเปลี่ยนแปลงของระนาบ 
13. ครูอธิบาย 

- หากต้องการลบระนาบที่สร้างขึ้นมาใหม่ สามารถทำได้โดยคลิกที่ชื่อของตัวระนาบใหม่ใน 
Property Manager แล้วกดปุ่ม Delete บนแป้นพิมพ์ (Keyboard) 

14. ครูสรุปขั้นตอนการสร้างระนาบใหม่ทั้งหมด (ทบทวนจากรูปที่ 4.1 - 4.4) 
15. ผู้เรียนถามคำถามสงสัยและข้อผิดพลาดที่พบระหว่างสาธิต 
16. ครูตอบคำถามพร้อมยกตัวอย่างเพ่ิมเติมจากประสบการณ์จริง 
17. ผู้เรียนจดบันทึกสรุปและเตรียมพร้อมสำหรับการปฏิบัติ 

 

ขั้นฝึกฝน/ลงมือปฏิบัติ (Practice) 
1. ครใูห้ผู้เรียนทำใบงานเพ่ิมเติมที่ 3 
2. ผู้เรียนรับฟังคำอธิบาย อ่านใบงานและทำความเข้าใจใบงานที่ต้องทำ 
3. ผู้เรียนทำงานเป็นรายบุคคล โดยปฏิบัติตามข้ันตอน 
4. ครูเดินดูการทำงานและให้คำแนะนำ 
5. ครูเดินสังเกตการทำงาน ให้คำแนะนำและแก้ปัญหาเมื่อผู้เรียนติดขัด 
6. ผู้เรียนที่ทำเสร็จก่อนช่วยเพื่อนที่ยังทำไม่เสร็จ 
7. ผู้เรียนบันทึกไฟล์งานโดยใช้ชื่อตามท่ีใบงานกำหนด 

ขั้นประยุกต์ใช ้(Production)  
กิจกรรม Mini Project ออกแบบชิ้นงานที่มีระนาบหลายชั้น 
1. ครูแบ่งผู้เรียนเป็นกลุ่ม กลุ่มละ 3 - 4 คน 
2. ครูมอบหมายโจทย์ 

- ออกแบบฝาปิดกล่องพลาสติกท่ีมีร่องติดอยู่ภายใน 3 ร่อง โดยแต่ละร่องห่างกัน 15 มม. 
3. ผู้เรียนร่วมกันวางแผนขั้นตอนการสร้าง 

- กำหนดระนาบอ้างอิงหลัก 
- สร้างระนาบใหม่ 3 ระนาบโดยกำหนดระยะห่าง 15, 30, 45 มม. 
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- ใช้ระนาบเหล่านี้เป็นพื้นฐานในการสร้างร่องติด (Sketch + Extrude Cut) 
4. ผู้เรียนกลุ่มละ 1 คนปฏิบัติบนคอมพิวเตอร์ ขณะที่สมาชิกคนอ่ืนให้คำแนะนำและตรวจสอบ 
5. ครูเดินสังเกตและให้คำปรึกษาแก่แต่ละกลุ่ม 

ขั้นสรุป/ประเมินผล (Wrap up) 
1. ครูและผู้เรียนร่วมกันสรุปประเด็นสำคัญ 
2. ผู้เรียนฟังการสรุปและจดบันทึกสาระสำคัญ 
3. ครูถามคำถามทบทวนความรู้  
4. ผู้เรียนตอบคำถามทบทวน 
5. ผู้เรียนสอบถามข้อสงสัยที่ยังไม่เข้าใจ 
6. ครูแจ้งหัวข้อที่จะเรียนครั้งต่อไป 
7. ผู้เรียนเตรียมความพร้อมสำหรับบทเรียนต่อไป 

 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
  



184 
 

 
 

 

ใบงานเพิ่มเติม ที่ 3 หน่วยที่   4   .   
รหัสวิชา 20101 – 2029  ช ื ่อว ิชา งานเข ียนแบบเคร ื ่องกลด ้วย
คอมพิวเตอร์ (Computer-Aided Mechanical Drafting Job) 

สอนครั้งที ่ 9  .       

ชื่อหน่วยการเรียนรู้   ระบบ 3 มิติ และการสร้างชิ้นงาน 3 มิติด้วยการเพ่ิม
ความหนาในโปรแกรม SOLIDWORKS ทฤษฎี   3  ชม.  

ปฏิบัติ  18 ชม. ชื่อเรื่อง  ระบบ 3 มิติ และการสร้างชิ้นงาน 3 มิติด้วยการเพ่ิมความหนาในโปรแกรม 
SOLIDWORKS 

 

1.  ผลลัพธ์การเรียนรู้จากการปฏิบัติงาน 
 ผู้เรียนสามารถสร้างระนาบในรูปแบบต่างๆ และเพิ่มความหนาให้กับเส้นร่าง 2 มิติ เพื่อสร้างเป็นชิ้นงาน 3 
มิติ ในโปรแกรม SOLIDWORKS โดยใช้เทคนิคการสร้างความหนาที่เหมาะสมกับลักษณะของชิ้นงาน 
 

2.  อ้างอิงมาตรฐาน/เชื่อมโยงกลุ่มอาชีพ 
 - 
 

3. สมรรถนะการปฏิบัติงาน 
 4.1  ผู้เรียนสามารถระบุและเข้าถึงคำสั่ง 
 4.2  ผู้เรียนสามารถกำหนดค่าพารามิเตอร์ได้อย่างถูกต้องและแม่นยำ 
 4.3  ผู้เรียนสามารถใช้ระนาบที่สร้างขึ้นเพ่ือสร้าง/แก้ไข/ตัดลักษณะชิ้นงานถัดไปได้อย่างมีประสิทธิภาพ 

 

4.  จุดประสงค์เชิงพฤติกรรม  
ด้านความรู้ (Knowledge) 
1. อธิบายเกี่ยวกับระบบ 3 มิติ และหลักการสร้างระนาบในรูปแบบต่าง ๆ เพื่อใช้เป็นพื้นฐานในการสรา้ง

ชิ้นงาน 3 มิติได้ 
ด้านทักษะ/กระบวนการ  (Process) 
1. ใช้คำสั่งและเครื่องมือในการสร้างระนาบและเพ่ิมความหนาให้กับชิ้นงาน 2 มิติ เพ่ือสร้างเป็นชิ้นงาน 3 

มิติในโปรแกรม SOLIDWORKS ได ้
2. แก้ไขปัญหาและใช้เทคนิคข้ันสูงในการสร้างและจัดการชิ้นงาน 3 มิติเพ่ือเพ่ิมประสิทธิภาพในการทำงาน

ได ้
คุณลักษณะท่ีพึงประสงค์ (Attitude)   
1. มีเจตคติและกิจนิสัยที่ดีในการปฏิบัติงานด้วยความละเอียด รอบคอบ และมีความคิดสร้างสรรค์ในการ

ออกแบบชิ้นงาน 3 มิติ 
ด้านการประยุกต์ใช้ (Apply)  
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1. ประยุกต์ใช้เทคนิคการเพ่ิมความหนาในรูปแบบต่าง ๆ เพื่อสร้างชิ้นงาน 3 มิติที่มีความซับซ้อนและตรง
ตามความต้องการได้ 

5.  เครื่องมือ วัสดุ และอุปกรณ์ 
1. เครื่องคอมพิวเตอร์ พร้อมระบบปฏิบัติการ Windows 10 ขึ้นไป พร้อม จอมอนิเตอร์ 
2. เครื่องคอมพิวเตอร์ ที่ติดตั้ง Software SOLIDWORKS 
3. เมาส์ ที่มี 3 ปุ่ม (ซ้าย ขวา และ ลูกกลิ้ง) 
4. คีย์บอร์ดคอมพิวเตอร์ 

6.  คำแนะนำ/ข้อควรระวัง 
1. ทำตามขั้นตอนที่แนะนำในใบงาน พยายามอย่าข้ามขั้นตอนใดขั้นตอนหนึ่ง อาจทำให้โปรแกรมไม่

สามารถประมวลผลได้ 
2. ฝึกทำ และ ทบทวน การทำงานของเครื่องมือต่างๆ บ่อยครั้ง เพ่ือให้เกิดความคล่องแคล่วและชำนาญ 

7.  ขั้นตอนการปฏิบัติงาน 
การสร้างระนาบอ้างอิงและชิ้นงานซับซ้อน (SolidWorks Reference Plane Assignment) 
ขั้นตอนที่ 1 การสร้างชิ้นงานฐาน (Base Feature) 
 1. เปิดไฟล์ Part ใหม่ในโปรแกรม SolidWorks 
 2. สร้าง สเก็ตช์ (Sketch) บนระนาบ Top Plane (ระนาบบน) 
 3. วาดสี่เหลี่ยมจัตุรัสขนาด 100 x 100 mm 
 4. ใช้คำสั่ง Extrude Boss/Base (เพ่ิมเนื้อชิ้นงาน) ให้มีความหนา 50 mm 
ขั้นตอนที่ 2 การสร้างระนาบแบบออฟเซ็ต (Offset Plane) 
 1. ไปที่แท็บ Features (คุณลักษณะ) 
 2. คลิก Reference Geometry (เรขาคณิตอ้างอิง) แล้วเลือก Plane (ระนาบ) 
 3. ในช่อง First Reference (การอ้างอิงแรก) ให้คลิกเลือก พ้ืนผิวด้านบนสุด ของชิ้นงาน Extrude ที่คุณ 
   สร้างไว้ 
 4. ในส่วน Parameters (พารามิเตอร์) ให้เลือก Offset (ระยะเยื้อง) และกำหนดระยะเป็น 25 mm 
 5. ตรวจสอบให้แน่ใจว่าลูกศรชี้ขึ้น (หากชี้ลงให้คลิก Flip offset เพ่ือกลับทิศทาง) 
 6. คลิก OK เพ่ือสร้าง Plane1 
 7. ใช้ Plane1 ในการสร้างสเก็ตช์วงกลมที่จุดศูนย์กลางของระนาบวงกลม และ Extrude ให้มีความหนา  
   15 mm 
ขั้นตอนที่ 3  การสร้างระนาบกึ่งกลาง (Mid-Plane) 
 1. คลิกท่ีคำสั่ง Plane อีกครั้ง 
 2. ในช่อง First Reference ให้เลือก ผิวด้านหน้า (Front Face) ของชิ้นงานฐาน 



186 
 

 
 

 3. ในช่อง Second Reference (การอ้างอิงที่สอง) ให้เลือก ผิวด้านหลัง (Back Face) ของชิ้นงานฐาน 
 4. โปรแกรมจะสร้างระนาบที่อยู่ตรงกลางระหว่างสองผิวโดยอัตโนมัติ (เป็นระนาบกึ่งกลาง) 
 5. คลิก OK เพ่ือสร้าง Plane2 
 6. ทดสอบการใช้งาน 

- สร้าง รู (Hole) หรือ Extruded Cut เล็กๆ บนผิวด้านหน้าของชิ้นงาน 
- ใช ้คำส ั ่ง Mirror (สะท้อน) โดยเล ือก Plane2 เป ็นระนาบสำหรับการสะท้อน (Mirror 

Face/Plane) และเลือกลักษณะที่คุณเพิ่งสร้างเป็นคุณลักษณะที่จะสะท้อน (Features to 
Mirror) 

ขั้นตอนที่ 4  การสร้างระนาบทำมุมเอียง (Angle/Inclined Plane) 
 1. คลิกท่ีคำสั่ง Plane 
 2. ในช่อง First Reference ให้เลือก ขอบ (Edge) ด้านข้างของชิ้นงานฐาน (เช่น ขอบบนด้านขวา) 
 3. ในช่อง Second Reference ให้เลือก พ้ืนผิว ที่อยู่ติดกับขอบนั้น (เช่น ผิวด้านข้างขวา) 
 4. ในส่วน Parameters ให้เลอืก Angle (มุม) และกำหนดค่าเป็น 45 องศา 
 5. คลิก Flip หากต้องการเปลี่ยนทิศทางของระนาบ 
 6. คลิก OK เพ่ือสร้าง Plane3 
 7. ทดสอบการใช้งาน 

- สร้างสเก็ตช์บน Plane3 
- ใช้คำสั่ง Extruded Cut ในทิศทาง Normal To Profile (ตั้งฉากกับโปรไฟล์) เพื่อตัดเฉือนมุม

ของชิ้นงานฐานตามแนว 45 องศา 

8.  สรุปและวิจารณ์ผล 
8.1 ชิ้นงานควรมีลักษณะท่ีซับซ้อนขึ้นโดยใช้ระนาบอ้างอิง 3 แบบ 

- Plane1  Offset (ระยะเยื้อง) 
- Plane2  Mid-Plane (ระนาบกึ่งกลาง) 
- Plane3  Angle (ทำมุม) 

8.2 ปัญหาที่พบและแนวทางแก้ไข 

ปัญหาที่พบระหว่างปฏิบัติงาน วิธีแก้ไขท่ีใช้ 
1. 

 

2. 
 

3. 
 

8.3 ข้อเสนอแนะ/ความคิดเห็น กรุณาเขียนความคิดเห็นเกี่ยวกับการปฏิบัติงานในครั้งนี้ 
- สิ่งที่ได้เรียนรู้ใหม่………………………………………………………………………………………………………………. 
- สิ่งที่ยากที่สุด…………………………………………………………………………………………………………………….. 
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- สิ่งที่อยากเรียนรู้เพิ่มเติม…………………………………………………………………………………………………….. 

9.  การประเมินผล 

รายการประเมิน รายละเอียด คะแนน (10) 
Plane1 (Offset) สร้างระนาบที่ระยะเยื้อง (Offset) 25 mm จากผิวที่กำหนดได้ถูกต้อง  

Plane2 (Mid-
Plane) 

สร้างระนาบกึ่งกลาง (Mid-Plane) ระหว่างสองผิวที่ขนานกันได้ถูกต้อง  

Plane3 (Angle) 
สร้างระนาบทำมุม (Angle) 45 องศา โดยอ้างอิงจากขอบและผิวที่
ถูกต้อง 

 

การตั้งชื่อ 
ตั้งชื ่อระนาบ (เช่น Plane1, Plane2, Plane3) หรือเปลี่ยนชื่อให้สื่อ
ความหมายได้ชัดเจน 

 

 
10.  หนังสืออ้างอิง /หนังสือค้นคว้าเพิ่มเติม 

หนังสือเรียนวิชา งานเขียนแบบเครื่องกลด้วยคอมพิวเตอร์ (Computer-Aided Mechanical Drafting 
Job) รหัสวิชา 20101-2029 หน่วยการเรียนรู้ที่ 4 เรื่อง ระบบ 3 มิติ และการสร้างชิ้นงาน 3 มิติด้วยการเพิ่มความ
หนาในโปรแกรม SOLIDWORKS ของบริษัท สำนักพิมพ์เอมพันธ์ จำกัด 
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กิจกรรมการเรียนรู้ (ครั้งท่ี 10/18, ชั่วโมงท่ี 64–7/126) 

ขั้นนำเข้าสู่บทเรียน (Warm up) 
24. ครูเปิดไฟล์ SOLIDWORKS ที่สร้างระนาบใหม่จากบทเรียนที่ผ่านมา (Parallel Plane) และถามผู้เรียน

ว่า 
- นอกจากการสร้างระนาบแบบขนานแล้ว เรายังสามารถสร้างระนาบในรูปแบบอื่นได้อีกหรือไม่ 

25. ผู้เรียนแสดงความคิดเห็นและยกตัวอย่างจากประสบการณ์หรือการสังเกตชิ้นงานจริง 
26. ครูนำเสนอภาพชิ้นงานที่มีรูทะลุเอียง, ผิวตัด, หรือลักษณะซับซ้อน และถามว่า  

- จะใช้ระนาบแบบใดในการสร้างลักษณะเหล่านี้ 
27. ผู้เรียนและครูร่วมกันระดมสมองเก่ียวกับความจำเป็นของระนาบหลากหลายรูปแบบ 
28. ครูนำเสนอ Case Study 

- ถ้าต้องการสร้างรูทะลุที่มีมุม 45 องศากับผิวบนของชิ้นงาน จะทำอย่างไร 
29. ผู้เรียนแบ่งกลุ่มย่อย 2-3 คน อภิปรายและนำเสนอแนวคิดการแก้ปัญหา  
30. แต่ละกลุ่มแชร์ไอเดียสั้นๆ 

- ใช้ระนาบเอียง, ใช้ระนาบตั้งฉาก, กำหนดมุม 
31. ครูสรุป 

- วันนี้เราจะเรียนรู้การสร้างระนาบ 5 รูปแบบ ได้แก่ Parallel, Perpendicular, Coincident, 
At Angle, และ Mid Plane และวิธีนำไปใช้งานจริง 
 

ขั้นการสอน/การนำเสนอ (Presentation) 
1. ครูแบ่งผู้เรียนเป็น 5 กลุ่ม แต่ละกลุ่มรับผิดชอบศึกษาระนาบ 1 รูปแบบ ได้แก่ 

- กลุ่ม 1  Parallel Plane (รูปที่ 4.5) 
- กลุ่ม 2  Perpendicular Plane (รูปที่ 4.6-4.8) 
- กลุ่ม 3  Coincident Plane (รูปที่ 4.9) 
- กลุ่ม 4  At Angle Plane (รูปที่ 4.10) 
- กลุ่ม 5  Mid Plane (รูปที่ 4.11) 

2. ผู ้เรียนในกลุ ่มศึกษาเนื ้อหาจากหนังสือ พร้อมทดลองปฏิบัติบนคอมพิวเตอร์ตามหัวข้อที ่ได้รับ
มอบหมาย 

3. แต่ละกลุ่มต้องเตรียม 
- นิยาม 
- ขั้นตอนการสร้าง 
- ตัวอย่างการใช้งาน 
- และข้อควรระวัง 

4. ครูจัดกลุ่มใหม่ โดยให้แต่ละกลุ่มมีตัวแทนจากการบ่งกลุ่มใน ข้อที่ 9 (กลุ่มละ 5 คน) 
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5. ผู้เรียนแต่ละคนสอนเพื่อนในกลุ่มเก่ียวกับระนาบที่ตนเองรับผิดชอบ 
6. ผู้เรียนฟัง ถามคำถาม และจดบันทึกข้อมูล 
7. ครูเดินสังเกตและให้คำแนะนำแต่ละกลุ่ม 
8. ครูสุ่มเรียกตัวแทนแต่ละกลุ่มนำเสนอสรุประนาบแต่ละประเภทต่อชั้นเรียน  
9. ผู้เรียนคนอ่ืนเพิ่มเติมหรือแก้ไขข้อมูล 
10. ครูสรุปความแตกต่างและความเหมือนของระนาบทั้ง 5 แบบด้วยตารางเปรียบเทียบ 
11. ครูอธิบาย 

- หลังจากสร้างระนาบใหม่แล้ว เราสามารถใช้ระนาบนั้นเป็นพื้นฐานในการสร้างวัตถุ 3 มิติได้ 
12. ผู้เรียนฟังและสังเกตความเชื่อมโยงระหว่างระนาบกับการสร้าง Feature 
13. ครูแสดงภาพตัวอย่าง การสร้างรูทะลุบนระนาบเอียง, การสร้างซี่โครงบนระนาบขนาน 
14. ครูสาธิตตามรูปที่ 4.12 - 4.13 

- คลิกเลือกระนาบที่สร้างข้ึนมาใหม่ (ระนาบสีฟ้าปรากฏ) 
- คลิกท่ี Sketch เพ่ือเข้าโหมดวาดภาพร่างบนระนาบใหม่ 
- คลิกเครื่องมือ Circle เพ่ือวาดวงกลมบนระนาบใหม่ 
- เมื่อเขียนวงกลมแล้ว คลิกเลือกแท็บ Features 
- คลิกคำสั่ง Extruded Boss/Base เพ่ือเปลี่ยนเส้นร่างวงกลมเป็นรูปทรง 3 มิติในระนาบใหม่ 

15. ผู้เรียนสังเกตทีละขั้นตอนและจดบันทึกสำคัญ 
16. ครูเน้นย้ำ จุดสำคัญคือต้องเลือกระนาบที่ถูกต้องก่อน Sketch เสมอ 
17. ครูสาธิตตามรูปที่ 4.14 

- คลิกเลือกระนาบที่ต้องการแก้ไข (ในกล่อง Feature Tree หรือบนชิ้นงาน) 
- คลิกเมนู Property Manager หรือคลิกคำสั่งปรากฏขึ้นมาท่ีชื่อระนาบในส่วนของการแสดงผล 
- เมื่อคลิกเลือกระนาบใหม่แล้ว จะมีทูลบาร์คำสั่งปรากฏขึ้นมา ให้คลิกเลือกคำสั่ง Edit Feature  

18. ผู้เรียนสังเกตการเปลี่ยนแปลงพารามิเตอร์ เช่น ระยะห่าง, มุมเอียง, ตำแหน่งอ้างอิง 
19. ครูสาธิตตามรูปที่ 4.15 การปรับเปลี่ยนคุณสมบัติของระนาบในโปรแกรม SOLIDWORKS โดยสามารถ

ทำได้โดยเลือกคำสั่งหน้าต่างแก้ไขคุณสมบัติ และแก้ไขได้ในหน้าต่างนี้จะส่งผลให้วัตถุที่สร้างบนระนาบ
นั้นเคลื่อนที่ตามที่ตำหนดไหม้โดยอัตโนมัติ  

20. ผู้เรียนสังเกตว่าการเปลี่ยนแปลงระนาบส่งผลต่อ Feature ที่อ้างอิงระนาบนั้นอย่างไร 
21. ครูตอบคำถามและแก้ไขข้อสงสัย 

ขั้นฝึกฝน/ลงมือปฏิบัติ (Practice) 
1. ครใูห้ผู้เรียนทำใบงานที่ 4.1 
2. ผู้เรียนรับฟังคำอธิบาย อ่านใบงานและทำความเข้าใจตัวอย่างชิ้นงานที่ต้องสร้าง 
3. ผู้เรียนทำงานเป็นรายบุคคล โดยปฏิบัติตามข้ันตอน 
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4. ครูเดินดูการทำงานและให้คำแนะนำ 
5. ครูเดินสังเกตการทำงาน ให้คำแนะนำและแก้ปัญหาเมื่อผู้เรียนติดขัด 
6. ผู้เรียนที่ทำเสร็จก่อนช่วยเพื่อนที่ยังทำไม่เสร็จ 
7. ผู้เรียนบันทึกไฟล์งานโดยใช้ชื่อตามท่ีใบงานกำหนด 

ขั้นประยุกต์ใช ้(Production)  
กิจกรรม ออกแบบขาตั้งกล้อง Mini 
1. ครใูห้โจทย์ ออกแบบขาตั้งกล้องแบบพับได้ โดยมีข้อกำหนด ดังนี้ 

- ขาตั้ง 3 แฉก แต่ละแฉกเอียง 30 องศาจากแนวตั้ง 
- มีแท่นวางกล้องด้านบนรูปหกเหลี่ยม 
- ความสูง 150 mm เมื่อขยาย, 50 mm เมื่อพับ 

2. ครูแบ่งผู้เรียนเป็นกลุ่ม กลุ่มละ 3-4 คน 
3. แต่ละกลุ่มวางแผนร่วมกันว่า จะใช้ระนาบแบบใด ในการสร้างแต่ละส่วน 

- แท่นวางกล้อง → Top Plane 
- ขาแฉกที่ 1 → At Angle Plane (30°) 
- ขาแฉกที่ 2-3 → At Angle Plane + หมุน 120° และ 240° 

4. ผู้เรียนกลุ่มละ 1 คนปฏิบัติบนคอมพิวเตอร์ ขณะสมาชิกคนอื่นช่วยคิดและแนะนำ 
5. ครูเดินสังเกตและให้คำแนะนำเฉพาะกลุ่มท่ีติดขัด 
6. แต่ละกลุ่มบันทึกผลงาน (ขาตั้งกล้อง) ลงในไฟล์และแสดงบนจอคอมพิวเตอร์ 
7. ผู้เรียนเดินชมผลงานของทุกกลุ่ม 
8. แต่ละกลุ่มจดข้อเสนอแนะจากเพ่ือนๆ โดยใช้ Sticky Notes หรือกระดาษ 
9. ผู้เรียนตัวแทน กลุ่มละ 1 คนนำเสนอสั้นๆ ดังนี้ 

- ระนาบแบบใด ใช้สร้างส่วนใด 
- ปัญหาที่พบและวิธีแก้ไข 
- สิ่งที่ภูมิใจที่สุด 

10. ครูชื่นชมความคิดสร้างสรรค์และให้คะแนน 

ขั้นสรุป/ประเมินผล (Wrap up) 
1. ครูและผู้เรียนร่วมกันสรุปประเด็นสำคัญ 
2. ผู้เรียนฟังการสรุปและจดบันทึกสาระสำคัญ 
3. ครูถามคำถามทบทวนความรู้  
4. ผู้เรียนตอบคำถามทบทวน 
5. ผู้เรียนสอบถามข้อสงสัยที่ยังไม่เข้าใจ 
6. ครูแจ้งหัวข้อที่จะเรียนครั้งต่อไป 
7. ผู้เรียนเตรียมความพร้อมสำหรับบทเรียนต่อไป 
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กิจกรรมการเรียนรู้ (ครั้งท่ี 11/18, ชั่วโมงท่ี 71-77/126) 

ขั้นนำเข้าสู่บทเรียน (Warm up) 
15. ครถูามคำถามทบทวนเนื้อหาที่ผ่านมา ได้แก่ 

- การสร้างระนาบ 5 แบบ (Parallel, Perpendicular, Coincident, At Angle, Mid Plane) 
- การสร้างวัตถุในระนาบใหม่ 
- การแก้ไขและเปลี่ยนแปลงระนาบ 

16. ผู้เรียนช่วยกันตอบคำถามที่ครูถาม 
17. ครูประกาศผู้ชนะและให้รางวัล (คะแนนพิเศษ 5%) 
18. ผู้เรียนและครูร่วมกันทบทวนคำตอบที่ผิดพลาด 
19. ครูแสดงชิ้นงานตัวอย่าง 3 ชิ้นบนจอโปรเจคเตอร์ ได้แก่ 

- กล่องใส่อุปกรณ์  ผนังบาง, โปร่งแสง 
- ช่องรางน้ำ  เอียง 45 องศา, ผิวเรียบ 
- ชิ้นส่วนประกอบซับซ้อน  มีหลายวัตถุรวมกัน 

20. ครูถามผู้เรียน 
- สังเกตชิ้นงานแต่ละชิ้น มีลักษณะพิเศษอะไรบ้าง  จะสร้างด้วยเทคนิคแบบใด 

21. ผู้เรียนแบ่งกลุ่ม กลุ่มละ 3 - 4 คน อภิปรายและบันทึกความคิดเห็น 
22. ตัวแทนแต่ละกลุ่มนำเสนอ 

- กล่องใส่อุปกรณ์ →  ผนังบาง ต้องใช้ Thin Feature 

- ช่องรางน้ำ →  เอียง ต้องปรับมุม Draft Extrusion 

- ชิ้นส่วนซับซ้อน →  หลายชิ้นรวมกัน ต้อง Merge 
23. ครูสรุป 

- วันนี้เราจะเรียนรู้เทคนิคขั ้นสูงที่ทำให้สร้างชิ้นงานซับซ้อนได้ง่ายและรวดเร็วขึ้น รวมถึง       
การปรับแต่งการแสดงผลให้สวยงาม 

ขั้นการสอน/การนำเสนอ (Presentation) 
1. ครูถาม 

- เมื่อสร้างระนาบหลายๆ ระนาบ จอภาพเต็มไปด้วยเส้นสีเขียว ทำให้งง หรือไม่ 
2. ผู้เรียนแสดงความคิดเห็นจากประสบการณ ์
3. ครอูธิบายว่า เราสามารถปรับแต่งสี, ความโปร่งใส, การแสดง/ซ่อนได้ เพ่ือให้ทำงานสะดวกข้ึน 
4. ครูสาธิตตามรูปที่ 4.16 

- คลิกที่เมนู Tools > Options... ที่หน้าต่าง Properties จะปรากฏขึ้นมา ให้คลิกไปที่แถบ 
Document Properties  

- คลิกท่ีค่าเลือก Plane Display (การแสดงระนาบ) 
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- คลิกปุ่ม Front Face Color... เพ่ือเลือกสีสำหรับแสดงในระนาบด้านหน้า 
- คลิกปุ่ม Back Face color... เพ่ือเลือกสีสำหรับแสดงในระนาบด้านหลัง 
- ที่สไลด์บาร์ Transparency  เลือกความโปร่งใสของระนาบ ค่าบาตรฐานคือ 100% ซึ่งจะทำ

ให้ระนาบโปร่งใสไม่เห็นสีด้านหน้าและด้านหลัง 
- ที่ Intersections เป็นส่วนกำหนดค่าแสดงเส้นเปรอะ เมื่อระนาบใหม่ตัดผ่านกันโดยมีส่วนทับ

กัน 
- Show Intersections กำหนดให้แสดงเส้นประ 
- Line Color... กำหนดสีของเส้นประ 

5. ผู้เรียนสังเกตการเปลี่ยนแปลงแต่ละขั้นตอนและจดบันทึก 
6. ครูเน้นย้ำ ปรับ Transparency เป็น 50% จะช่วยให้มองเห็นชิ้นงานด้านหลังได้ชัดเจน 
7. ครูแบ่งผู้เรียนเป็น 3 กลุ่มใหญ่ (Station A, B, C) โดยแต่ละ Station มีเนื้อหา 3 เทคนิค  
8. ผู้เรียนหมุนเวียนผ่านทั้ง 3 Stations เพ่ือเรียนรู้ครบทั้ง 9 เทคนิค 

Station A  เทคนิคพื้นฐาน  
Angular Reference Extrusion 

9. ครูสาธิตการสร้างความหนาแบบอ้างอิงจากมุม (รูปที่ 4.18-4.19) 
- สร้างสี่เหลี่ยม 3 มิติขึ้นมา 1 รูป และสร้างเส้นร่างวงกลมขึ้นมาอีก 1 วง 
- คลิกกลับมาท่ีหน้าต่าง Features 
- คลิกคำสั่ง Extruded Boss/Base เพื่อสร้างความหนาให้เส้นวงกลมที่ From ตั้งค่า Sketch 

Plane เป็นแบบ Vertex เพ่ือกำหนดจุดเริ่มต้นในการสร้างวัตถุ 3 มิติจากมุม 
- ที่ Direction 1 ตั ้งค่าจาก Blind เป็นแบบ Up to Vertex แล้วเลือกมุมที ่ต้องการให้เป็น

จุดสิ้นสุดความหนาของวัตถุ 3 มิติที่จะสร้างข้ึน 
10. ผู้เรียนจดบันทึกและทดลองตาม (พร้อมกัน 3-4 คน/คอมพิวเตอร์) 

Surface Reference Extrusion  
1. ครูสาธิตการสร้างความหนาโดยอ้างอิงจากพ้ืนผิว (รูปที่ 4.20 - 4.21) 

- สร้างสี่เหลี่ยม 3 มิติขึ ้นมา 1 รูป และสร้างเส้นร่างวงกลมขึ้นมาอีก 1 วง แล้วคลิกที่แถบ 
Features แล้วคลิกเลือกคำสั่ง Extruded Boss/Base 

- ที่หน้าต่าง Boss-Extrude คลิกท่ี DropdownBox ตึง จาก Blind เป็นแบบ Up to Surface 
- คลิกเลือกพื้นผิวของวัตถุ 3 มิติที ่ต้องการจะนำไปใช้กำหนดความหนาของวงกลม 3 มิติ         

ให้ทำกับความสูงของพ้ืนผิวนั้น 
2. ผู้เรียนสังเกตความแตกต่างจาก Angular Reference 

Distance Plane/Surface Extrusion 
1. ครูสาธิตการกำหนดความหนาจากระยะห่างระนาบหรือพ้ืนผิว (รูปที่ 4.22-4.24) 
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- สร้างสี่เหลี่ยม 3 มิติขึ ้นมา 1 รูป และสร้างเส้นร่างวงกลมขึ้นมาอีก 1 วง แล้วคลิกที่แถบ 
Features เพ่ือเรียกใช้คำสั่ง Extruded Boss/Base โดยให้ตั้งค่าท่ีหน้าต่าง Boss-Extrude ใน
ดรอปดาวบล็อคของส่วน From ให้เปลี่ยนจากแนบ Sketch Plane เป็น Offset  

- ตั้งค่าระยะห่างที่ Enter Offset Value โดยเส้นร่างความหนาของวงกลมลอยขึ้นจากฐานตาม
ระยะห่างที่ได้ตั้งเอาไว้ 

- ที่ Direction 1 คลิกที ่DropdownBox จาก Blind เป็นแบบ Offset From Surface 
- คลิกเลือกพ้ืนผิวของวัตถุ 3 มิติที่ต้องการใช้เป็นตัวกำหนดความหนาของจุดสิ้นสุด 
- กำหนดระยะห่างระหว่างจุดสิ้นสุดความหนาของวงกลมที่จะสร้างกับพ้ืนผิวที่เลือกไว้ 
- ปกติจากจุดเริ่มต้นความหนาอยู่ในด้านตรงข้ามกับพื้นผิวที่เลือกไว้ ในขั้นตอนที่ 6 จะเป็นการ

ลดความหนาของจุดส้น สุด ซึ ่งหากต้องการทำในทางตรงข้าม คือเพิ ่มความหนาต้อง         

คลิก  ✓ ที่ตัวเลือก Reverse offset 
2. ผู้เรียนฝึกปฏิบัติและเปรียบเทียบกับเทคนิคก่อนหน้า 

Station B  เทคนิคขั้นกลาง  
End at Object Extrusion 

3. ครูสาธิตการกำหนดความหนาไปยังวัตถุอ่ืน (รูปที่ 4.25 - 4.26) 
- ให้สร้างวัตถุขึ้นมา 3 ชิ้นคือ สี่เหลี่ยม 3 มิติ โดยตำแหน่งอยู่ล่างสุด 
- วงกลม 3 มิติ อยู่กลาง และวาดสี่เหลี่ยมอยู่บนพื้นผิวส่วนกลม 
- ใช้คำสั ่ง Extruded Boss/Base โดยตั ้งค่าที ่หน้าต่าง Boss-Extrude ในดรอปดาวบล็อค     

จาก Blind เป็น Up To Body 
- คลิกเลือกวัตถุ 3 มิติ ที่ต้องการกำหนดความหนาของเส้นสี่เหลี่ยม ตามตัวอย่าง ให้คลิกเลือก

สี่เหลี่ยม 3 มิติที่ อยู่ด้านล่างสุด จะมีเส้นร่าง 3 มิติ ของสี่เหลี่ยมที่อยู่ด้านบนจนลากยาวไป
จนถึงพ้ืนถ้วยของสี่เหลี่ยม 3 มิติด้านล่าง 

4. ผู้เรียนสังเกตการเปลี่ยนแปลงและทดลองปฏิบัติ 
Mid-Plane Extrusion  

1. ครูสาธิตการสร้างความหนาจากจุดกึ่งกลาง (รูปที่ 4.27) 
- สร้างเส้นร่างสี ่เหลี ่ยมขึ ้นมา และใช้คำสั ่ง Extruded Boss/Base โดยตั ้งค่าที ่หน้าต่าง       

Boss-Extrude ในดรอปดาวบล็อค จาก Blind เป็นแบบ Mid Plane 
- ที่ Depth ตั้งค่าความหนาที่จะสร้างจากจุดกึ่งกลาง 

2. ครูอธิบาย 
- เทคนิคนี้ทำให้ความหนาแบ่งเท่าๆ กัน 2 ด้าน เหมาะกับชิ้นงานที่ต้องการความสมดุล เช่น    

ฝาปิดกล่อง, ผนังแบ่งช่อง 
Draft Extrusion  
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1. ครูสาธิตการสร้างความหนาแบบปรับปลาย (รูปที่ 4.28 - 4.29) 
- สร้างเส ้นร่างสี ่ เหลี ่ยมขึ ้นมาและใช้คำสั ่ง Extruded Boss/Base โดยตั ้งค่าที ่หน้าต่าง        

Boss-Extrude คล ิกท ี ่ ไอคอน Draft On/Off ท ี ่ อย ู ่ ในส ่ วนของ Direction 1 จากนั้น            
ป้อนค่าการเอียงของเส้นความหนา 

- หากต้องการให้เส้นความหนาเอียงออกด้านนอก ทำคลิก ✓ ที่ตัวเลือก Draft Outward 
2. ครูเน้น  Draft มักใช้กับแม่พิมพ์ฉีดพลาสติก เพราะช่วยให้ถอดชิ้นงานออกจากแม่พิมพ์ได้ง่าย 

Station C  เทคนิคขั้นสูง + Advanced Techniques  
Dual Direction Extrusion  

3. ครูสาธิตการสร้างความหนาแบบแยกสองทิศทาง (รูปที่ 4.30 - 4.31) 
- สร้างเส้นร่างสี่เหลี่ยมขึ้นมาและใช้คำสั่ง Extruded Boss/Base สร้างความหนาตามปกติ

จากนั้นคลิก ✓ ที่ตัวเลือก Direction 2 
- เส้นความหนาจะปรากฏขึ ้นมาในทิศทางตรงข้าม สามารถตั ้งค่าความหนาได้ตามปกติ         

แต่การสร้างความหนานี้จะปรากฏขึ้นในทิศทางตรงข้ามแทน 
4. ผู้เรียนทดลองปรับค่าทิศทางท้ัง 2 และสังเกตผลลัพธ์ 

Thin Feature Extrusion  
1. ครูสาธิตการสร้างความหนาเฉพาะเส้นร่าง (รูปที่ 4.32) 

- สร้างเส ้นร่างสี ่ เหลี ่ยมขึ ้นมา และใช้คำสั ่ง Extruded Boss/Base คลิก ✓ ที ่ต ัวเล ือก        
Thin Feature 

- กำหนดความหนาที่จะสร้างขึ้นในเส้นร่าง 
- ที่ตัวเลือก Cap ends จะเป็นตัวเลือกสำหรับสร้างแผ่นความหนาปิดพื้นที่ภายในเส้นร่างไม่ให้

ทะลุออกมาด้านนอก (คล้ายการสร้างฝาครอบปิดส่วนที่กลวงเอาไว้) 
2. ครูเน้น Thin Feature เหมาะกับการสร้างผนัง, กล่อง, ท่อ โดยไม่ต้องวาดเส้น 2 รอบ 

Merge Extrusion + Advanced Techniques 
1. ครูสาธิตการสร้างความหนาและผนึกรวมกับวัตถุ (รูปที่ 4.33 - 4.34) 

- สร้างวัตถุ 3 มิติขึ้นมาหนึ่งชิ้น จากนั้นคลิกไปที่ Sketch แล้วสร้างเส้นร่างข้อนทับกับวัตถุ      
3 มิต ิเดิม 

- คลิก ✓ ที่ตัวเลือก Merge Result วัตถุ 3 มิติที ่สร้างขึ้นมาใหม่จะผนึกรวมกับวัตถุ 3 มิติ     
เดิมที่ชื่อนทับกันอยู่ 

2. ครูสาธิตเทคนิคเสริม (รูปที่ 4.35 - 4.43) 
- การเลือกวัตถุ 3 มิติ  กดปุ่ม Ctrl ค้างไว้ แล้วคลิกเลือกเฉพาะบางชื่อได้ 
- การซ่อนวัตถุ 3 มิติแบบเรียงลำดับก่อนหลัง ซ่อนวัตถใุห้เห็นส่วนที่ต้องการทำงาน 
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- การสร้างความหนาให้กับเส้นร่างหลาย ๆ เส้นพร้อมกัน  ใช้ Contour Select Tool เลือก
หลาย Sketch พร้อมกัน 

3. ผู้เรียนฝึกปฏิบัติเทคนิคทั้ง 4 แบบ 
 

ขั้นฝึกฝน/ลงมือปฏิบัติ (Practice) 
1. ครใูห้ผู้เรียนทำใบงานที่ 4.2 
2. ผู้เรียนรับฟังคำอธิบาย อ่านใบงานและทำความเข้าใจตัวอย่างชิ้นงานที่ต้องสร้าง 
3. ผู้เรียนทำงานเป็นรายบุคคล โดยปฏิบัติตามข้ันตอน 
4. ครูเดินดูการทำงานและให้คำแนะนำ 
5. ครูเดินสังเกตการทำงาน ให้คำแนะนำและแก้ปัญหาเมื่อผู้เรียนติดขัด 
6. ผู้เรียนที่ทำเสร็จก่อนช่วยเพื่อนที่ยังทำไม่เสร็จ 
7. ผู้เรียนบันทึกไฟล์งานโดยใช้ชื่อตามท่ีใบงานกำหนด 
 

ขั้นประยุกต์ใช ้(Production)  
กิจกรรม ออกแบบภาชนะใส่ของใช้ส่วนตัว 
1. ครูให้โจทย์ ออกแบบภาชนะใส่ของใช้ส่วนตัว (กล่องใส่เครื ่องสำอาง , ที่ใส่ปากกา, ถาดวางแก้ว)      

โดยต้องใช้เทคนิคข้ันสูงอย่างน้อย 3 เทคนิค มีข้อกำหนด ดังนี้ 
- ใช้ Thin Feature สร้างผนัง (ความหนา 1.5 - 3 mm) 
- ใช้ Draft Extrusion ปรับมุม (10 - 20 องศา) 
- ใช้ Merge หรือ Dual Direction สร้างลักษณะพิเศษ 
- ขนาด  กว้างไม่เกิน 150 mm, ยาวไม่เกิน 200 mm, สูงไม่เกิน 100 mm 

2. ครใูห้ผู้เรียนจับคู่ 
3. ผู้เรียนแต่ละคู่ร่วมกันวางแผนออกแบบ 

- กำหนดลักษณะภาชนะ (รูปทรง, ขนาด, จำนวนช่อง) 
- เลือกเทคนิคที่จะใช้ในแต่ละส่วน 
- แบ่งหน้าที่  คนหนึ่งปฏิบัติบนคอมพิวเตอร์ คนหนึ่งช่วยคิดและตรวจสอบ 

4. ครูเดินสังเกตและให้คำแนะนำเฉพาะคู่ท่ีติดขัด 
5. แต่ละคู่นำเสนอผลงาน Mini Project โดยอธิบาย 

- ชื่อภาชนะและการใช้งาน 
- เทคนิคที่ใช้ในแต่ละส่วน (ต้องระบุให้ชัดเจน) 
- ปัญหาที่พบและวิธีแก้ไข 
- จุดเด่นของการออกแบบ 

6. ผู้เรียนคู่อ่ืน ๆ ตั้งคำถามและให้ข้อเสนอแนะ เช่น 
- ทำไมถึงเลือกใช้ Draft แทน Blind 
- ถ้าเพ่ิมช่องเก็บของอีก 2 ช่อง จะใช้เทคนิคอะไร 
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7. ผู้เรียนโหวตเลือก "ผลงานยอดเยี่ยม" 3 อันดับ 
8. ครูประกาศผลและมอบรางวัล (คะแนนพิเศษ, ใบประกาศ) 

 

ขั้นสรุป/ประเมินผล (Wrap up) 
1. ครูให้ผู้เรียนทำแบบฝึกหัดหลังเรียน หน่วยที่ 4  
2. ผู้เรียนทำแบบฝึกหัดหลังเรียน หน่วยที่ 4 ตามที่ครูมอบหมาย 
3. ครแูละผู้เรียนร่วมสรุปเนื้อหาและประเด็นสำคัญ 
4. ผู้เรียนตั้งคำถามและข้อสงสัย  
5. ครแูจ้งหัวข้อที่จะเรียนครั้งต่อไป 
6. ผู้เรียนเตรียมความพร้อมสำหรับบทเรียนต่อไป 

 

สื่อและแหล่งการเรียนรู้ 
สื่อสิ่งพิมพ์ 
หนังสือเรียนวิชา งานเขียนแบบเครื่องกลด้วยคอมพิวเตอร์ (Computer-Aided Mechanical Drafting 

Job) รหัสวิชา 20101-2029 หน่วยการเรียนรู้ที ่4 เรื่อง ระบบ 3 มิติ และการสร้างชิ้นงาน 3 มิติด้วยการเพิ่มความ
หนาในโปรแกรม SOLIDWORKS ของบริษัท สำนักพิมพ์เอมพันธ์ จำกัด 

สื่อโสตทัศน์ 
สไลด์ Power Point หน่วยการเรียนรู้ที่ 3 เรื่อง ระบบ 3 มิติ และการสร้างชิ้นงาน 3 มิติด้วยการเพ่ิมความ

หนาในโปรแกรม SOLIDWORKS 
สื่อออนไลน์ 

  - 
สื่อจำลองหรือของจริง 
 - 

 อ่ืน ๆ  
  - 

หลักฐานการเรียนรู้ 
หลักฐานความรู้ 
1. ผลการทำแบบฝึกหัดหลังเรียน หน่วยที่ 4 
2. ผลการตอบคำถามทบทวนความรู้ 
3. ผลการตรวจแบบทดสอบหลังเรียน หน่วยที่ 4 

 หลักฐานการปฏิบัติงาน 
1. ผลการปฏิบัติงานตามใบงานเพ่ิมเติมที่ 3 
2. ผลการปฏิบัติงานตามใบงานที่ 4.1 
3. ผลการปฏิบัติงานตามใบงานที่ 4.2 



199 
 

 
 

4. ผลการทำ Mini Project ออกแบบชิ้นงานที่มีระนาบหลายชั้น 
5. ผลการออกแบบขาตั้งกล้อง Mini 
6. ผลการออกแบบภาชนะใส่ของใช้ส่วนตัว 

 หลักฐานคุณลักษณะอันพึงประสงค์ 
1. ผลการประเมินตามแบบประเมินคุณธรรม จริยธรรม ตามสภาพจริง 

การวัดและประเมินผล 
เครื่องมือวัด วิธีวัด การประเมินตามเกณฑ ์

1. ใบงานเพ่ิมเติมที่ 3 ปฏิบัติ-ตรวจแบบฝึกหัด เกณฑ์ผ่าน 50% 

2. ใบงานที่ 4.1 ปฏิบัติ-ตรวจแบบฝึกหัด เกณฑ์ผ่าน 50% 

3. ใบงานที่ 4.2 ปฏิบัติ-ตรวจแบบฝึกหัด เกณฑ์ผ่าน 50% 

4. แบบฝึกหัดหลังเรียน หน่วยที่ 4 ตรวจแบบฝึกหัด เกณฑ์ผ่าน 50% 

5. แบบทดสอบหลังเรียน หน่วยที่ 4 ทดสอบ-ตรวจแบบทดสอบ เกณฑ์ผ่าน 50% 

6. แบบประเมินคุณธรรม จริยธรรม ตามสภาพจริง สังเกต/ผู้เรียนประเมินตนเอง เกณฑ์ผ่าน 70% 

งานที่มอบหมาย 
1. งานที่มอบหมายนอกเหนือเวลาเรียน ให้ทำแบบฝึกหัดที่ทำไม่แล้วเสร็จในห้องเรียนให้เรียบร้อย 
2. ทำ Mini Project ออกแบบชิ้นงานที่มีระนาบหลายชั้น 
3. ออกแบบขาตั้งกล้อง Mini 
4. ออกแบบภาชนะใส่ของใช้ส่วนตัว 
5. สืบค้นข้อมูลเพิ่มเติมเก่ียวกับเนื้อหาที่จะเรียนในครั้งถัดไป 

 

หนังสืออ้างอิง 
 ผศ.กีรดิษ สายพัทลุง. (2567). งานเขียนแบบเครื่องกลด้วยคอมพิวเตอร์ (Computer-Aided Mechanical 
Drafting Job). เอมพันธ์. 
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บันทึกผลหลังการจัดการเรียนรู้ (ครั้งที่ 9/18, ชั่วโมงท่ี 57-63/126) 
1. ผลการจัดการเรียนรู้ที่เกิดขึ้นกับผู้เรียน 

               
               
               

2. ปัญหา อุปสรรคที่พบ 
               
               
               

3. การแก้ไขปัญหา 
3.1) ผลการแก้ไขปัญหาที่ส่งผลลัพธ์ที่ดีต่อผู้เรียน 

               
               

3.2) แนวทางแก้ปัญหาในครั้งต่อไป 
               
               

 
 

ลงชื่อ 
                        (.........................................)

                    ครูผู้สอน   
     ………./…………/………… 
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บันทึกผลหลังการจัดการเรียนรู้ (ครั้งที่ 10/18, ชั่วโมงที่ 64–7/126) 

1. ผลการจัดการเรียนรู้ที่เกิดขึ้นกับผู้เรียน 
               
               
               

2. ปัญหา อุปสรรคที่พบ 
               
               
               

3. การแก้ไขปัญหา 
3.1) ผลการแก้ไขปัญหาที่ส่งผลลัพธ์ที่ดีต่อผู้เรียน 

               
               

3.2) แนวทางแก้ปัญหาในครั้งต่อไป 
               
               

 
 

ลงชื่อ 
                        (.........................................)

                    ครูผู้สอน   
     ………./…………/………… 

 
 
 
 
 
 
 
 
 
 



203 
 

 
 

 
 
บันทึกผลหลังการจัดการเรียนรู้ (ครั้งที่ 11/18, ชั่วโมงที่ 71-77/126) 

1. ผลการจัดการเรียนรู้ที่เกิดขึ้นกับผู้เรียน 
               
               
               

2. ปัญหา อุปสรรคที่พบ 
               
               
               

3. การแก้ไขปัญหา 
3.1) ผลการแก้ไขปัญหาที่ส่งผลลัพธ์ที่ดีต่อผู้เรียน 

               
               

3.2) แนวทางแก้ปัญหาในครั้งต่อไป 
               
               

 
 

ลงชื่อ 
                        (.........................................)

                    ครูผู้สอน   
     ………./…………/………… 
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แผนการจัดการเรียนรู้ที่ 5  หน่วยที่    5    . 
รหัสว ิชา 20101-2029  ช ื ่อว ิชา  งานเข ียนแบบเคร ื ่องกลด ้วย
คอมพิวเตอร์ (Computer-Aided Mechanical Drafting Job) 

สอนครั้งที ่12 - 14 

ชื่อหน่วยการเรียนรู้  การสร้างวัตถุ 3 มิติ ด้วยการตัด เจาะ หมุน และ
กำหนดรูปทรงให้กับชิ้นงาน    

ทฤษฎี     3    ชม.  
ปฏิบัติ    18    ชม. 

ชื่อเรื่อง   การสร้างวัตถุ 3 มิติ ด้วยการตัด เจาะ หมุน และกำหนดรูปทรงให้กับชิ้นงาน    

สาระสำคัญ 
 การสร้างวัตถุ 3 มิติ ใน SOLIDWORKS อาศัยเทคนิคพื้นฐานหลายรูปแบบ ได้แก่ การเจาะ (Drilling)        
ที่ใช้คำสั่ง Extruded Cut สำหรับสร้างรูและช่องว่าง การหมุน (Revolve) ที่ใช้ Revolve Boss/Base สำหรับ
สร้างวัตถุรอบแกน การสร้างตามเส้นนำ (Sweep) ที่ใช้เส้นกำหนดทิศทางในการขึ ้นรูป และการสร้างแบบ      
หลายหน้าตัด (Lofted) ที่เชื่อมต่อภาคตัดขวางหลายระนาบเข้าด้วยกัน โดยแต่ละเทคนิคมีทั้งการเพิ่มและการลด       
เนื้อวัสดุเพ่ือให้ได้รูปทรงที่ต้องการ 
 

ผลลัพธ์การเรียนรู้ระดับหน่วยการเรียน 
ผู้เรียนสามารถสร้างและปรับแต่งวัตถุ 3 มิติที่มีความซับซ้อนด้วยเทคนิคการตัด เจาะ หมุน และกำหนด

รูปทรงตามหน้าตัดที่หลากหลาย เพื่อให้ได้ชิ้นงานที่มีรูปทรงตามที่ต้องการและสามารถนำไปประยุกต์ใช้ในงาน
ออกแบบต่าง ๆ ได้อย่างมีประสิทธิภาพ 

 

อ้างอิงมาตรฐาน/เชื่อมโยงกลุ่มอาชีพ 
 - 

 

สมรรถนะประจำหน่วย 
13. แสดงความรู้เกี่ยวกับหลักการและเทคนิคการสร้างวัตถุ 3 มิติด้วยวิธีการตัด เจาะ หมุน และกำหนด

รูปทรงตามหน้าตัด 
14. มีทักษะการใช้เครื่องมือและคำสั่งต่าง ๆ ในโปรแกรมออกแบบ 3 มิติ เพื่อสร้างชิ้นงานที่มีความซับซ้อน 
15. ประยุกต์ใช้เทคนิคการสร้างวัตถุ 3 มิติในการออกแบบและพัฒนาชิ้นงานตามวัตถุประสงค์ท่ีกำหนด 

 

จุดประสงค์เชิงพฤติกรรม   
ด้านความรู้ (Knowledge) 
5. อธิบายเกี่ยวกับหลักการและขั้นตอนการเจาะวัตถุ 3 มิติรูปแบบต่าง ๆ เพื่อให้ได้รูปทรงตามที่ต้องการ

ได ้

ด้านทักษะ/กระบวนการ  (Process) 
7. ใช้เทคนิคการหมุนและการสร้างรูปทรงแบบแกนห่างหน้าตัดและแกนติดหน้าตัดเพ่ือสร้างชิ้นงาน  3 มิต ิ

ที่มีความซับซ้อนได้ 
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8. ปรับแต่งและแก้ไขรูปทรงวัตถุ 3 มิติเพ่ือให้ได้ชิ้นงานที่สมบูรณ์และตรงตามข้อกำหนดได้ 
 

 
คุณลักษณะท่ีพึงประสงค์ (Attitude)   
4. มีเจตคติและกิจนิสัยที่ดีในการปฏิบัติงานด้วยความละเอียด รอบคอบ และมีความคิดสร้างสรรค์ ในการ

ออกแบบวัตถุ 3 มิติ เพ่ือให้ได้ชิ้นงานที่มีประสิทธิภาพและสวยงาม 
 

ด้านการประยุกต์ใช้ (Apply)  
1. ประยุกต์ใช้การขึ้นรูปตามเส้นนำและการสร้างแบบจำลองแบบหลายหน้าตัดเพื่อสร้างวัตถุ 3 มิติ ที่มี

รูปทรงอิสระได้ 
 

สาระการเรียนรู้ 
 5.1 การเจาะวัตถุ 3 มิติ 
  5.1.1 การเจาะรูวัตถุ 3 มิติ 

5.1.2 การสร้างรูปทรงแบบผกผัน (Inverse Hole Feature) 
5.1.3 กระบวนการสร้างรูปทรงด้วยการเจาะตามแนวเส้นร่าง (Profile-Based Hole Feature) 

5.2 หลักการหมุนเพ่ือสร้างวัตถุ 3 มิติ 
5.3 การสร้างชิ้นงานแบบแกนห่างหน้าตัด (Offset Axis Feature) 
5.4 การสร้างชิ้นงานด้วยเทคนิคการหมุนแบบแกนติดหน้าตัด (Attached-Axis Revolution) 
5.5 การคว้านเนื้อในวัตถุออกด้วยการหมุน 
5.6 การข้ึนรูปชิ้นงานตามเส้นนำ (Sweep Feature) 
5.7 การสร้างช่องว่างตามแนวเส้นนำ (Swept Cut Feature) 
5.8 การสร้างแบบจำลอง 3 มิติแบบหลายหน้าตัด (Multi-Section Solid Feature) 
5.9 การปรับแต่งรูปทรงวัตถุ 3 มิติแบบหลายหน้าตัด (Multi-Section Solid Shape Modification) 
 5.9.1 การปรับความโค้งของพ้ืนผิว 

5.9.2 การหมุนบิดวัตถุ 
5.10 การสร้างช่องว่างแบบหลายหน้าตัด (Multi-Section Lofted Cut) 

กิจกรรมการเรียนรู้ (ครั้งท่ี 12/18, ชั่วโมงท่ี 78-84/126) 

ขั้นนำเข้าสู่บทเรียน (Warm up) 
35. ครูเปิดภาพชิ้นงานจริงที่มีรูเจาะ เช่น ฝาท่อ, ล้อ, ชิ้นส่วนเครื่องจักร พร้อมถามผู้เรียนว่า 

- ชิ้นงานเหล่านี้มีอะไรเหมือนกัน 
36. ผู้เรียนสังเกตและตอบคำถาม 

- แนวคำตอบ มีรูเจาะ, มีลักษณะกลม, มีหลายรูปแบบ 
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37. ครูนำเสนอคลิปวิดีโอสั ้น ๆ แสดงกระบวนการเจาะรูในโรงงานอุตสาหกรรม (Drilling, Boring, 
Reaming)  

 
 
38. ครูเชื่อมโยงสู่บทเรียน 

- ในโลกจริง เราใช้สว่านเจาะรู แต่ใน SOLIDWORKS เรามีเครื่องมือพิเศษท่ีจำลองกระบวนการ
นี้ได้อย่างง่ายดาย วันนี้เราจะมาเรียนรู้วิธีการสร้างรูเจาะ การหมุนชิ้นงาน และการสร้าง
รูปทรงแบบแกนเยื้องศูนย์กลาง 

39. ครูอธิบายภาพรวมของกิจกรรมในวันนี้ 
 

ขั้นการสอน/การนำเสนอ (Presentation) 

5.1  การเจาะวัตถุ 3 มิติ 
1. ครูเปิดโปรแกรม SOLIDWORKS บนจอโปรเจคเตอร์ และสร้างวัตถุ 3 มิติเหลี่ยม 1 ชิ้น ดังรูปที่ 5.1 
2. ครูสาธิตการสร้างเหลี่ยม 3 มิติ 1 ชิ้น พร้อมอธิบายว่า  

- เรามีชิ้นงานพื้นฐานแล้ว ต่อไปเราจะมาเจาะรูกัน 
3. ผู้เรียนสังเกตและจดบันทึก ขั้นตอนที่ครูสาธิต 
4. ครูสาธิตการคลิก Extruded Cut 
5. ครูอธิบาย คำสั่ง Extruded Cut คือการตัดวัสดุออกจากชิ้นงาน 

6. ครูแสดงการคลิกเลือก Sketch บนหน้าตัด → วาดวงกลม → ใช้คำสั่ง Extruded Cut 
7. ผู้เรียนสังเกตผลลัพธ์ที่เกิดข้ึน (รูเจาะทะลุหรือไม่ทะลุ) 
8. ครูถามผู้เรียน 

- ถ้าต้องการเจาะทะลุต้องเลือกอะไร 
9. ผู้เรียนตอบ 

- Through All 

10. ครูยืนยันและสาธิตให้เห็น Direction 1 → Through All 
11. ครูใหผู้้เรียนลองปฏิบัติตาม บนเครื่องของตนเอง 
12. ผู้เรียนที่ทำเสร็จ ยกมือแสดง ครูตรวจเช็ค 

5.1.2  การสร้างรูปทรงแบบผกผัน (Inverse Hole Feature) 
1. ครูอธิบายแนวคิด 

- บางครั้งเราต้องการเจาะแบบกลับด้าน เช่น เจาะจากด้านในออกด้านนอก 
2. ครูสาธิตสร้างวัตถุ 3 มิติและวาดเส้นร่างบนหน้าตัดด้านบน (รูปทรงที่ต้องการเจาะแบบกลับด้าน) 

- ครูคลิก Extruded Cut → Direction 1 → เลือก Flip side to cut 
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3. ครูอธิบาย Flip side to cut จะเปลี่ยนทิศทางการเจาะ 
4. ผู้เรียนสังเกตความแตกต่างระหว่างการเจาะปกติกับ Flip side to cut 
5. ครูถามผู้เรียน 

- กรณีใดที่ควรใช้ Flip side to cut 
 
 

6. ผู้เรียนแลกเปลี่ยนความคิดเห็น 
- เวลาที่ต้องการเจาะจากด้านล่าง 
- เวลาที่วาด Sketch จากด้านบน 

กระบวนการสร้างรูปทรงด้วยการเจาะตามแนวเส้นร่าง (Profile-Based Hole Feature) 
1. ครูอธิบาย การเจาะตามแนวเส้นร่างคือการกำหนดความหนาของกำแพงรู เรียกว่า Thin Feature 
2. ครูสร้างวัตถุ 3 มิติและวาดเส้นร่าง ที่ต้องการเจาะแบบกำแพงบาง 

- ครูคลิก Extruded Cut → เลือก Thin Feature → ระบุความหนาที่ต้องการ (Thickness) 
3. ครูอธิบาย Thin Feature จะช่วยให้เราควบคุมความหนาของรูได้แม่นยำ 
4. ครูถามผู้เรียน  

- การใช้ Thin Feature มีประโยชน์อย่างไร 
5. ผู้เรียนตอบ 

- ทำให้ควบคุมความหนาได้ 
- ใช้กับชิ้นงานที่ต้องการความแม่นยำ 

6. ครูคลิก Bodies to Keep → เลือก All Bodies 
7. ครูอธิบาย Bodies to Keep คือการเลือกว่าจะเก็บชิ้นงานส่วนไหนไว้ 
8. ผู้เรียนสังเกตผลลัพธ์ 

5.2  หลักการหมุนเพื่อสร้างวัตถุ 3 มิติ (Revolve Feature) 
1. ครูอธิบายแนวคิด 

- การหมุน (Revolve) คือการสร้างวัตถุ 3 มิติโดยการหมุนรูปร่าง 2 มิติรอบแกน เช่น สร้างแก้ว
น้ำ ท่อ ล้อ 

2. ครูสาธิต โดย สร้าง Sketch ของหน้าตัดชิ้นงาน (เช่น รูปครึ่งวงกลม) 
3. ครูถามผู้เรียน 

- ถ้าเราหมุนรูปนี้ 360 องศา จะได้รูปร่างอะไร 
4. ผู้เรียนตอบ 

- ท่อ, แหวน, วงกลม 
5. ครูใช้คำสั่ง Revolved Boss/Base 
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- เลือก Axis of Revolution → เลือกเส้นแกนหมุน 
- ระบุมุมหมุน (360 องศา หรือ 180 องศา) 

6. ครูอธิบาย Revolved Boss เพ่ิมวัสดุ ในขณะที่ Revolved Cut ตัดวัสดุออก 
7. ผู้เรียนสังเกต การเปลี่ยนแปลงของวัตถุ 3 มิติเมื่อหมุนแกน 
8. ครูถาม 

- ถ้าต้องการสร้างท่อโค้ง 180 องศา ต้องตั้งค่าอย่างไร 
9. ผู้เรียนตอบและครูสาธิตให้เห็น 

5.3  การสร้างช้ินงานแบบแกนห่างหน้าตัด (Offset Axis Feature) 
1. ครูอธิบาย Offset Axis คือการสร้างรูปทรงที่แกนหมุนห่างจากกำแพงชิ้นงาน เช่น ท่อโค้ง 
2. ครูสาธิต โดยสร้าง Sketch หน้าตัดและแกนหมุนที่ห่างจากหน้าตัด 

- ใช้คำสั่ง Revolved Boss/Base → เลือก Axis of Revolution ที่ตั้งไว้ 
3. ครูอธิบาย Offset Distance คือระยะห่างระหว่างแกนหมุนกับหน้าตัด 
4. ครูถาม  

- การสร้างชิ้นงานแบบ Offset Axis แตกต่างจากการหมุนปกติอย่างไร 
5. ผู้เรียนตอบ 

- แกนหมุนไม่อยู่ที่ชิ้นงาน, ทำให้ได้รูปทรงโค้ง 
6. ครูคลิก Selected Contours เพ่ือเลือกเฉพาะส่วนที่ต้องการหมุน 
7. ผู้เรียนสังเกตว่าสามารถเลือกหลายส่วนได้ 
8. ครูและผู้เรียนร่วมสรุป ความแตกต่างระหว่าง Revolve ปกติ กับ Offset Axis 

ขั้นฝึกฝน/ลงมือปฏิบัติ (Practice) 
1. ครใูห้ผู้เรียนทำใบงานเพ่ิมเติมที่ 4 
2. ผู้เรียนรับฟังคำอธิบาย อ่านใบงานและทำความเข้าใจใบงานที่ต้องทำ 
3. ผู้เรียนทำงานเป็นรายบุคคล โดยปฏิบัติตามข้ันตอน 
4. ครูเดินดูการทำงานและให้คำแนะนำ 
5. ครูเดินสังเกตการทำงาน ให้คำแนะนำและแก้ปัญหาเมื่อผู้เรียนติดขัด 
6. ผู้เรียนที่ทำเสร็จก่อนช่วยเพื่อนที่ยังทำไม่เสร็จ 
7. ผู้เรียนบันทึกไฟล์งานโดยใช้ชื่อตามท่ีใบงานกำหนด 

ขั้นประยุกต์ใช ้(Production) 
กิจกรรม ออกแบบชิ้นส่วนเฟืองตามโจทย์ 
1. ครูให้โจทย์ จงออกแบบชิ้นส่วนเฟืองขนาดเล็กท่ีมีคุณสมบัติดังนี้ 

- มีรูเจาะตรงกลาง ขนาดเส้นผ่านศูนย์กลาง 20 มม. 
- มีฟันเฟือง 6 ฟันรอบ ๆ ตัวเฟือง (ใช้การเจาะและ Circular Pattern) 
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- ความหนาของเฟือง 10 มม. 
2. ผู้เรียนทำงานเป็นคู่ ร่วมกันออกแบบชิ้นงาน 
3. ผู้เรียนใช้ความรู้ที่เรียนมา 

- สร้างวงกลมพ้ืนฐานด้วย Extruded Boss 
- เจาะรูตรงกลางด้วย Extruded Cut 
- สร้างฟันเฟืองด้วยการเจาะรูและใช้ Circular Pattern 

4. ครูเดินดูและให้คำแนะนำ เมื่อผู้เรียนติดปัญหา 
5. ผู้เรียนนำเสนอผลงาน โดยเลือก 3-4 คู่ที่มีผลงานโดดเด่น 
6. ผู้เรียนและครูร่วมวิจารณ์ผลงาน โดยพิจารณาจาก 

- ความถูกต้องตามโจทย์ 
- ความสวยงามและความคิดสร้างสรรค์ 
- การใช้เครื่องมืออย่างเหมาะสม 

ขั้นสรุป/ประเมินผล (Wrap up) 
1. ครูและผู้เรียนร่วมกันสรุปประเด็นสำคัญ 
2. ผู้เรียนฟังการสรุปและจดบันทึกสาระสำคัญ 
3. ครูถามคำถามทบทวนความรู้  
4. ผู้เรียนตอบคำถามทบทวน 
5. ผู้เรียนสอบถามข้อสงสัยที่ยังไม่เข้าใจ 
6. ครูแจ้งหัวข้อที่จะเรียนครั้งต่อไป 
7. ผู้เรียนเตรียมความพร้อมสำหรับบทเรียนต่อไป 
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ใบงานเพิ่มเติมที่ 4 หน่วยที่   5    .   
รหัสวิชา 20101 – 2029  ช ื ่อว ิชา งานเข ียนแบบเคร ื ่องกลด ้วย
คอมพิวเตอร์ (Computer-Aided Mechanical Drafting Job) 

สอนครั้งที ่12  .       

ชื่อหน่วยการเรียนรู้   การสร้างวัตถุ 3 มิติ ด้วยการตัด เจาะ หมุน และ
กำหนดรูปทรงให้กับชิ้นงาน ทฤษฎี   3  ชม.  

ปฏิบัติ  18 ชม. ชื่อเรื่อง    การเจาะวัตถุ 3 มิติ, หลักการหมุนเพื่อสร้างวัตถุ 3 มิติ และการสร้างชิ้นงานแบบ
แกนห่างหน้าตัด 

 

1.  ผลลัพธ์การเรียนรู้จากการปฏิบัติงาน 
ผู้เรียนสามารถสร้างและปรับแต่งวัตถุ 3 มิติ ที่มีความซับซ้อนด้วยเทคนิคการตัด เจาะ หมุน และกำหนด

รูปทรงตามหน้าตัดที่หลากหลาย เพื่อให้ได้ชิ้นงานที่มีรูปทรงตามที่ต้องการและสามารถนำไปประยุกต์ใช้ในงาน
ออกแบบต่างๆ ได้อย่างมีประสิทธิภาพ 
 

2.  อ้างอิงมาตรฐาน/เชื่อมโยงกลุ่มอาชีพ 
 - 

3. สมรรถนะการปฏิบัติงาน 
1. ผู้เรียนแสดงความเข้าใจและสามารถใช้คำสั่ง การหมุนขึ้นรูป ซึ่งเป็นหนึ่งในพื้นฐานที่สำคัญที่สุดในการ

สร้างชิ้นงานทรงสมมาตร 
2. สามารถเลือกใช้ได้อย่างถูกต้องในการกำหนด แกนหมุน ซึ่งเป็นหลักการพื้นฐานของการหมุนขึ้นรูป 
3. สามารถเริ่มต้นการทำงานบนระนาบที่ถูกต้องและใช้คำสั่งพ้ืนฐานเพ่ือสร้าง หน้าตัดรูปปิดที่เป็นเงื่อนไข

สำคัญของคำสั่ง Revolve 
 

4.  จุดประสงค์เชิงพฤติกรรม  
ด้านความรู้ (Knowledge) 
1. อธิบายเกี่ยวกับหลักการทำงานของฟังก์ชันหลักและฟังก์ชันเสริมในการเขียนเส้นร่างเพื่อให้เข้าใจการ

นำไปใช้งานได้อย่างถูกต้องได้ 
 

ด้านทักษะ/กระบวนการ  (Process) 
1. ใช้ฟังก์ชันหลักในการปรับแต่งลักษณะและรูปแบบของเส้นร่างเพื่อสร้างเส้นร่างพื้นฐานที่ถูกต้องตาม

หลักการเขียนแบบได้ 
2. ใช้ฟังก์ชันการจัดการเส้นร่างเพื่อปรับปรุงประสิทธิภาพในกระบวนการออกแบบและลดเวลาในการ

ทำงานได้ 
 

คุณลักษณะท่ีพึงประสงค์ (Attitude)   
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1. มีเจตคติและกิจนิสัยที่ดีในการปฏิบัติงานด้วยความละเอียด รอบคอบ และถูกต้องตามหลักวิชาการใน
การใช้โปรแกรม SOLIDWORKS 

ด้านการประยุกต์ใช้ (Apply)  
ประยุกต์ใช้ฟังก์ชันเสริมเพ่ือปรับแต่ง แก้ไข และสร้างรูปแบบซ้ำของเส้นร่างในการออกแบบชิ้นงาน ที่มี

ความซับซ้อนได้ 
 

5.  เครื่องมือ วัสดุ และอุปกรณ์ 
1. เครื่องคอมพิวเตอร์ พร้อมระบบปฏิบัติการ Windows 10 ขึ้นไป พร้อม จอมอนิเตอร์ 
2. เครื่องคอมพิวเตอร์ ที่ติดตั้ง Software SOLIDWORKS 
3. เมาส์ ที่มี 3 ปุ่ม (ซ้าย ขวา และ ลูกกลิ้ง) 
4. คีย์บอร์ดคอมพิวเตอร์ 

 

6.  คำแนะนำ/ข้อควรระวัง 
1. ทำตามขั ้นตอนที่แนะนำในใบงาน พยายามอย่าข้ามขั ้นตอนใดขั ้นตอนหนึ่ง อาจทำให้โปรแกรม  

ไม่สามารถประมวลผลได้ 
2. ฝึกทำ และ ทบทวน การทำงานของเครื่องมือต่างๆ บ่อยครั้ง เพ่ือให้เกิดความคล่องแคล่วและชำนาญ 

 

7.  ขั้นตอนการปฏิบัติงาน 
แบบฝึกหัด SolidWorks Extruded Cut 
โจทย์ : สร้างลูกบาศก์ขนาด 100x100x100 mm ที่มีรูวงกลมเจาะทะลุตรงกลาง 
ขั้นตอนที่ 1 การสร้างชิ้นงานหลัก (สร้างลูกบาศก์) 

1. เปิดไฟล์ใหม ่ 
- ไปที ่File > New > เลือก Part > คลิก OK 

2. เริ่ม Sketch 
- เลือก Front Plane (ระนาบด้านหน้า) 
- คลิกท่ีปุ่ม Sketch (ร่างภาพ) 

3. วาดสี่เหลี่ยม 
- ใช้คำสั่ง Rectangle (สี่เหลี่ยม) วาดสี่เหลี่ยมบนระนาบ 

4. กำหนดขนาด (Dimension) 
- ใช้คำสั่ง Smart Dimension (กำหนดขนาดอัจฉริยะ) 
- กำหนดความกว้าง  = 100 mm 
- กำหนดความสูง = 100 mm 

5. สร้างเนื้อชิ้นงาน 
- ออกจาก Sketch (Exit Sketch) 
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- ไปที่แท็บ Features > คลิก Extruded Boss/Base (สร้างเนื้อชิ้นงาน) 
- กำหนดความลึก (Depth) เป็น 100 mm 
- คลิก OK 

 ขั้นตอนที่ 2 การสร้าง Sketch สำหรับการเจาะ (วาดวงกลม) 
1. เลือกผิวหน้า  

- คลิกเลือกผิวหน้า ด้านหน้า ของลูกบาศก์ที่ผู้เรียนเพ่ิงสร้าง 
2. เริ่ม Sketch ใหม ่

- คลิกท่ีปุ่ม Sketch (ร่างภาพ) 
3. วาดวงกลม 

- ใช้คำสั่ง Circle (วงกลม) วาดวงกลมตรงกลางลูกบาศก์ 
4. กำหนดขนาดและตำแหน่ง 

- ใช้คำสั่ง Smart Dimension 
- ขนาดวงกลม (Diameter)   เส้นผ่านศูนย์กลาง = 50 mm 
- ตำแหน่งแนวนอน   จากขอบซ้ายถึงจุดศูนย์กลางวงกลม   50 mm (เพ่ือให้อยู่ตรงกลาง) 
- ตำแหน่งแนวตั้ง  จากขอบล่างถึงจุดศูนย์กลางวงกลม   50 mm (เพ่ือให้อยู่ตรงกลาง) 

 ขั้นตอนที่ 3 การใช้คำสั่ง Extruded Cut (เจาะทะลุ) 
1. ออกจาก Sketch  

- ออกจาก Sketch (Exit Sketch) 
2. เรียกใช้คำสั่งเจาะ 

- ไปที่แท็บ Features > คลิก Extruded Cut (ตัดเนื้อชิ้นงาน) 
3. ตั้งค่าการเจาะ 

- ดูที ่End Condition (เงื่อนไขสิ้นสุด) 
- เลือก Through All (เจาะทะลุทั้งหมด) 

5.2  หลักการหมุนเพื่อสร้างวัตถุ 3 มิติ 
การใช้คำสั่ง Revolve Boss/Base (พื้นฐาน) 
 ขั้นตอนที่ 1   การเตรียมระนาบและแกนหมุน 
 ก่อนที่จะหมุน เราต้องมี Sketch ที่เป็นรูปทรงที่เราต้องการ และ Centerline (เส้นศูนย์กลาง) เพ่ือกำหนด
แกนหมุน โดย 

1. เปิดไฟล์ใหม่ 
- ไปที ่File > New > เลือก Part > คลิก OK 

2. เลือกระนาบ 
- เลือก Front Plane (ระนาบด้านหน้า) 

3. สร้าง Sketch 
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- คลิกท่ีปุ่ม Sketch 
ขั้นตอนที่ 2  การวาด Sketch สำหรับการ Revolve 
1. วาด Sketch ให้เป็นภาพแบบ 2 มิติ ตามขนาดตัวอย่างในรูป 

 
ขั้นตอนที่ 3  การใช้คำสั่ง Revolve Boss/Base 
1. ออกจาก Sketch: คลิก Exit Sketch 
2. เรียกใช้คำสั่ง Revolve 

- ไปที่แท็บ Features 
- คลิกท่ี Revolved Boss/Base 

3. ตั้งค่าการหมุน 
- SolidWorks ม ักจะเล ือก  Axis of Revolution (แกนหม ุน) ให ้ โดยอ ัตโนม ัต ิ  ซ ึ ่ งก ็คือ 

Centerline ที่วาดไว้ในขั้นตอนที่ 2 (สามารถเปลี่ยนแกนหมุนได้ ลองคลิกเลือกแกนหมุนอ่ืน
เพ่ือดูการเปลี่ยนแปลง) 

- ในช่อง Direction 1 
- ตรวจสอบให้แน่ใจว่า End Condition คือ Blind หรือ Up To Vertex 
- กำหนดมุมเป็น 360 องศา (เพ่ือสร้างวัตถุเต็มวง) 

4. ยืนยัน 
- คลิก OK 
- ผู้เรียนจะได้ชิ้นงาน ทรงกระบอกตัน (ลักษณะคล้ายหัวสกรู) ที่มีความสูง 100 mm และมีเส้น

ผ่านศูนย์กลาง (Diameter) เท่ากับ 50 mm (รัศมี 20 mm) ซึ่งเกิดจากการหมุนสี่เหลี่ยมครึ่ง
ซีกรอบแกน 360 องศา 

5.3  การสร้างช้ินงานแบบแกนห่างหน้าตัด 
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1. สร้างชิ้นงานเป็นภาพ 2 มิติ ให้ได้ขนาด ตามรูป 
2. ระยะห่างของเส้นตรง (แกนหมุนสำหรับหน้าตัดตรงกลาง) พอประมาณ ตามความเหมาะสม (เส้นตรง 

ด้านขวามือ) 

 
 

3. ไปที่แถบ Features (ฟีเจอร์) 
4. เลือกคำสั่ง Revolve Boss/Base (การหมุนขึ้นรูป) 
5. หน้าต่าง Property Manager จะปรากฏขึ้น 

- Selected Contours (หน้าตัดที ่เลือก) หากสเก็ตช์ของผู ้เร ียนเป็นรูปปิดเพียงรูปเดียว 
SolidWorks จะเลือกให้อัตโนมัติ หากไม่เลือก ให้คลิกท่ีพ้ืนที่ภายในรูปหน้าตัดของผู้เรียน 

- Axis of Revolution (แกนหมุน)  คลิกท่ีเส้น Centerline ทีผู่้เรียนสร้างไว้ในขั้นตอนที่ 2 
- Direction 1 (ทิศทางที่ 1)  เลือก Blind และตั้งค่า Angle (มุม) เป็น 360° (สำหรับการหมุน

เต็มรอบ) 
6. ตรวจสอบภาพตัวอย่าง (Preview) ที่แสดงขึ้นมา 

8.  สรุปและวิจารณ์ผล 
 8.1  สรุป 

ผู้เรียนสามารถสร้างภาพ 2 มิติ และใช้คำสั่ง สร้างให้เป็นภาพ 3 มิติ พร้อมทั้งคำสั่งสำหรับการเจาะวัตถุ 3 
มิติ ได้ด้วยคำสั่ง Extruded Cut 

สามารถเข้าใจหลักการหมุนเพื่อสร้างวัตถุ 3 มิติ และใช้คำสั่ง Revolve Boss/Base (พื้นฐาน) ได้ รวมถึง
เข้าใจคำสั่ง Axis of Revolution (แกนหมุน) ในการสร้างชิ้นงานแบบแกนห่างหน้าตัด และเข้าใจการสร้างชิ้นงาน
ในพ้ืนฐานเบื้องต้น 
 

8.2 ปัญหาที่พบและแนวทางแก้ไข 
ปัญหาที่พบระหว่างปฏิบัติงาน วิธีแก้ไขท่ีใช้ 

1. 
 

2. 
 

3. 
 

8.3 ข้อเสนอแนะ/ความคิดเห็น กรุณาเขียนความคิดเห็นเกี่ยวกับการปฏิบัติงานในครั้งนี้ 
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- สิ่งที่ได้เรียนรู้ใหม่………………………………………………………………………………………………………………. 
- สิ่งที่ยากที่สุด…………………………………………………………………………………………………………………….. 
- สิ่งที่อยากเรียนรู้เพิ่มเติม…………………………………………………………………………………………………….. 

 

9.  การประเมินผล 
ประเมินความสามารถในการใช้คำสั่ง Revolve Boss/Base (การหมุนขึ้นรูป) และการสเก็ตช์ที่เกี่ยวข้อง 

ในโปรแกรม SolidWorks 
 

ลำดับ รายการประเมิน (เกณฑ์การให้คะแนน) คะแนน คะแนนที่ได ้

1 การเตรียมการและการตั้งค่าเริ่มต้น 
  

 
- เลือก Front Plane หรือระนาบที่เหมาะสมเพื่อเริ่มต้นสเก็ตช์ได้ถูกต้อง 2 

 

2 การสร้างแกนหมุน (Axis of Revolution) 
  

 
- ใช้คำสั่ง Centerline ในการสร้างแกนหมุนในแนวตั้งได้อย่างถูกต้อง 2 

 

3 การสเก็ตช์หน้าตัด (Profile Sketch) 
  

 
- สเก็ตช์รูปทรงหน้าตัดเพียงครึ่งเดียวของชิ้นงาน (แก้ว) ได้ถูกต้องตามความ
ต้องการ 

2 
 

 
- หน้าตัดเป็น รูปปิด (Closed Profile) และเชื่อมต่อกับแกนหมุนอย่าง
สมบูรณ์ 

2 
 

4 การกำหนดขนาดและความสมบูรณ์ 
  

 
- ใช้คำสั่ง Smart Dimension ในการกำหนดขนาดเชิงเส้นและขนาดเส้นผ่าน
ศูนย์กลางได้อย่างถูกต้อง 

3 
 

 
- สเก็ตช์อยู่ในสถานะ Fully Defined (กำหนดขนาดสมบูรณ์) (เส้นสเก็ตช์
เปลี่ยนเป็นสีดำ) 

2 
 

5 การใช้คำสั่ง Feature (Revolve) 
  

 
- เลือกใช้คำสั่ง Revolve Boss/Base ได้ถูกต้อง 2 

 

 
- กำหนด Axis of Revolution (Centerline) และตั้งค่ามุมหมุนเป็น 360° ได้
ถูกต้อง 

2 
 

6 ผลลัพธ์และความถูกต้องของชิ้นงาน 
  

 
- ชิ้นงาน 3 มิติที่ได้มีความสมมาตรและตรงตามรูปทรงของแก้วที่ต้องการ 
(ปราศจากข้อผิดพลาดของ Feature) 

3 
 

รวมคะแนน 20 
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10.  หนังสืออ้างอิง /หนังสือค้นคว้าเพิ่มเติม 
หนังสือเรียนวิชา งานเขียนแบบเครื่องกลด้วยคอมพิวเตอร์ (Computer-Aided Mechanical Drafting 

Job) รหัสวิชา 20101-2029 หน่วยการเรียนรู้ที่ 5 เรื่อง การสร้างวัตถุ 3 มิติ ด้วยการตัด เจาะ หมุน และกำหนด
รูปทรงให้กับชิ้นงาน ของบริษัท สำนักพิมพ์เอมพันธ์ จำกัด 
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กิจกรรมการเรียนรู้ (ครั้งท่ี 13/18, ชั่วโมงท่ี 85-91/126) 

ขั้นนำเข้าสู่บทเรียน (Warm up) 
32. ครูเปิดภาพตัวอย่างชิ้นงานจริง เช่น ลูกบิดประตู, แจกันดอกไม้, หลอดไฟ, ขวดน้ำ, ท่อโค้ง, ราวบันได 

พร้อมถามว่า 
- ชิ้นงานเหล่านี้สร้างด้วยวิธีใด ใน SOLIDWORKS 

33. ผู้เรียนสังเกตและตอบ 
- ใช้การหมุน, มีรูปทรงกลม, มีเส้นโค้ง 

34. ครูนำเสนอวิดีโอสั ้น ๆ แสดงกระบวนการผลิตชิ ้นงานโดยการหมุนบนเครื ่อง CNC Lathe และ        
การข้ึนรูปท่อโค้งในโรงงานอุตสาหกรรม 

35. ครูใหผู้้เรียนจับชิ้นงานตัวอย่าง (เช่น ลูกบิดประตู, ท่อ PVC โค้ง) และสังเกตว่า 
- ถ้าจะสร้างลูกบิดประตูใน SOLIDWORKS ต้องวาดรูปอะไร 
- ถ้าจะสร้างท่อโค้งต้องทำอย่างไร 

36. ผู้เรียนตอบ 
- สร้างลูกบิดประตู ต้องวาดครึ่งหนึ่งแล้วหมุน 
- สร้างท่อโค้ง ใช้เส้นนำ 

37. ครูเชื่อมโยงสู่บทเรียน 
- วันนี้เราจะเรียนรู้เทคนิคพิเศษ 3 แบบ คือ การหมุนแบบแกนติดหน้าตัด  ( Attached-Axis 

Revolution), การคว้านเนื้อในด้วยการหมุน, และ การขึ้นรูปตามเส้นนำ (Sweep Feature) 
ซึ่งจะช่วยให้เราสร้างชิ้นงานที่ซับซ้อนได้ง่ายขึ้น 

38. ผู้เรียนเปิดเครื่องคอมพิวเตอร์ และโปรแกรม SOLIDWORKS พร้อมรับฟัง 
39. ครูอธิบายภาพรวมของกิจกรรมวันนี้ 

 

ขั้นการสอน/การนำเสนอ (Presentation) 
5.4  การสร้างช้ินงานด้วยเทคนิคการหมุนแบบแกนติดหน้าตัด (Attached-Axis Revolution) 
1. ครูอธิบายแนวคิด 

- Attached-Axis Revolution คือการหมุนรูปร่าง 2D รอบแกนที ่ต ิดกับหน้าตัดโดยตรง 
แตกต่างจากการหมุนปกติที่แกนอาจห่างจากหน้าตัด 

2. ครูเปิด SOLIDWORKS และสาธิตทีละข้ันตอน 
ขั้นที่ 1 ที่ Sketch วาดเส้นร่างกลมที่เส้นเสียมและวาดเส้นตรงพาดผ่านระหว่างเส้นทั้งสอง เส้นตรงนี้จะใช้
เป็นแกนกลางในการหมุน 
1. ครูอธิบาย เพ่ิมเติมว่า เส้นตรงนี้คือแกนหมุนที่ติดกับหน้าตัด 
2. ผู้เรียนสังเกตตำแหน่งแกนหมุน 
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ขั้นที่ 2  ครู คลิกคำสั่ง Trim Entities เพ่ือตัดเส้นที่ไม่ต้องการทิ้งไป เมือ่ตัดเส้นจะได้ผลตรง 
1. ครูสาธิตการใช้ Trim Entities 
2. ผู้เรียนถามคำถามว่า ทำไมต้อง Trim 
3. ครูอธิบาย เพ่ิมเติมว่า เพราะเราต้องการเฉพาะส่วนที่จะหมุน 
ขั้นที่ 3  คลิกที่แถบ Features และใช้คำสั่ง Revolved Boss/Base เพื่อสร้างวัตถุ 3 มิติจากการหมุนรอบ
แกน 
1. ครูอธิบาย Revolved Boss/Base จะสร้างชิ้นงาน 3 มิติจากการหมุน 
ขั้นที่ 4 ที่หน้าต่าง Revolve คลิกที่ของ Selected Contours และคลิกที่กลางเส้นร่างเพื่อกำหนดหน้าตัด
สำหรับใช้หมุน 
1. ผู้เรียนสังเกตการเลือก Contours 
2. ครูถาม ถ้าเราไม่เลือก Contours จะเกิดอะไรขึ้น 
3. ผู้เรียนตอบ จะหมุนทั้งหมด 
ขั้นที่ 5  คลิกช่องในหัวข้อ Axis of Revolution และคลิกที่เส้นตรง เพื่อกำหนดแกนกลางสำหรับใช้หมุน 

เมื่อตั้งค่าเสร็จแล้ว คลิกเครื่องหมาย ✓ เพ่ือเสร็จสิ้นการทำงาน 
1. ครูอธิบาย Axis of Revolution คือแกนที่เราจะหมุนรอบ 
ขั้นที่ 6  วัตถุ 3 มิติแบบแกนติดกับหน้าตัด การตั้งค่าอื่น ๆ จะเหมือนกับการตั้งค่าการหมุนวัตถุแบบทั่วไป
อ่ืน ๆ 
1. ผู้เรียนเห็นผลลัพธ์ชิ้นงาน 3 มิติ 
2. ผู้เรียนลองปฏิบัติตาม บนเครื่องของตนเอง  
3. ครูเดินดูและให้คำแนะนำ เมื่อผู้เรียนติดปัญหา 
4. ครูถามผู้เรียน 

- การใช้ Attached-Axis Revolution เหมาะกับชิ้นงานประเภทใด 
5. ผู้เรียนตอบ 

- ลูกบิดประตู, ขวดน้ำ, แจกัน 
5.5  การคว้านเนื้อในวัตถุออกด้วยการหมุน (Revolved Cut) 
1. ครูอธิบายแนวคิด 

- นอกจากใช้การหมุนหน้าตัดเพ่ือสร้างวัตถุ 3 มิติแล้ว ยังสามารถใช้การหมุนหน้าตัดเพ่ือตัดเนื้อ
วัตถุ 3 มิติ ออก ซึ่งเทคนิคนี้มีประโยชน์อย่างมากในการสร้างชิ้นงานที่มีโพรงภายใน 

2. ครูสาธิตทีละข้ันตอน 
ขั้นที่ 1 สร้างเหลี่ยม 3 มิติขึ้นที่ระนาบ Top Plane 
1. ครูสร้างชิ้นงานพ้ืนฐาน 
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2. ผู้เรียนสังเกต 
ขั้นที่ 2  คลิกท่ี Sketch เพ่ือสร้างเส้นร่างใช้ในการคว้านเนื้อในเหลี่ยม 3 มิติ 
1. ครูวาดรูปครึ่งวงกลมบนหน้าตัด Front Plane 
2. ผู้เรียนถาม 

- ทำไมจึงต้องวาดครึ่งวงกลม 
3. ครูอธิบาย 

- เพราะเราจะหมุนให้กลายเป็นทรงกลมกลวง 
ขั้นที่ 3 คลิกท่ีแถบ Features ดังรูปที่ 5.24 
1. ครูอธิบาย ว่า Revolved Cut จะตัดเนื้อวัสดุออกด้วยการหมุน 
ขั้นที่ 4  ที่หน้าต่าง Revolve คลิกที่ของ Selected Contours และคลิกที่กลางเส้นร่าง เพื่อกำหนดหน้า
ตัดสำหรับใช้หมุน 
1. ผู้เรียนเลือก Contours ที่ต้องการ 
ขั้นที่ 5  คลิกคำสั่ง Revolved Cut 
1. ครูอธิบาย ว่า คำสั่งนี้จะคว้านเนื้อในออก 
ขั้นที่ 6  ที่หน้าต่าง Cut-Revolve คลิกที่ของ Selected Contours และคลิกที่กลางเส้นร่าง เพื่อกำหนด
หน้าตัดสำหรับใช้หมุน 
1. ผู้เรียนปฏิบัติตาม 
ขั้นที่ 7  คลิกช่องใน Axis of Revolution และคลิกที่เส้นตรง เพ่ือกำหนดแกนกลางสำหรับใช้หมุน ดังรูปที่ 5.25 
1. ครูอธิบาย ว่า เราต้องเลือกแกนที่จะหมุนรอบ 

ขั้นที่ 8  คลิกเพื่อลบเครื่องหมาย ✓ หน้าตัวเลือก Thin Feature ออก เพราะหากปล่อยไว้จะเป็นการตัด
แบบใช้ขอบเส้นร่างด้วย จากนั้นปรับขนาดของเนื้อวัตถุ 3 มิติ ที่จะคว้านออกมา โดยคลิกที่ลูกศรแล้วลาก
ตามต้องการ โดยพื้นที่ท่ีจะลูกคว้านจะเป็นเส้นร่างสีเหลือง ดังรูปที่ 5.26 
1. ผู้เรียนเห็นผลลัพธ์การคว้านเนื้อใน 
2. ผู้เรียนลองปฏิบัติตาม  
3. ครูถามผู้เรียน 

- ความแตกต่างระหว่าง Revolved Boss กับ Revolved Cut คืออะไร 
4. ผู้เรียนตอบ 

- Boss เพ่ิมวัสดุ 
- Cut ตัดวัสดุ 

5.6  การขึ้นรูปชิ้นงานตามเส้นนำ (Sweep Feature) 
1. ครูอธิบายแนวคิด 
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- Sweep Feature คือการสร้างชิ้นงาน 3 มิติ โดยให้หน้าตัด (Profile) เคลื่อนที่ไปตามเส้นนำ 
(Guide Curve) เหมาะกับการสร้างท่อโค้ง, ราวบันได, เฟรมรถจักรยาน 

2. ครูสาธิตทีละข้ันตอน 
ขั้นที่ 1  การ Sketch ให้สร้างเส้นโค้งตามดังรูปที่ 5.28 จากนั้นคลิก Exit Sketch โดยเส้นร่างนี้จะถูก
นำมาใช้เป็นเส้นที่กำหนดรูปทรงของวัตถุ 3 มิติที่จะสร้างข้ึนมาตามรูปทรงดังกล่าว 
1. ครูวาดเส้นโค้ง (Spline) 1 เส้น 
2. ผู้เรียนสังเกตรูปร่างเส้นโค้ง 
ขั้นที่ 2  คลิกที่แถบ Insert > Reference Geometry > Plane... เพื่อสร้างระนาบใหม่บนปลายของเส้น
โค้งระนาบนี้ เพื่อจะใช้ในการเขียนหน้าตัดลงไป เหตุผลที่ต้องสร้างระนาบใหม่ขึ้นมา เนื่องจากหากเขียน
หน้าตัดไม่ตรงจุดที่ปลายเส้นโค้ง การสร้างวัตถุขึ ้นมาใหม่ก็จะเริ่มต้นไม่ตรงกับจุดปลาย แต่จะไปเริ ่มที่
บริเวณอ่ืน ๆ ของเส้นแทนก็ได้ 
1. ครูอธิบาย ว่า เราต้องสร้างระนาบที่ปลายเส้นโค้งเพ่ือวาดหน้าตัด 
2. ผู้เรียนถาม  

- ทำไมต้องสร้างระนาบใหม่ 
3. ครูตอบ 

- เพ่ือให้หน้าตัดตั้งฉากกับเส้นโค้ง 
ขั้นที่ 3  สร้างวงกลมบนระนาบใหม่ 1 วง 
1. ครูวาดวงกลมขนาดเล็กที่ปลายเส้นโค้ง 
2. ผู้เรียนปฏิบัติตาม 
ขั้นที่ 4  คลิกที่บริเวณพื้นที่ว่าง บนพื้นที่ที่แสดงผลบริเวณใดก็ได้ เพื่อยกเลิกการเลือกวงกลม จากนั้นคลิก 
ดร็อปดาวน์ลิสต์คำสั่ง Display/Delete Relations แล้วเลือกคำสั่ง Add Relation ดังรูปที่ 5.30 
1. ครูอธิบาย ว่า เราจะสร้างความสัมพันธ์ระหว่างวงกลมกับเส้นโค้ง 
ขั้นที่ 5  คลิกท่ีจุดกึ่งกลางของวงกลม และคลิกที่จุดปลายของเส้นร่างให้ตรง 
1. ผู้เรียนสังเกตการเชื่อมโยง 
ขั้นที่ 6  ที่หน้าต่าง Add Relations คลิกคำสั่ง Coincident จุดกึ่งกลางของวงกลมและจุดส่วนปลาย     
ของเส้นร่างจะถูกทำให้เลื่อนติดกันทันที จากนั้นคลิกคำสั่ง Exit Sketch ดังรูปที่ 5.31 
1. ครูอธิบาย ว่า Coincident จะทำให้จุดทั้งสองติดกัน 
ขั้นที่ 7  คลิกแถบ Feature เลือกคำสั่ง Swept Boss/Base 
1. ครูอธิบาย ว่า Swept Boss/Base จะสร้างชิ้นงาน 3 มิติตามเส้นนำ 
ขั้นที่ 8  ที่หน้าต่าง Sweep คลิกช่องบน และคลิกที่เส้นร่างให้ตรง เพื่อกำหนดหน้าตัดในการสร้างวัตถุ     
3 มิต ิ
1. ผู้เรียนเลือกวงกลมเป็น Profile 
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ขั้นที่ 9  ที่หน้าต่าง Sweep คลิกช่องล่าง และคลิกที่เส้นร่างให้ตรง เพ่ือกำหนดรูปทรงของวัตถุ 3 มิติ ดังรูป
ที่ 5.32  
1. ผู้เรียนเลือกเส้นโค้งเป็น Guide Curve 
2. ครูอธิบาย ว่า เส้นนำจะกำหนดว่าหน้าตัดจะเคลื่อนที่ไปทางใด 

ผลลัพธ์  คลิกเครื่องหมาย ✓ เพ่ือเสร็จสิ้นการทำงานวัตถุ 3 มิติที่สร้างขึ้นมาตามรูปทรงดังกล่าว 
1. ผู้เรียนเห็นท่อโค้งที่สร้างเสร็จ 
2. ครูถาม 

- ชิ้นงานประเภทใดท่ีเหมาะใช้ Sweep Feature 
3. ผู้เรียนตอบ 

- ท่อโค้ง, ราวบันได, สายไฟ 
4. ผู้เรียนลองปฏิบัติตาม 

ขั้นฝึกฝน/ลงมือปฏิบัติ (Practice) 
1. ครใูห้ผู้เรียนทำใบงานที่ 5.1 
2. ผู้เรียนรับฟังคำอธิบาย อ่านใบงานและทำความเข้าใจตัวอย่างชิ้นงานที่ต้องสร้าง 
3. ผู้เรียนทำงานเป็นรายบุคคล โดยปฏิบัติตามข้ันตอน 
4. ครูเดินดูการทำงานและให้คำแนะนำ 
5. ครูเดินสังเกตการทำงาน ให้คำแนะนำและแก้ปัญหาเมื่อผู้เรียนติดขัด 
6. ผู้เรียนที่ทำเสร็จก่อนช่วยเพื่อนที่ยังทำไม่เสร็จ 
7. ผู้เรียนบันทึกไฟล์งานโดยใช้ชื่อตามท่ีใบงานกำหนด 

 

ขั้นประยุกต์ใช ้(Production)  
กิจกรรม ออกแบบชิ้นส่วนอุตสาหกรรมแบบผสมผสาน 
1. ครูให้โจทย์ จงออกแบบราวจับบันไดเวียน ที่มีคุณสมบัติดังนี้ 

- เป็นราวโค้งตามแนวเส้นบันไดเวียน (ใช้ Sweep Feature) 
- มีฐานจับยึดทรงกลมที่ปลายทั้งสองด้าน (ใช้ Revolved Boss) 
- มีรูเจาะสำหรับยึดสกรูที่ฐานจับ (ใช้ Revolved Cut หรือ Extruded Cut) 
- เส้นผ่านศูนย์กลางของราว 30 มม. 
- ความยาวตามแนวเส้นโค้งประมาณ 800 มม. 

2. ผู้เรียนทำงานเป็นคู่ ร่วมกันวางแผนและออกแบบชิ้นงาน 
3. ผู้เรียนใช้ความรู้ที่เรียนมาทั้งหมด 

- วาดเส้นนำสำหรับราวบันได (Spline หรือ Arc) 
- สร้างหน้าตัดวงกลมที่ปลายเส้น 
- ใช้ Swept Boss/Base สร้างราว 
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- ใช้ Revolved Boss/Base สร้างฐานจับยึด 
- ใช้ Revolved Cut หรือ Extruded Cut เจาะรูสำหรับสกรู 

4. ครูเดินดูและให้คำแนะนำ 
- ลองใช้ Reference Geometry สร้าง Plane ที่ตำแหน่งที่ต้องการ 
- ใช้ Relations เพ่ือให้หน้าตัดติดกับเส้นนำ 
- ตรวจสอบว่าทุกส่วนเชื่อมต่อกันอย่างถูกต้อง 

5. ผู้เรียนนำเสนอผลงาน โดยเลือก 3-4 คู ่ที่มีผลงานโดดเด่น  
6. ผู้เรียนและครูร่วมวิจารณ์ผลงาน โดยพิจารณาจาก 

- ความสมบูรณ์ของชิ้นงาน (มีครบทุกส่วนตามโจทย์หรือไม่) 
- ความถูกต้องของเทคนิค (ใช้คำสั่งที่เหมาะสม) 
- ความสวยงามและสัดส่วน 
- ความคิดสร้างสรรค์  

7. ผู้เรียนที่ฟัง ให้ข้อเสนอแนะเพ่ือนด้วยความสร้างสรรค์ 
 

ขั้นสรุป/ประเมินผล (Wrap up) 
1. ครูและผู้เรียนร่วมกันสรุปประเด็นสำคัญ 
2. ผู้เรียนฟังการสรุปและจดบันทึกสาระสำคัญ 
3. ครูถามคำถามทบทวนความรู้  
4. ผู้เรียนตอบคำถามทบทวน 
5. ผู้เรียนสอบถามข้อสงสัยที่ยังไม่เข้าใจ 
6. ครูแจ้งหัวข้อที่จะเรียนครั้งต่อไป 
7. ผู้เรียนเตรียมความพร้อมสำหรับบทเรียนต่อไป 

กิจกรรมการเรียนรู้ (ครั้งท่ี 14/18, ชั่วโมงท่ี 92-98/126) 

ขั้นนำเข้าสู่บทเรียน (Warm up) 
24. ครูเปิดภาพชิ้นงานตัวอย่าง เช่น ขวดน้ำหอม, แจกันดอกไม้, ตัวถังเครื่องบิน, ช่องระบายอากาศ พร้อม

ถามผู้เรียนว่า 
- ชิ้นงานเหล่านี้มีลักษณะพิเศษอะไร 

25. ผู้เรียนสังเกตและตอบ 
- มีรูปทรงที่เปลี่ยนไป, มีหลายรูปร่าง, มีช่องว่างโค้ง 

26. ครูนำเสนอวิดีโอสั้น ๆ แสดง 
- กระบวนการผลิตขวดน้ำหอมที่มีรูปทรงเปลี่ยนไปจากล่างสู่บน 
- การตัดช่องระบายอากาศตามแนวโค้งในตัวถังรถยนต์ 

27. ครูแจกชิ้นงานตัวอย่าง (ขวดน้ำหอมเปล่า หรือรูปภาพ) ให้ผู้เรียนจับและสังเกต 
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28. ครูถาม 
- ถ้าจะสร้างขวดนี้ใน SOLIDWORKS ต้องใช้เทคนิคอะไร 
- ถ้าต้องการตัดช่องระบายอากาศตามแนวโค้ง ต้องใช้เทคนิคอะไร 

29. ผู้เรียนตอบ 
- ถ้าจะสร้างขวดนี้ใน SOLIDWORKS ต้องมีหลายหน้าตัด, ต้องใช้เส้นนำ 
- ถ้าต้องการตัดช่องระบายอากาศตามแนวโค้ง ต้องใช้ Sweep Cut 

30. ครูเชื่อมโยงสู่บทเรียน ว่า วันนี้เราจะเรียนรู้เทคนิคขั้นสูงที่จะช่วยให้เราสร้างชิ้นงานที่ซับซ้อนและ
สวยงามได้ ได้แก่ 

- Swept Cut Feature  ตัดช่องว่างตามแนวเส้นโค้ง 
- Multi-Section Solid Feature  สร้างชิ้นงานที่มีหลายหน้าตัดแตกต่างกัน 
- Multi-Section Solid Shape Modification  ปรับแต่งความโค้งและบิดของชิ้นงาน 
- Multi-Section Lofted Cut  ตัดช่องว่างแบบหลายหน้าตัด 

31. ผู้เรียนเปิดเครื่องคอมพิวเตอร์ และโปรแกรม SOLIDWORKS พร้อมรับฟัง 
32. ครูอธิบายภาพรวมของกิจกรรมวันนี้ 

ขั้นการสอน/การนำเสนอ (Presentation) 
5.7  Swept Cut Feature  
1. ครูอธิบาย ว่า Swept Cut = ตัดเนื้อวัสดุออกตามแนวเส้นโค้ง เช่น ช่องระบายอากาศในรถ 
2. ครูสาธิตบน SOLIDWORKS 

- สร้างทรงกระบอก (Ø100 มม. × สูง 50 มม.) 

- วาด Sketch บนหน้าบน → วาดเส้นโค้ง (Spline) เป็นเส้นนำ → Exit Sketch 

- คลิก Features → Swept Cut 

- ตั้งค่า  Circular Profile → เลือกเส้นโค้งเป็น Path 

- คลิก ✓ เสร็จ 
- ผลลัพธ์  เห็นช่องว่างตามเส้นโค้ง 

3. ผู้เรียนลองทำ และ ครูเดินดู 
4. ครูถาม 

- Swept Boss กับ Swept Cut ต่างกันอย่างไร 
5.8  Multi-Section Solid Feature  
1. ครูอธิบาย ว่า Multi-Section = สร้างชิ้นงานที่มีหลายหน้าตัดแตกต่างกัน เช่น ขวดน้ำหอม 
2. ครูสาธิต 

- สร้าง Plane จาก  Insert → Reference Geometry → Plane (Distance = 50 mm) 

- วาดหน้าตัด Sketch บน Top Plane → วาดสี่เหลี่ยม → Exit Sketch 
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- Sketch บน Plane 1 → วาดวงกลม → Exit Sketch 

- เชื่อมหน้าตัด จาก  Features → Lofted Boss/Base → เลือกทั้งสองหน้าตัด → คลิก ✓ 

- ผลลัพธ์  ชิ้นงานเปลี่ยนรูปจากสี่เหลี่ยม → วงกลม 
3. ครูอธิบายเพิ่ม ว่า เราสามารถสร้างหลาย Plane และหลายหน้าตัดได้ตามต้องการ 
4. ผู้เรียนลองทำ และ ครูเดินดู 
5. ครูถาม 

- จะเพ่ิมหน้าตัดเป็น 3-4 หน้าได้หรือไม ่(ตอบ : ได้) 
5.9  Shape Modification 
1. ครูอธิบาย ว่า ปรับแต่งรูปทรง = ทำให้ชิ้นงานโค้งหรือบิดสวยงามข้ึน 
2. ครูสาธิต 2 เทคนิค 

เทคนิค 1  ปรับความโค้ง 

- คลิกขวาที่ Loft Feature → Edit Feature 
- ตั้งค่า Start Constraint = Normal To Profile 
- ปรับ Tangent Length (ยิ่งมากยิ่งโค้ง) 
- ทำซ้ำกับ End Constraint 

- คลิก ✓ 
- ผลลัพธ์ พ้ืนผิวเรียบและโค้งสวยงาม 

เทคนิค 2  บิดชิ้นงาน 
- คลิกท่ี จุดสีเขียว บนหน้าตัดบนหรือล่าง 
- ลากเพ่ือบิด (เช่น 45 องศา) 
- ผลลัพธ์ ชิ้นงานบิดตามที่ต้องการ 

3. ผู้เรียนลองทำ 
4. ครูถาม 

- Normal To Profile ทำอะไร (ตอบ : ทำให้พื้นผิวเรียบ) 
5.10  Multi-Section Lofted Cut 
1. ครูอธิบาย ว่า Lofted Cut = ตัดช่องว่างที่มีหลายหน้าตัดแตกต่างกัน 
2. ครูสาธิตย่อ 

- สร้างทรงสี่เหลี่ยม 3 มิติ 
- วาดวงกลมบน Front Plane 

- สร้าง Plane ใหม่ (ใช้ Flip) → วาดสี่เหลี่ยม 

- Features → Lofted Cut → เลือกทั้งสองหน้าตัด → คลิก ✓ 

- ผลลัพธ์  ช่องว่างเปลี่ยนรูปจากวงกลม → สี่เหลี่ยม 
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3. ผู้เรียนลองทำ 
4. ครูถาม 

- Lofted Boss กับ Lofted Cut ต่างกันอย่างไร  (ตอบ : Boss สร้าง, Cut ตัด) 
5. ครสูรุปย่อ  

- Swept Cut = ตัดตามเส้นโค้ง 
- Multi-Section = หลายหน้าตัดต่างกัน (ใช้ Lofted Boss/Base) 
- Shape Modification = ปรับโค้ง (Normal To Profile) + บิด (จุดสีเขียว) 
- Lofted Cut = ตัดแบบหลายหน้าตัด 

ขั้นฝึกฝน/ลงมือปฏิบัติ (Practice) 
1. ครใูห้ผู้เรียนทำใบงานที่ 5.2 
2. ผู้เรียนรับฟังคำอธิบาย อ่านใบงานและทำความเข้าใจตัวอย่างชิ้นงานที่ต้องสร้าง 
3. ผู้เรียนทำงานเป็นรายบุคคล โดยปฏิบัติตามข้ันตอน 
4. ครูเดินดูการทำงานและให้คำแนะนำ 
5. ครูเดินสังเกตการทำงาน ให้คำแนะนำและแก้ปัญหาเมื่อผู้เรียนติดขัด 
6. ผู้เรียนที่ทำเสร็จก่อนช่วยเพื่อนที่ยังทำไม่เสร็จ 
7. ผู้เรียนบันทึกไฟล์งานโดยใช้ชื่อตามท่ีใบงานกำหนด 

 

ขั้นประยุกต์ใช ้(Production)  
กิจกรรม ออกแบบผลิตภัณฑ์บรรจุภัณฑ์ 
1. ครูให้โจทย์ จงออกแบบขวดน้ำหอมหรือแจกันดอกไม้ ที่มีคุณสมบัติดังนี้ 

- มีหน้าตัดอย่างน้อย 3 รูปแบบที่แตกต่างกัน (เช่น วงกลม → รูปดาว → สี่เหลี่ยม) 
- มีความสูงรวมประมาณ 200 มม. 
- มีช่องระบายอากาศหรือลวดลายตัดตามแนวโค้ง (ใช้ Swept Cut) 
- มีการปรับความโค้งของพ้ืนผิวให้สวยงาม 
- มีความคิดสร้างสรรค์และเป็นเอกลักษณ์ 

2. ผู้เรียนทำงานเป็นคู ่ร่วมกันวางแผนและออกแบบชิ้นงาน 
3. ผู้เรียนใช้ความรู้ที่เรียนมาทั้งหมด 

- สร้าง Reference Planes หลาย ๆ ระนาบ 
- วาดหน้าตัดที่แตกต่างกันบนแต่ละระนาบ 
- ใช้ Lofted Boss/Base สร้างตัวขวดหรือแจกัน 
- ใช้ Swept Cut สร้างช่องระบายหรือลวดลาย 
- ปรับ Start/End Constraints เพ่ือให้พ้ืนผิวเรียบ 
- ใช้การบิด (Twist) เพ่ือเพ่ิมความสวยงาม 

4. ครูเดินดูและให้คำแนะนำ 
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- ลองใช้หน้าตัดที่แปลกใหม่ เช่น รูปดาว รูปหัวใจ 
- การปรับ Tangent Length จะช่วยให้พื้นผิวเรียบขึ้น 
- ลองใช้ Swept Cut สร้างลวดลายที่ซับซ้อน 

5. ผู้เรียนนำเสนอผลงาน โดยเลือก 3-4 คู่ที่มีผลงานโดดเด่น  
6. ผู้เรียนและครูร่วมวิจารณ์ผลงาน โดยพิจารณาจาก 

- ความสมบูรณ์ของชิ้นงาน (มีครบทุกส่วนตามโจทย์หรือไม่) 
- ความถูกต้องของเทคนิค (ใช้คำสั่งที่เหมาะสม) 
- ความสวยงามและสัดส่วน 
- ความคิดสร้างสรรค์ (มีเอกลักษณ์เฉพาะตัว) 

7. ผู้เรียนที่ฟัง ให้ข้อเสนอแนะเพ่ือนด้วยความสร้างสรรค์ 
 

ขั้นสรุป/ประเมินผล (Wrap up) 
1. ครูให้ผู้เรียนทำแบบฝึกหัดหลังเรียน หน่วยที่ 5  
2. ผู้เรียนทำแบบฝึกหัดหลังเรียน หน่วยที่ 5 ตามที่ครูมอบหมาย 
3. ครแูละผู้เรียนร่วมสรุปเนื้อหาและประเด็นสำคัญ 
4. ผู้เรียนตั้งคำถามและข้อสงสัย  
5. ครแูจ้งหัวข้อที่จะเรียนครั้งต่อไป 
6. ผู้เรียนเตรียมความพร้อมสำหรับบทเรียนต่อไป 

 

สื่อและแหล่งการเรียนรู้ 
สื่อสิ่งพิมพ์ 
หนังสือเรียนวิชา งานเขียนแบบเครื่องกลด้วยคอมพิวเตอร์ (Computer-Aided Mechanical Drafting 

Job) รหัสวิชา 20101-2029 หน่วยการเรียนรู้ที่ 5 เรื่อง การสร้างวัตถุ 3 มิติ ด้วยการตัด เจาะ หมุน และกำหนด
รูปทรงให้กับชิ้นงาน ของบริษัท สำนักพิมพ์เอมพันธ์ จำกัด 

สื่อโสตทัศน์ 
สไลด์ Power Point หน่วยการเรียนรู้ที่ 5 เรื่อง การสร้างวัตถุ 3 มิติ ด้วยการตัด เจาะ หมุน และกำหนด

รูปทรงให้กับชิ้นงาน 
สื่อออนไลน์ 

  - 
สื่อจำลองหรือของจริง 
 - 

 อ่ืน ๆ  
  - 

หลักฐานการเรียนรู้ 
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หลักฐานความรู้ 
1. ผลการทำแบบฝึกหัดหลังเรียน หน่วยที่ 5 
2. ผลการตอบคำถามทบทวนความรู้ 
3. ผลการตรวจแบบทดสอบหลังเรียน หน่วยที่ 5 

 หลักฐานการปฏิบัติงาน 
1. ผลการปฏิบัติงานตามใบงานเพ่ิมเติมที่ 4 
2. ผลการปฏิบัติงานตามใบงานที่ 5.1 
3. ผลการปฏิบัติงานตามใบงานที่ 5.2 
4. ผลการออกแบบชิ้นส่วนเฟืองตามโจทย์ 
5. ผลการออกแบบชิ้นส่วนอุตสาหกรรมแบบผสมผสาน 
6. ผลการออกแบบผลิตภัณฑ์บรรจุภัณฑ์ 

 หลักฐานคุณลักษณะอันพึงประสงค์ 
1. ผลการประเมินตามแบบประเมินคุณธรรม จริยธรรม ตามสภาพจริง 

การวัดและประเมินผล 
เครื่องมือวัด วิธีวัด การประเมินตามเกณฑ ์

1. ใบงานเพ่ิมเติมที่ 4 ปฏิบัติ-ตรวจแบบฝึกหัด เกณฑ์ผ่าน 50% 

2. ใบงานที่ 5.1 ปฏิบัติ-ตรวจแบบฝึกหัด เกณฑ์ผ่าน 50% 

3. ใบงานที่ 5.2 ปฏิบัติ-ตรวจแบบฝึกหัด เกณฑ์ผ่าน 50% 

4. แบบฝึกหัดหลังเรียน หน่วยที่ 5 ตรวจแบบฝึกหัด เกณฑ์ผ่าน 50% 

5. แบบทดสอบหลังเรียน หน่วยที่ 5 ทดสอบ-ตรวจแบบทดสอบ เกณฑ์ผ่าน 50% 

6. แบบประเมินคุณธรรม จริยธรรม ตามสภาพจริง สังเกต/ผู้เรียนประเมินตนเอง เกณฑ์ผ่าน 70% 
 

งานที่มอบหมาย 
1. งานที่มอบหมายนอกเหนือเวลาเรียน ให้ทำแบบฝึกหัดที่ทำไม่แล้วเสร็จในห้องเรียนให้เรียบร้อย 
2. ออกแบบชิ้นส่วนเฟืองตามโจทย์ 
3. ออกแบบชิ้นส่วนอุตสาหกรรมแบบผสมผสาน 
4. ออกแบบผลิตภัณฑ์บรรจุภัณฑ์ 
5. สืบค้นข้อมูลเพิ่มเติมเก่ียวกับเนื้อหาที่จะเรียนในครั้งถัดไป 

 

หนังสืออ้างอิง 
 ผศ.กีรดิษ สายพัทลุง. (2567). งานเขียนแบบเครื่องกลด้วยคอมพิวเตอร์ (Computer-Aided Mechanical 
Drafting Job). เอมพันธ์. 
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บันทึกผลหลังการจัดการเรียนรู้ (ครั้งที่ 12/18, ชั่วโมงที่ 78-84/126) 
1. ผลการจัดการเรียนรู้ที่เกิดขึ้นกับผู้เรียน 

               
               
               

2. ปัญหา อุปสรรคที่พบ 
               
               
               

3. การแก้ไขปัญหา 
3.1) ผลการแก้ไขปัญหาที่ส่งผลลัพธ์ที่ดีต่อผู้เรียน 

               
               

3.2) แนวทางแก้ปัญหาในครั้งต่อไป 
               
               

 
 

ลงชื่อ 
                        (.........................................)

                    ครูผู้สอน   
     ………./…………/………… 
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บันทึกผลหลังการจัดการเรียนรู้ (ครั้งที่ 13/18, ชั่วโมงที่ 85-91/126) 

1. ผลการจัดการเรียนรู้ที่เกิดขึ้นกับผู้เรียน 
               
               
               

2. ปัญหา อุปสรรคที่พบ 
               
               
               

3. การแก้ไขปัญหา 
3.1) ผลการแก้ไขปัญหาที่ส่งผลลัพธ์ที่ดีต่อผู้เรียน 

               
               

3.2) แนวทางแก้ปัญหาในครั้งต่อไป 
               
               

 
 

ลงชื่อ 
                        (.........................................)

                    ครูผู้สอน   
     ………./…………/………… 
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บันทึกผลหลังการจัดการเรียนรู้ (ครั้งที่ 14/18, ชั่วโมงที่ 92-98/126) 

1. ผลการจัดการเรียนรู้ที่เกิดขึ้นกับผู้เรียน 
               
               
               

2. ปัญหา อุปสรรคที่พบ 
               
               
               

3. การแก้ไขปัญหา 
3.1) ผลการแก้ไขปัญหาที่ส่งผลลัพธ์ที่ดีต่อผู้เรียน 

               
               

3.2) แนวทางแก้ปัญหาในครั้งต่อไป 
               
               

 
 

ลงชื่อ 
                        (.........................................)

                    ครูผู้สอน   
     ………./…………/………… 
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แผนการจัดการเรียนรู้ที่ 6  หน่วยที่    6    . 
รหัสว ิชา 20101-2029  ช ื ่อว ิชา  งานเข ียนแบบเคร ื ่องกลด ้วย
คอมพิวเตอร์ (Computer-Aided Mechanical Drafting Job) 

สอนครั้งที ่15 - 17 

ชื่อหน่วยการเรียนรู้  การประกอบชิ้นงานย่อยเป็นชิ้นงานที่สมบูรณ์    ทฤษฎี     3    ชม.  
ปฏิบัติ    18    ชม. ชื่อเรื่อง   การประกอบชิ้นงานย่อยเป็นชิ้นงานที่สมบูรณ์    

สาระสำคัญ 
 การประกอบชิ้นงานในโมดูล Assembly ของ SOLIDWORKS เป็นกระบวนการที่ต้องอาศัยการจัดการ
ความสัมพันธ์ระหว่างชิ้นส่วน การปรับตำแหน่งและการควบคุมการหมุนของวัตถุ 3 มิติ ผ่านระบบพิกัดคาร์ทีเชียน 
โดยมีเครื่องมือและคำสั่งสำคัญ เช่น Move Component, Mate และ Move with Triad ที่ช่วยให้ผู้ใช้สามารถ
ประกอบชิ้นงานได้อย่างแม่นยำและมีประสิทธิภาพ 
 

ผลลัพธ์การเรียนรู้ระดับหน่วยการเรียน 
ผู้เรียนสามารถประกอบชิ้นงานย่อยเป็นชิ้นงานที่สมบูรณ์โดยใช้โมดูล Assembly พร้อมทั้งจัดวางตำแหน่ง 

ปรับแต่งองศา และนำเสนองานในรูปแบบภาพฉายได้อย่างถูกต้องตามหลักการ 
 

อ้างอิงมาตรฐาน/เชื่อมโยงกลุ่มอาชีพ 
 - 

สมรรถนะประจำหน่วย 
16. แสดงความรู้เกี่ยวกับการประกอบชิ้นงานย่อยเป็นชิ้นงานที่สมบูรณ์ในโมดูล Assembly 
17. มีทักษะการใช้เครื่องมือและคำสั่งในการจัดวางตำแหน่ง ปรับแต่งองศา และจัดการตำแหน่งเชิงพิกัด      

ในงานประกอบ 
18. ประยุกต์ใช้ความรู้และทักษะในการสร้างความสัมพันธ์ระหว่างชิ้นงานเพื่อการนำเสนอภาพฉายแบบ 

Drawing การพิมพ์ และการพล็อต 

จุดประสงค์เชิงพฤติกรรม   
ด้านความรู้ (Knowledge) 
6. อธิบายเกี่ยวกับหลักการทำงานของโมดูล Assembly และการสร้างความสัมพันธ์ระหว่างชิ้นงานใน

รูปแบบต่าง ๆ เพื่อการประกอบชิ้นงานที่มีประสิทธิภาพได้ 
ด้านทักษะ/กระบวนการ  (Process) 
9. ใช้คำสั่งและเครื่องมือในการแก้ไขส่วนประกอบชิ้นงานและจัดการหน้าต่างเรียงไฟล์ในโมดูล Assembly 

เพ่ือเพ่ิมประสิทธิภาพในการทำงานได้ 
10. ใช้เครื่องมือในการสร้างภาพฉายแบบ Drawing การพิมพ์ และการพล็อต เพื่อนำเสนอผลงานการ

ออกแบบได้อย่างมืออาชีพได้ 
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คุณลักษณะท่ีพึงประสงค์ (Attitude)   
5. มีเจตคติและกิจนิสัยที่ดีในการปฏิบัติงานด้วยความละเอียด รอบคอบ และความรับผิดชอบต่อการ

ประกอบชิ้นงานให้ได้มาตรฐานตามหลักวิศวกรรม 
 

ด้านการประยุกต์ใช้ (Apply)  
1. ประยุกต์ใช้เทคนิคการจัดวางตำแหน่ง การปรับแต่งองศา และการจัดการตำแหน่งเชิงพิกัดเพ่ือสร้างงาน

ประกอบที่ถูกต้องตามข้อกำหนดได้ 

สาระการเรียนรู้ 
 6.1 โมดูล Assembly 
  6.1.1 วิธีแก้ไขส่วนประกอบชิ้นงานใน Assembly 

6.1.2 การแยกหน้าต่างเรียงไฟล์แก้ไขงานใน Assembly 
6.1.3 การสร้างความสัมพันธ์ระหว่างชิ้นงานในแบบต่าง ๆ 

6.2 การจัดวางตำแหน่งชิ้นส่วนในงานประกอบ (Assembly Positioning) 
6.3 การปรับแต่งองศาในการประกอบชิ้นงาน (Angular Orientation Adjustment) 
6.4 การจัดการตำแหน่งเช ิงพิก ัดในระบบการออกแบบและประกอบชิ ้นงาน  (Coordinate-based 
Positioning in Assembly Design)  
6.5 การนำเสนองานด้วยการสร้างภาพฉายแบบ Drawing การพิมพ์ การพล็อต 

กิจกรรมการเรียนรู้ (ครั้งท่ี 15/18, ชั่วโมงท่ี 99-105/126) 

ขั้นนำเข้าสู่บทเรียน (Warm up) 
40. ครูนำเสนอวิดีโอหรือภาพตัวอย่างชิ้นงานอุตสาหกรรมจริง เช่น เครื่องจักรกล รถยนต์ หรืออุปกรณ์กล

ที่ประกอบจากหลายชิ้นส่วน 
41. ผู้เรียนร่วมสังเกตและระบุว่าชิ้นงานแต่ละชิ้นมีความสัมพันธ์กันอย่างไร 
42. ครูแจกชิ้นส่วนจำลอง (บล็อกพลาสติก หรือแบบจำลอง 3 ชิ้น) ให้ผู้เรียนแต่ละกลุ่ม 
43. ผู้เรียนลองประกอบชิ้นส่วนด้วยมือ และอภิปรายว่า  ต้องจัดวางชิ้นส่วนอย่างไรให้ถูกตำแหน่ง 
44. ครูและผู้เรียนร่วมสรุปว่า การประกอบชิ้นงานต้องมี ข้อกำหนดความสัมพันธ์ เพ่ือควบคุมตำแหน่ง 
45. ครูเปิดโปรแกรม SOLIDWORKS และสาธิตงานประกอบ (Assembly) ที่สร้างเสร็จแล้ว โดยแสดงให้

เห็นว่าชิ้นส่วนต่างๆ ถูกควบคุมด้วย Mate Commands 
46. ผู้เรียนตั้งคำถามเกี่ยวกับสิ่งที่สังเกตเห็น เช่น ทำไมชิ้นส่วนถึงอยู่ในตำแหน่งที่ต้องการ 
47. ครูแจ้งจุดประสงค์และผลการเรียนรู้ที่คาดหวัง พร้อมแสดงตัวอย่างผลงานที่ผู้เรียนจะสามารถสร้างได้

หลังเรียนจบ 
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ขั้นการสอน/การนำเสนอ (Presentation) 
1. ครูอธิบายความหมายของ Assembly และความสำคัญในการออกแบบเชิงวิศวกรรม 
2. ผู้เรียนฟังและจดบันทึกประเด็นสำคัญ 
3. ครสูาธิตการสร้าง Assembly พ้ืนฐาน ได้แก่ 

- การเปิด Assembly ใหม ่
- การนำชิ้นส่วนเข้า Assembly 
- การแยกหน้าต่างเพื่อแก้ไขชิ้นส่วน 
- การแก้ไขชิ้นส่วนใน Assembly 

4. ครูสาธิตการเปิด Assembly (New → Assembly) พร้อมอธิบายขั้นตอน 
5. ผู้เรียนสังเกตและซักถามข้อสงสัย 
6. ครูสาธิตการใช้ Insert Component เพื่อนำชิ้นส่วนที่เตรียมไว้ (3 ชิ้น คือ แผ่นฐาน, ทรงกระบอก, 

แผ่นกลม) เข้ามาในหน้าต่าง Assembly 
7. ผู้เรียนสังเกตว่าชิ้นส่วนยังไม่มีความสัมพันธ์กัน (สามารถเคลื่อนที่ได้อย่างอิสระ) 
8. คร ูสาธ ิตการใช ้ Window Layout Options (Cascade, Tile Horizontally, Tile Vertically) เ พ่ือ

แสดงหน้าต่างหลายชิ้นส่วนพร้อมกัน 
9. ผู้เรียนเห็นประโยชน์ของการแยกหน้าต่างในการทำงานที่ซับซ้อน 
10. ครูสาธิตการใช้ Edit Component เพ่ือแก้ไขชิ้นส่วนโดยไม่ต้องกลับไปเปิดไฟล์ Part 
11. ผู้เรียนเห็นตัวอย่างการแก้ไขและการใช้ Rebuild 
12. ครูอธิบายและสาธิต Mate Commands แต่ละประเภทอย่างกระชับ 

- Standard Mates  Coincident, Concentric, Parallel, Perpendicular, Tangent 
- Advanced Mates Distance, Angle, Lock 

13. ผู้เรียนสังเกตผลลัพธ์ของแต่ละ Mate และถามคำถามเพ่ือความเข้าใจ 
14. ครูสาธิตการใช้ Move Component (Free Drag, Along Assembly XYZ, By Delta XYZ) เพื่อจัด

วางชิ้นส่วนก่อนใช้ Mate 
15. ผู้เรียนเห็นการทำงานแบบ Real-time 
16. ครูและผู้เรียนร่วมสรุปว่า การสร้าง Assembly ที่ดีต้องใช้ Mate ที่เหมาะสม เพ่ือควบคุมความสัมพันธ์

ระหว่างชิ้นส่วน 

ขั้นฝึกฝน/ลงมือปฏิบัติ (Practice) 
1. ครใูห้ผู้เรียนทำใบงานที่ 6.1 
2. ผู้เรียนรับฟังคำอธิบาย อ่านใบงานและทำความเข้าใจใบงานที่ต้องทำ 
3. ผู้เรียนทำงานเป็นรายบุคคล โดยปฏิบัติตามข้ันตอน 
4. ครูเดินดูการทำงานและให้คำแนะนำ 
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5. ครูเดินสังเกตการทำงาน ให้คำแนะนำและแก้ปัญหาเมื่อผู้เรียนติดขัด 
6. ผู้เรียนที่ทำเสร็จก่อนช่วยเพื่อนที่ยังทำไม่เสร็จ 
7. ผู้เรียนบันทึกไฟล์งานโดยใช้ชื่อตามท่ีใบงานกำหนด 

ขั้นประยุกต์ใช ้(Production) 
กิจกรรม ออกแบบตัวยึดชิ้นงานแบบง่าย 
1. ครูให้โจทย์ ออกแบบชิ้นงานประกอบที่มี 4-5 ชิ้นส่วน สำหรับใช้เป็นอุปกรณ์ยึดชิ้นงานบนโต๊ะทำงาน 

โดยมีข้อกำหนด ดังนี้ 
- ต้องใช้ Mate อย่างน้อย 3 แบบ (เช่น Concentric, Distance, Perpendicular) 
- ชิ้นงานต้องสามารถเคลื่อนไหวได้อย่างน้อย 1 ส่วน 

2. ผู้เรียนปฏิบัติงาน ดังนี้ 
- ทำงานเป็นคู่ ร่วมกันวางแผนการออกแบบ  
- สเก็ตช์แนวคิดบนกระดาษก่อนเริ่มสร้างใน SOLIDWORKS  
- สร้างชิ้นส่วนและประกอบด้วย Mate ที่เหมาะสม 
- ผู้เรียนทดสอบการทำงานและปรับปรุง 

3. ครูเดินสังเกตและให้คำแนะนำเชิงสร้างสรรค์ 
4. ผู้เรียนอภิปรายปัญหาและแนวทางแก้ไขกับคู่ของตน 
5. ผู้เรียนแต่ละคู่นำเสนอผลงานหน้าชั้นเรียน โดย 

- อธิบายแนวคิดการออกแบบ 
- อธิบาย Mate ที่ใช้และเหตุผล 
- สาธิตการทำงานของชิ้นงาน 

6. ผู้เรียนคนอ่ืนๆ ให้ Feedback และถามคำถาม 
7. ครูให้คำแนะนำและข้อเสนอแนะเพ่ือพัฒนา 
 

ขั้นสรุป/ประเมินผล (Wrap up) 
1. ครูและผู้เรียนร่วมกันสรุปประเด็นสำคัญ 
2. ผู้เรียนฟังการสรุปและจดบันทึกสาระสำคัญ 
3. ครูถามคำถามทบทวนความรู้  
4. ผู้เรียนตอบคำถามทบทวน 
5. ผู้เรียนสอบถามข้อสงสัยที่ยังไม่เข้าใจ 
6. ครูแจ้งหัวข้อที่จะเรียนครั้งต่อไป 
7. ผู้เรียนเตรียมความพร้อมสำหรับบทเรียนต่อไป 

กิจกรรมการเรียนรู้ (ครั้งท่ี 16/18, ชั่วโมงท่ี 106-112/126) 

ขั้นนำเข้าสู่บทเรียน (Warm up) 
40. ครูแสดงภาพชิ้นงานประกอบ 2 แบบ 
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- แบบที่ 1 ชิ้นส่วนอยู่ในตำแหน่งที่ถูกต้อง  
- แบบที่ 2 ชิ้นส่วนอยู่ในตำแหน่งและมุมที่ผิด 

41. ผู้เรียนสังเกตและระบุความแตกต่าง เช่น  
- ชิ้นส่วนหมุนไปทางไหน 
- ตำแหน่งเลื่อนไปก่ีมิลลิเมตร 

42. ครูถามคำถามกระตุ้น 
- ถ้าต้องการหมุนชิ้นส่วน 90 องศา หรือเลื่อนชิ้นส่วนไป 50 มม. ในโปรแกรม SOLIDWORKS 

จะทำอย่างไร 
43. ครูแสดงวิดีโอหรือภาพเครื่องจักรอุตสาหกรรม เช่น แขนหุ่นยนต์ที่สามารถหมุนและเคลื่อนที่ได้หลาย

ทิศทาง 
44. ผู้เรียนอภิปรายว่า 

- การควบคุมองศาและตำแหน่งมีความสำคัญอย่างไรในการทำงานจริง 
45. ครูเชื่อมโยงว่าในโปรแกรม CAD ก็ต้องมีเครื่องมือที่แม่นยำเช่นเดียวกัน 
46. ครูทบทวนสั้นๆ เกี่ยวกับ Mate Commands ที่เรียนไปแล้ว (Coincident, Concentric, Distance) 
47. ผู้เรียนระดมความคิด 

- Mate Commands ช่วยให้ชิ ้นส่วนอยู่ในตำแหน่งที่ถูกต้อง แต่ถ้าต้องการหมุนหรือเลื ่อน
ชิ้นส่วนด้วยค่าที่กำหนดเองจะทำอย่างไร 

48. ครูแจ้งจุดประสงค์  
- วันนี้เราจะเรียนรู้ว ิธีการหมุนชิ้นส่วนด้วย Rotate และควบคุมตำแหน่งด้วย Move with 

Triad เพ่ือให้สามารถประกอบชิ้นงานได้แม่นยำยิ่งขึ้น 
49. ครูแสดงตัวอย่างผลงานที่ผู้เรียนจะสามารถสร้างได้ 

ขั้นการสอน/การนำเสนอ (Presentation) 
6.3  การปรับแต่งองศาในการประกอบชิ้นงาน 
1. สาธิตการใช้ Rotate Component 
2. เปิด Assembly ที่มีชิ้นส่วน 3 ชิ้น (จากบทเรียนที่แล้ว) 

3. ครูสาธิตการเลือก Move Component → Rotate 
4. ผู้เรียนสังเกตว่าชิ้นส่วนสามารถหมุนได้อย่างอิสระ 
5. ครูอธิบายว่า Rotate มี 3 รูปแบบ 

- Free Drag  หมุนเองโดยไม่จำกัดทิศทาง 
- About Entity  หมุนรอบจุดหรือแกนที่เลือก 
- By Delta XYZ  หมุนตามมุมที่กำหนด (เช่น 90 องศา) 

6. ครสูาธิต Free Drag โดย คลิกท่ีชิ้นส่วนทรงกระบอกและเลือก Free Drag 
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7. ผู้เรียนเห็นว่าชิ้นส่วนหมุนตามการลากเมาส์ 
8. ครูอธิบายว่าวิธีนี้เหมาะกับการปรับมุมคร่าวๆ 
9. ครสูาธิต About Entity โดย อธิบายว่า  ถ้าต้องการหมุนรอบแกนเฉพาะ เช่น แกน Z ของฐานสี่เหลี่ยม 

ให้ใช้ About Entity 

10. ครูสาธิตการเลือก About Entity → Selected Item  เลือกแนวของชิ้นส่วนที่ต้องการ 
11. ผู้เรียนสังเกตว่าชิ้นส่วนหมุนเฉพาะแกนที่เลือก 
12. ครสูาธิต By Delta XYZ โดยอธิบาย วิธีนี้แม่นยำที่สุด เพราะสามารถกำหนดมุมได้เป๊ะ 
13. ครูสาธิตการป้อนค่า 

- แกน X  ป้อน 0 องศา 
- แกน Y  ป้อน 0 องศา 
- แกน Z  ป้อน 90 องศา 

14. ผู้เรียนเห็นว่าชิ้นส่วนหมุน 90 องศาพอดี 
15. ครูใหผู้้เรียนทดลองเปลี่ยนค่าเป็น -90 และสังเกตผล 
16. ครอูธิบายแนวคิด Coordinate-based Positioning 
17. ครูอธิบายว่า นอกจากใช้ Mate แล้ว เรายังสามารถควบคุมตำแหน่งด้วยพิกัด X, Y, Z ได้ด้วย 
18. ครูแสดงภาพระบบพิกัด 3 มิติและอธิบายแกนแต่ละแกน 
19. ครูอธิบาย Move with Triad เปรียบเสมือนการมีไม้บรรทัด 3D ที่สามารถควบคุมการเคลื่อนที่ได้ทั้ง   

3 แกน 

20. ครูสาธิตการคลิกขวาที่ชิ้นส่วน → เลือก Move with Triad 
21. ผู้เรียนเห็น Triad (ลูกศรสีแดง เขียว น้ำเงิน) ปรากฏบนชิ้นส่วน 
22. ครูอธิบายหน้าที่ของแต่ละแกน 

- แกน X (สีแดง)  เลื่อนซ้าย-ขวา 
- แกน Y (สีเขียว)  เลื่อนบน-ล่าง 
- แกน Z (สีน้ำเงิน)  เลื่อนหน้า-หลัง 

23. ครสูาธิตการเลื่อนชิ้นส่วนด้วยค่าที่กำหนด โดย 
- ลากลูกศรแกน X และป้อนค่า 150 มม. 

24. ผู้เรียนเห็นว่าชิ้นส่วนเลื่อนไป 150 มม. ตามแกน X 
25. ครูใหผู้้เรียนทดลองเปลี่ยนค่าเป็น -100 และสังเกตผล 
26. ครสูาธิต Show Translate XYZ Box และ Show Translate Delta XYZ Box 
27. ครูอธิบายความแตกต่าง 

- XYZ Box  กำหนดตำแหน่งสัมบูรณ์ (absolute position) 
- Delta XYZ Box  กำหนดระยะห่างจากจุดปัจจุบัน (relative distance) 
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28. ครูสาธิตการป้อนค่าในแต่ละโหมด 
29. ผู้เรียนสังเกตผลลัพธ์และเปรียบเทียบ 
30. ครสูาธิต Show Rotate Delta XYZ Box โดย 

- อธิบายว่า นอกจากเลื่อนแล้ว เรายังสามารถหมุนด้วยค่าที่กำหนดได้ด้วย 
- สาธิตการป้อนค่ามุมหมุน 90 องศาในแกน Z 

31. ผู้เรียนเห็นว่าชิ้นส่วนหมุน 90 องศาพอดี 
32. ครูและผู้เรียนร่วมสรุปความแตกต่างระหว่าง Rotate และ Move with Triad 

- Rotate  ปรับมุมการหมุน 
- Move with Triad  ปรับตำแหน่งด้วยพิกัด 

33. ผู้เรียนตั้งคำถามเพ่ือความเข้าใจ 

ขั้นฝึกฝน/ลงมือปฏิบัติ (Practice) 
1. ครใูห้ผู้เรียนทำใบงานที่ 6.2 
2. ผู้เรียนรับฟังคำอธิบาย อ่านใบงานและทำความเข้าใจตัวอย่างชิ้นงานที่ต้องสร้าง 
3. ผู้เรียนทำงานเป็นรายบุคคล โดยปฏิบัติตามข้ันตอน 
4. ครูเดินดูการทำงานและให้คำแนะนำ 
5. ครูเดินสังเกตการทำงาน ให้คำแนะนำและแก้ปัญหาเมื่อผู้เรียนติดขัด 
6. ผู้เรียนที่ทำเสร็จก่อนช่วยเพื่อนที่ยังทำไม่เสร็จ 
7. ผู้เรียนบันทึกไฟล์งานโดยใช้ชื่อตามท่ีใบงานกำหนด 

ขั้นประยุกต์ใช ้(Production) 
กิจกรรม ออกแบบขาตั้งสำหรับวางมือถือ 
1. ครูให้โจทย์ ออกแบบขาตั้งสำหรับวางมือถือที่มี 3-4 ชิ้นส่วน สามารถปรับมุมได้ โดยมีข้อกำหนด คือ 

- ต้องใช้ Rotate By Delta XYZ เพ่ือปรับมุมการวางมือถือ (เช่น ยืดตัวขึ้น 45 องศา) 
- ต้องใช้ Move with Triad เพ่ือวางชิ้นส่วนในตำแหน่งที่เหมาะสม 
- ชิ้นงานต้องมีเสถียรภาพและสวยงาม 

2. ผู้เรียนต้องปฏิบัติ ดังนี้ 
- ทำงานเป็นคู่ ร่วมกันวางแผนการออกแบบ 
- สเก็ตช์แนวคิดบนกระดาษ  
- สร้างชิ้นส่วนและประกอบด้วย Rotate และ Move with Triad 
- ทดสอบและปรับแต่ง  

3. ครูเดินสังเกตและให้คำแนะนำเชิงสร้างสรรค์ 
4. ผู้เรียนถ่ายภาพหน้าจอ Assembly ที่สร้างเสร็จ 
5. ผู้เรียนแต่ละคู่นำเสนอผลงานหน้าชั้นเรียน โดย 

- อธิบายแนวคิดการออกแบบและวัตถุประสงค์ 
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- สาธิตการใช้ Rotate และ Move with Triad ในการสร้าง 
- แสดงมุมท่ีปรับได้และตำแหน่งที่กำหนด 

6. ผู้เรียนคนอ่ืนๆ ให้ Feedback และถามคำถาม 
7. ครูให้คะแนนความคิดสร้างสรรค์และการใช้เครื่องมือ 

ขั้นสรุป/ประเมินผล (Wrap up) 
1. ครูและผู้เรียนร่วมกันสรุปประเด็นสำคัญ 
2. ผู้เรียนฟังการสรุปและจดบันทึกสาระสำคัญ 
3. ครูถามคำถามทบทวนความรู้  
4. ผู้เรียนตอบคำถามทบทวน 
5. ผู้เรียนสอบถามข้อสงสัยที่ยังไม่เข้าใจ 
6. ครูแจ้งหัวข้อที่จะเรียนครั้งต่อไป 
7. ผู้เรียนเตรียมความพร้อมสำหรับบทเรียนต่อไป 

กิจกรรมการเรียนรู้ (ครั้งท่ี 17/18, ชั่วโมงท่ี 113-119/126) 

ขั้นนำเข้าสู่บทเรียน (Warm up) 
33. ครูแสดงแบบ 2 มิติ (Drawing) ของชิ้นงานจริงจากโรงงานหรืออุตสาหกรรม เช่น แบบลูกสูบเครื่องยนต์ 

แบบเกียร ์
34. ผู้เรียนสังเกตและระบุว่าเห็นอะไรบ้าง เช่น มุมมองหลายด้าน, ขนาดวัด, สัญลักษณ์ต่างๆ 
35. ครูถาม 

- ทำไมโรงงานต้องมีแบบ 2 มิต ิทั้งท่ีเรามีโมเดล 3 มิต ิอยู่แล้ว 
36. ผู้เรียนร่วมอภิปราย 

- ช่างในโรงงานอ่านแบบ 2 มิต ิง่ายกว่า 
- ใช้พิมพ์และแจกจ่ายได ้
- เป็นมาตรฐานสากล 

37. ครูแจกภาพชิ้นงาน 3D จำนวน 3 ชิ้น (ลูกสูบ, ปลายไขควง, เฟือง) และแบบ 2D ที่สับสน 
38. ผู้เรียนแบ่งกลุ่มๆ ละ 3-4 คน จับคู่ว่าโมเดลใดเป็น 3มิติ โมเดลใดเป็นแบบ 2 มิต ิ 
39. ผู้เรียนนำเสนอคำตอบและอธิบายเหตุผล 
40. ครูชี้แจงคำตอบที่ถูกต้องและอธิบายว่า การสร้าง Drawing คือการแปลงโมเดล 3 มิติ เป็นแบบ 2 มิติ 

ที่มีมาตรฐาน 
41. ครูทบทวนสั้น ๆ เกี่ยวกับการสร้าง Part และ Assembly ที่เรียนมาแล้ว 
42. ผู้เรียนระดมความคิด 

- ถ้าเราสร้างโมเดล 3 มิต ิเสร็จแล้ว ขั้นตอนต่อไปคืออะไร 
43. ครูเชื่อมโยง ขั้นตอนสุดท้ายคือการสร้าง Drawing เพ่ือนำเสนอและใช้งานจริง 
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44. ครูแจ้งจุดประสงค์ ว่า วันนี้เราจะเรียนรู้วิธีสร้าง Drawing จากโมเดล 3 มิติ พร้อมทั้งการพิมพ์และ
นำเสนอแบบอย่างมืออาชีพ 

45. ครูแสดงตัวอย่างผลงาน Drawing ที่สมบูรณ ์

ขั้นการสอน/การนำเสนอ (Presentation) 
แนะนำแนวคิดการสร้าง Drawing 
1. ครูอธิบาย Drawing คือแบบ 2 มิต ิที่สร้างจากโมเดล 3 มิต ิโดยใช้การฉายภาพแบบมุมฉากมาตรฐาน 
2. ผู้เรียนฟังและดูตัวอย่างภาพประกอบ 
3. ครูเน้นว่า Drawing จะอัปเดตอัตโนมัติเมื่อเราแก้ไขโมเดล 3 มิต ิ
สาธิตการสร้าง Drawing ใหม่ (เปิด Drawing ใหม่) 

1. ครูเปิด SOLIDWORKS → File → New → Drawing 
2. ผู้เรียนสังเกตว่าต้องเลือก Drawing (ไม่ใช่ Part หรือ Assembly) 
3. ครูอธิบาย ว่า เราต้องเตรียมโมเดล 3 มิต ิให้พร้อมก่อน แล้วค่อยสร้าง Drawing 
เลือกขนาดกระดาษ 
1. ครูสาธิตการเลือก Sheet Format/Size 
2. ผู้เรียนเห็นตัวเลือก A0, A1, A2, A3, A4 
3. ครูอธิบาย ว่า สำหรับงานที่ซับซ้อนใช้ A3 และ งานเล็กใช้ A4 
4. ครูเลือก A3 (ISO) สำหรับการสาธิต 
5. ผู้เรียนสังเกต Preview และสอบถามข้อสงสัย 
นำเข้าโมเดล 3D 

1. ครูสาธิตการใช้ Browse → เลือกไฟล์ Part หรือ Assembly ที่สร้างไว้ 
2. ผู้เรียนเห็นว่าโมเดล 3 มิต ิถูกโหลดเข้ามาในหน้าต่าง Drawing 
3. ครูคลิก OK เพ่ือเริ่มสร้าง Drawing 
สาธิตการใช้ View Palette ( เปิด View Palette ) 
1. ครูอธิบาย ว่า View Palette เป็นเครื่องมือสำคัญที่ช่วยสร้างมุมมองต่างๆ อย่างรวดเร็ว 
2. ครูคลิกท่ีไอคอน View Palette (อยู่ด้านซ้ายของหน้าจอ) 
3. ผู้เรียนเห็น View Palette แสดงมุมมองต่าง ๆ 

- Front  
- Top  
- Right  
- Back 
- Left 
- Bottom 

- Isometric 
- Dimetric 
- Trimetric 
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4. ครูอธิบายหน้าที่ของแต่ละมุมมอง 
สร้างมุมมองมาตรฐาน 
1. ครูลากมุมมอง (A) Front จาก View Palette วางลงบนกระดาษ 
2. ผู้เรียนเห็นว่ามุมมอง Front ปรากฏบนกระดาษ 
3. ครูลากมุมมอง (A) Top วางไว้ด้านบนของ Front 
4. ผู้เรียนสังเกตว่ามุมมองจัดเรียงตามหลัก Third Angle Projection 
5. ครูลากมุมมอง *Isometric วางไว้มุมขวา 
6. ผู้เรียนเห็นว่ามุมมอง 3 มิต ิช่วยให้เข้าใจรูปทรงได้ง่ายขึ้น 
สาธิตการปรับแต่งมุมมอง (เปลี่ยนรูปแบบการแสดงผล ) 

1. ครูคลิกท่ีมุมมอง Isometric → Display Style 
2. ผู้เรียนเห็นตัวเลือก ได้แก่  

- Shaded with Edges 
- Hidden Lines Visible 
- Hidden Lines Removed 

3. ครูเลือก Shaded with Edge 
4. ผู้เรียนสังเกตว่ามุมมอง 3 มิต ิมีสีและเส้นขอบชัดเจน 
5. ครูอธิบาย ว่า Shaded with Edge ทำให้แบบดูสวยงามและเข้าใจง่าย 
สร้าง Section View 
1. ครูอธิบาย ว่า Section View ใช้แสดงภายในชิ้นงาน เหมือนตัดชิ้นงานออกมาดู 

2. ครูคลิก Section View → เลือกเส้นตัด (Cutting Line) ผ่านมุมมอง Front 
3. ผู้เรียนเห็นมุมมอง Section แสดงส่วนภายในของชิ้นงาน 
4. ครูอธิบายว่า เส้นแฮทช์ (Hatch) แสดงบริเวณท่ีถูกตัด 
สร้าง Detail View 
1. ครูอธิบาย Detail View ใช้ขยายส่วนเล็กๆ ให้เห็นชัดเจน 

2. ครูคลิก Detail View → วงกลมรอบส่วนที่ต้องการขยาย 
3. ผู้เรียนเห็นว่ามุมมอง Detail แสดงรายละเอียดที่ขยายใหญ่ขึ้น 
4. ครูอธิบายว่า ใช้กับรูเล็กๆ หรือรายละเอียดที่สำคัญ 
5. ครูและผู้เรียนร่วมสรุปขั้นตอนการสร้าง Drawing ดังนี้ 

- เปิด Drawing ใหม่และเลือกขนาดกระดาษ 
- นำเข้าโมเดล 3D 
- ใช้ View Palette สร้างมุมมองมาตรฐาน 
- ปรับแต่งการแสดงผลด้วย Display Style 
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- เพ่ิม Section View และ Detail View ตามต้องการ 
6. ผู้เรียนสอบถามข้อสงสัย 

ขั้นฝึกฝน/ลงมือปฏิบัติ (Practice) 
1. ครใูห้ผู้เรียนทำใบงานจากภาคผนวก งานที่ 1 - 3 
2. ผู้เรียนรับฟังคำอธิบาย อ่านใบงานและทำความเข้าใจตัวอย่างชิ้นงานที่ต้องสร้าง 
3. ผู้เรียนทำงานเป็นรายบุคคล โดยปฏิบัติตามข้ันตอน 
4. ครูเดินดูการทำงานและให้คำแนะนำ 
5. ครูเดินสังเกตการทำงาน ให้คำแนะนำและแก้ปัญหาเมื่อผู้เรียนติดขัด 
6. ผู้เรียนที่ทำเสร็จก่อนช่วยเพื่อนที่ยังทำไม่เสร็จ 
7. ผู้เรียนบันทึกไฟล์งานโดยใช้ชื่อตามท่ีใบงานกำหนด 

ขั้นประยุกต์ใช ้(Production)  
กิจกรรม นำเสนอแบบ Drawing แบบมืออาชีพ 
1. ครูอธิบายสถานการณ์จำลอง 

- สมมติผู้เรียนเป็นวิศวกรออกแบบ ต้องนำเสนอแบบให้ทีมผลิตในโรงงาน ซึ่งต้องทำให้ช่าง
เข้าใจได้ง่ายและชัดเจน 

2. ผู้เรียนเลือก Drawing 1 งานที่ดีที่สุดของตนเอง (จากใบงานทั้ง 3 งาน ในขั้นขั้นฝึกฝน/ลงมือปฏิบัติ 
(Practice) 

3. ผู้เรียนเตรียม Drawing โดย 
- ตรวจสอบความสมบูรณ์: มุมมองครบหรือไม่, มีข้อมูลสำคัญหรือไม่ 
- ปรับปรุงการแสดงผล: เปลี่ยน Display Style ให้เหมาะสม 
- จัดเรียงมุมมอง: ให้อ่านง่าย ไม่ซ้อนทับกัน 

4. ผู้เรียนปฏิบัติ ดังนี้ 
- ปรับแต่ง Drawing ของตนเอง 
- เตรียมบันทึกประเด็นสำคัญท่ีจะนำเสนอ ได้แก่ 

- ชิ้นงานนี้คืออะไร / ใช้ทำอะไร 
- มีก่ีมุมมอง / แต่ละมุมมองแสดงอะไร 
- จุดเด่นของ Drawing นี้คืออะไร 

5. ครูสาธิตการพิมพ์ Drawing บนโปรเจคเตอร์ 
- คลิก File → Print 
- เลือก Printer (หรือ Print to PDF) 
- ตั้งค่า Scale: 1:1 หรือ Fit to Page 
- ตั้งค่า Orientation: Landscape (แนวนอน) สำหรับ A3/A4 
- คลิก Print Preview เพ่ือดูก่อนพิมพ์ 
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- คลิก OK เพ่ือพิมพ์ 
6. ผู้เรียนสังเกตและจดบันทึกขั้นตอน 
7. ครูอธิบาย 

- ในโรงงานจริง อาจใช้เครื่อง Plotter สำหรับแบบขนาด A0, A1 ที่ใหญ่มาก 
8. ผู้เรียนที่สนใจทดลองพิมพ์ Drawing ของตนเอง (ถ้ามีเครื่องพิมพ์เพียงพอ) 
9. ผู้เรียนนำเสนอผลงาน 
10. ครสูรุปและประกาศผลงานเด่น  
11. ครูอธิบายว่า Drawing ที่ด ีต้องมี 3 คุณสมบัติ 

- ชัดเจน  มุมมองครบถ้วน แสดงข้อมูลที่จำเป็น 
- อ่านง่าย จัดวางเป็นระเบียบ ไม่ซับซ้อนเกินไป 
- ถูกต้อง  ตรงตามมาตรฐาน (เช่น Third Angle Projection) 

12. ผู้เรียนสะท้อนความคิด 
- ผลงานของคุณมีคุณสมบัติเหล่านี้แล้วหรือยัง 
- ควรปรับปรุงอะไรบ้าง 

 

ขั้นสรุป/ประเมินผล (Wrap up) 
1. ครูใหผู้้เรียนทำแบบฝึกหัดบทเรียนที่ 6 
2. ผู้เรียนทำแบบฝึกหัดบทเรียนที่ 6 ตามท่ีครูมอบหมาย 
3. ครูและผู้เรียนร่วมสรุปเนื้อหาและประเด็นสำคัญ 
4. ผู้เรียนจดบันทึกสาระสำคัญและซักถามข้อสงสัย  
5. ครูทบทวนเนื้อหาให้ผู้เรียน เพ่ือเตรียมสอบปลายภาค 
6. ครูแจ้งรายละเอียดสำหรับการสอบปลายภาคในสัปดาห์ถัดไป 
7. ผู้เรียนเตรียมความพร้อมสำหรับการสอบปลายภาคต่อไป 

 

สื่อและแหล่งการเรียนรู้ 
สื่อสิ่งพิมพ์ 
หนังสือเรียนวิชา งานเขียนแบบเครื่องกลด้วยคอมพิวเตอร์ (Computer-Aided Mechanical Drafting 

Job) รหัสวิชา 20101-2029 หน่วยการเรียนรู้ที ่6 เรื่อง การประกอบชิ้นงานย่อยเป็นชิ้นงานที่สมบูรณ์ ของบริษัท 
สำนักพิมพ์เอมพันธ์ จำกัด 

สื่อโสตทัศน์ 
สไลด์ Power Point หน่วยการเรียนรู้ที่ 6 เรื่อง การประกอบชิ้นงานย่อยเป็นชิ้นงานที่สมบูรณ์ 
สื่อออนไลน์ 

  - 
สื่อจำลองหรือของจริง 
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 - 
 อ่ืน ๆ  
  - 

หลักฐานการเรียนรู้ 
หลักฐานความรู้ 
1. ผลการทำแบบฝึกหัดหลังเรียน หน่วยที่ 6 
2. ผลการตอบคำถามทบทวนความรู้ 
3. ผลการตรวจแบบทดสอบหลังเรียน หน่วยที่ 6 

 หลักฐานการปฏิบัติงาน 
1. ผลการปฏิบัติงานตามใบงาน ที่ 1 - 3 (ในภาคผนวก) 
2. ผลการออกแบบตัวยึดชิ้นงานแบบง่าย 
3. ผลการออกแบบขาตั้งสำหรับวางมือถือ 
4. ผลการนำเสนอแบบ Drawing แบบมืออาชีพ 

 หลักฐานคุณลักษณะอันพึงประสงค์ 
1. ผลการประเมินตามแบบประเมินคุณธรรม จริยธรรม ตามสภาพจริง 

การวัดและประเมินผล 
เครื่องมือวัด วิธีวัด การประเมินตามเกณฑ ์

1. ใบงานที่ 1 – 3 (ในภาคผนวก) ปฏิบัติ-ตรวจแบบฝึกหัด เกณฑ์ผ่าน 50% 

2. แบบฝึกหัดหลังเรียน หน่วยที่ 6 ตรวจแบบฝึกหัด เกณฑ์ผ่าน 50% 

3. แบบทดสอบหลังเรียน หน่วยที่ 6 ทดสอบ-ตรวจแบบทดสอบ เกณฑ์ผ่าน 50% 

4. แบบประเมินคุณธรรม จริยธรรม ตามสภาพจริง สังเกต/ผู้เรียนประเมินตนเอง เกณฑ์ผ่าน 70% 
 

งานที่มอบหมาย 
1. งานที่มอบหมายนอกเหนือเวลาเรียน ให้ทำแบบฝึกหัดที่ทำไม่แล้วเสร็จในห้องเรียนให้เรียบร้อย 
2. ออกแบบตัวยึดชิ้นงานแบบง่าย 
3. ออกแบบขาตั้งสำหรับวางมือถือ 
4. นำเสนอแบบ Drawing แบบมืออาชีพ 
5. สืบค้นข้อมูลเพิ่มเติมเก่ียวกับเนื้อหาที่จะเรียนในครั้งถัดไป 

 

หนังสืออ้างอิง 
 ผศ.กีรดิษ สายพัทลุง. (2567). งานเขียนแบบเครื่องกลด้วยคอมพิวเตอร์ (Computer-Aided Mechanical 
Drafting Job). เอมพันธ์. 
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บันทึกผลหลังการจัดการเรียนรู้ (ครั้งที่ 15/18, ชั่วโมงที่ 99-105/126) 
1. ผลการจัดการเรียนรู้ที่เกิดขึ้นกับผู้เรียน 

               
               
               

2. ปัญหา อุปสรรคที่พบ 
               
               
               

3. การแก้ไขปัญหา 
3.1) ผลการแก้ไขปัญหาที่ส่งผลลัพธ์ที่ดีต่อผู้เรียน 

               
               

3.2) แนวทางแก้ปัญหาในครั้งต่อไป 
               
               

 
 

ลงชื่อ 
                        (.........................................)

                    ครูผู้สอน   
     ………./…………/………… 
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บันทึกผลหลังการจัดการเรียนรู้ (ครั้งที่ 16/18, ชั่วโมงที่ 106-112/126) 

1. ผลการจัดการเรียนรู้ที่เกิดขึ้นกับผู้เรียน 
               
               
               

2. ปัญหา อุปสรรคที่พบ 
               
               
               

3. การแก้ไขปัญหา 
3.1) ผลการแก้ไขปัญหาที่ส่งผลลัพธ์ที่ดีต่อผู้เรียน 

               
               

3.2) แนวทางแก้ปัญหาในครั้งต่อไป 
               
               

 
 

ลงชื่อ 
                        (.........................................)

                    ครูผู้สอน   
     ………./…………/………… 
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บันทึกผลหลังการจัดการเรียนรู้ (ครั้งที่ 17/18, ชั่วโมงที่ 113-119/126) 

1. ผลการจัดการเรียนรู้ที่เกิดขึ้นกับผู้เรียน 
               
               
               

2. ปัญหา อุปสรรคที่พบ 
               
               
               

3. การแก้ไขปัญหา 
3.1) ผลการแก้ไขปัญหาที่ส่งผลลัพธ์ที่ดีต่อผู้เรียน 

               
               

3.2) แนวทางแก้ปัญหาในครั้งต่อไป 
               
               

 
 

ลงชื่อ 
                        (.........................................)

                    ครูผู้สอน   
     ………./…………/………… 
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